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Chapter 1: Smaart 6 소개 

 

 

Smaart는 1996년 처음 소개되었으며, 그 이후 실시간으로 사운드시스템을 측정, 최적화하고, 

또 제어하기 위한 분야에서 가장 널리 사용되는 소프트웨어 제품으로 확고히 자리매김하고 

있습니다. Smaart는 측정, 분석 그리고 데이터 저장을 통합하는 직관적이고 쉬운 인터페이스를 

통해 Dual-Channel FFT 기반의 오디오 측정을 수행합니다. 

Smaart 6는 현대적 객체지향형 구조로 완전히 새롭게 만들어졌습니다. 이런 커다란 구조적 

업그레이드로 사운드시스템의 측정이 더욱 강력해졌을 뿐만 아니라 다른 환경의 

운영체제에서도 사용이 가능합니다. 이와 같은 이유로 Smaart 6는 같은 unified source code로 

Windows XP와 Mac OS X의 환경에서 구동이 가능합니다. 사용자들의 의견을 수렴하여 사용자 

인터페이스를 강화하고 능률적으로 구축하였으며, 또 실시간으로 이퀄라이저와 DSP를 제어할 

수 있습니다. (제어가능장비 참조) 

 

1.1 하드웨어 요구사항 
  

1.1.1 컴퓨터 

 윈도우 환경 

 

 운영체제: Windows 2000 또는 XP 이상 

 CPU: 1 GHz 이상의 인텔 펜티엄 또는 호환 제품 

 램(RAM): 1 GB (최소: 512 MB) 

 비디오: 32MB 이상의 RAM을 가진 AGP 또는 PCI 그래픽카드 

 디스플레이: 1024 x 768 (24/32-bit) 디스플레이 지원 가능 제품 

 사운드 하드웨어: 다음의 입출력을 지원하는 Windows 호환(Wave/WDM or ASIO) 제품 

- 스테레오 라인/마이크 입력 

-  44.1 – 96kHz의 샘플링레이트, 16 – 24bit 해상도 지원 

-  Full-duplex 모드 지원(녹음과 재생이 동시에 가능) 

 맥킨토시 환경 

 

 운영체제: Mac OS X 10.4 (Tiger) 이상 

 CPU: 최소 1GHz 이상의 Apple Macintosh family CPU로 구성된 G4, G5 또는 Intel microprocessor. 

 램(RAM): 1 GB (최소: 512 MB) 

 비디오: 32MB 이상의 RAM을 가진 AGP 또는 PCI 그래픽카드 

 디스플레이: 1024 x 768 (24/32-bit) 디스플레이 지원 가능 제품 

 사운드 하드웨어: 다음의 입출력을 지원하는 Apple Core Audio 호환 제품 

- 스테레오 라인/마이크 입력 

-  44.1– 96kHz의 샘플링레이트, 16 – 24bit 해상도 지원 
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-  Full-duplex 모드 지원(녹음과 재생이 동시에 가능) 

 컴퓨터 사운드 하드웨어 

 

Smaart 6는 사운드 하드웨어를 직접 다루지 않고 컴퓨터에서 사용하는 사운드

하드웨어를 통해 오디오 데이터를 받기 때문에 Windows나 Mac OS 환경과 호환되는

어떤 오디오 입출력 장치와도 함께 사용할 수 있습니다. Smaart 6를 노트북, 그리고

고성능 A/D, D/A 컨버터와 마이크 프리앰프를 가진 USB, PCMCIA, 그리고 Firewire의
외장 하드웨어와 함께 사용한다면 간편하게 휴대할 수 있습니다. 
 

주파수응답 특성 측정과 임펄스응답 측정을 위해 두 개의 독립적인 라인/마이크

입력채널이 필요하며, 핑크노이즈와 같은 측정소스를 만들어주는 Smaart 6의 
신호발생기를 사용하기 위해 사운드 하드웨어는 반드시 녹음과 재생을 동시에

수행할 수 있어야 합니다. 

 
Smaart 6로 측정 과정을 수행하기 위해 컴퓨터에 내장된 마이크입력을 사용하는

대신, 외장 믹서나 마이크 프리앰프를 가진 사운드 장치를 사용할 것을 권장합니다. 

 
Smaart 6의 올바른 구동을 위해 사운드 하드웨어의 샘플링레이트(sampling rate), 
해상도(sampling resolution) 그리고 신호 대 잡음 비(signal-to-noise ratio)가 아래 사양에

준하여야 합니다. 
 

 

 녹음, 재생 동시 가능 (full duplex) 
 두 개의 독립적인 라인/마이크 입력 채널 
 16 - 24bit 해상도 
 외장 A/D 컨버터 사용 시 디지털오디오 입력 필요 
 사용자가 선택 가능한 샘플링 레이트: Smaart 6는 5512Hz에서 96kHz까지의

샘플링 레이트를 지원합니다. 오디오 입력 장치는 반드시 44.1kHz, 48kHz 또는

96kHz 중 한가지 이상의 샘플링 레이트를 지원해야 합니다. 
 

1.1.2 측정 마이크 

 

측정마이크는 미세한 음압의 변화를 전기신호로 정확하게 변환하는 것이 중요합니다. 
따라서 최대한 평탄한 주파수특성을 가진 무지향성 측정마이크를 사용하는 것이

좋으며, Smaart 6의 음압레벨(SPL) 교정(calibration)을 위한 마이크로폰

캘러브레이터(calibrator)의 사용을 권장합니다. 
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1.1.3 마이크 프리앰프 

 

마이크 프리앰프는 컴퓨터의 Line 입력으로 충분한 크기의 신호를 공급할 수 있도록

기본잡음(noise floor)이 작아야 하며, 콘덴서 마이크 사용을 위한 팬텀파워를 내장한

제품을 사용해야 합니다. 프리앰프를 대신하여 믹서 등을 사용할 경우 측정을 위해

사용하는 채널의 이퀄라이저, 컴프레서, 리미터 등은 모두 사용하지 말아야 합니다. 
 

1.1.4 케이블과 장비 연결 

 

측정 장비와 그 대상이 되는 장비의 연결에는 반드시 프로페셔널 급의 케이블과

커넥터를 사용하여야 합니다. 만일 컴퓨터 사운드카드의 1/8인치 스테레오 커넥터를

사용하려면, 1/4인치 폰 커넥터나 XLR 커넥터로 전환되는 Y 케이블을 사용할 것을

권장하며, 일반적으로 컴퓨터의 사운드카드는 언밸런스(unbalanced) 입력을

사용하므로 밸런스(balanced) 커넥터를 언밸런스(unbalanced) 형태로 전환할 수 있는

어댑터나 케이블이 필요할 수 있습니다.  

 

1.1.5 그 외 유용한 장비 

 
측정 작업에 따라 다음 장비가 필요할 수 있습니다: 
 

 믹서 / 레벨조정 장치 

 

대부분의 경우 컴퓨터에서 신호레벨을 맞출 수 있지만 2채널 입력의 프리앰프나

컴퓨터의 입력으로 여러 신호를 번갈아 보낼 경우 외부 장치를 이용해 레벨을

조절한다면 측정작업이 훨씬 수월해 질 수 있습니다. 
 

 마이크로폰 캘러브레이터(Calibrator), 사운드 레벨 미터 

 

Smaart 6로 정확한 음압레벨(SPL; Sound Pressure Level)을 측정하려면, 마이크로폰

캘러브레이터로 Smaart 6의 음압레벨을 교정(calibration)해야 합니다. 오디오 출력이

있는 고성능 SPL 미터를 측정마이크로 사용하는 것도 효과적일 수 있습니다. 
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1.2 Smaart 6 소프트웨어 설치 
  
 소프트웨어 라이센스 동의 

 

Smaart 6 소프트웨어 설치 시, 소프트웨어 라이센스에 관한 조건에 동의하셔야

합니다. 즉, 그에 관한 조건에 대해 법적 책임이 있음을 의미합니다. 설치 시 반드시

소프트웨어 라이센스에 대한 사용 조건을 읽어보시고, 다음의 사항들을 강조합니다: 

 

 

 

 

한 카피의 Smaart 6는 한 명의 사용자만 허용됩니다. 즉, 한 대의 컴퓨터에 설치하여 한 명의 

사용자가 사용하는 것에 대해서만 법적으로 인정됩니다. 

 

 

 

Smaart 6 설치와 복제 방지 메커니즘은 위의 규정을 강화하기 위한 것입니다. 이는

정품사용자에게 불편을 끼치거나 소프트웨어의 합법적인 사용을 어렵게 하기 위한

것이 아닙니다. 한 사용자가 데스크탑과 노트북 등 두 대의 컴퓨터에 Smaart 6를

설치하여 사용하는 것은 허용됩니다. Smaart 6 한 카피에는 두 번의 정품인증 기회가

주어지므로, 두 번째 컴퓨터에도 첫 번째 컴퓨터에 설치하신 것처럼 설치하신 후

사용하시면 됩니다. 

 

1.2.1 프로그램 설치와 정품인증 

 

Smaart 6를 처음으로 설치 할 경우 프로그램 설치와 정품인증, 이렇게 두 단계의

과정을 거쳐야 합니다. 설치 후 정품인증 과정을 거치지 않더라도 30일 동안은

사용이 가능하지만, 그 후에는 사용하실 수 없으므로 30일 이전에 정품인증을

받으셔야 합니다. 
 

 

 
 

 

 

Smaart 6 설치 전 바이러스 백신 프로그램, 시스템 모니터 소프트웨어 등 다른 모든 

응용프로그램을 종료하십시오. 
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1. 설치 CD를 실행하여 Smaart 6를 설치합니다. 
2. 프로그램 설치 후 Smaart 6를 실행하면, 정품인증을 묻는 대화창이 열립니다. 

차후에 인증을 받으시려면 ‘Continue’를 클릭하시고, 바로 인증을 받으시려면

Smaart 6가 설치된 컴퓨터가 인터넷 접속이 가능하다면 다음 3.의 안내에 
따르고, 그렇지 않다면 다음 4.의 안내에 따라 인증을 받습니다. 

3. ‘Unlock Now > Unlock Online’을 클릭하고 제품 라이센스번호와 로그인 정보를

입력한 후 ‘Unlock Now’를 클릭하면 인증이 완료됩니다. (my.eaw.com에 계정이

없다면, ‘I want to setup my account at my.eaw.com’을 선택하시면 인증과 함께

계정도 생성됩니다.) 
4. ‘continue’를 클릭하여 Smaart 6를 실행하고 ‘Help > About Smaart’에서 Machine 

Number를 확인합니다. 다음, 인터넷 접속이 가능한 컴퓨터에서 my.eaw.com에

로그인합니다. (계정이 없는 경우 가입하여 새 계정을 만듭니다.) 로그인 후

Smaart 6 제품 등록을 하고 Machine Number를 입력 한 후 Keyfile을 다운로드

받아 Smaart 6가 설치된 컴퓨터로 복사해와 ‘Unlock Now > Unlock with Keyfile’을
클릭하고 열린 탐색창에서 복사해 온 Keyfile을 선택하면 정품인증이

완료됩니다. 
 

 
설치와 정품인증이 완료된 후 재부팅 메시지가 나타날 경우 재부팅하고, 그렇지

않으면 바로 Smaart 6를 실행하여 사용하셔도 됩니다. 

 

 

프로그램 설치 중이나 설치 후 문제가 있으시면, Chapter 6: 문제 해결을 참고해

주십시오. 
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1.3 Smaart 6 신호 입출력 

 

1. 컴퓨터가 사운드카드를 인식했는지 확인합니다. 
2. 외부 오디오장치를 연결합니다. 
3. Smaart 6를 실행합니다. 

(Smaart 6가 실행되는 동안 외부 오디오장치의 연결을 해제하지 마십시오.) 

4. Options > Audio I/O에서 오디오 입출력장치와 사용할 채널을 선택합니다. 
 

 

< 그림 1-1 > 옵션 대화창의 Audio I/O 설정 화면 

 

 

5. Input / Output Device의 목록에서 각각 입력장치, 출력장치를 선택합니다. 
6. Meas / Ref In에서 각각 측정 / 레퍼런스신호를 위한 채널을 선택합니다. 
7. Main Out과 Aux Out의 목록에서 각각 출력으로 사용할 채널을 선택합니다. 
8. Input/Output Device의 Bits Per Sample에서 원하는 해상도를 선택합니다. 
9. 사운드카드나 외장 프리앰프의 입력, 출력에 연결될 장치들을 연결하면

Smaart 6를 사용할 준비가 완료됩니다. 
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많은 사운드카드는 내부회로를 통해 다양한 오디오신호를 선택하여 받아들이고, 또

이 신호들 중 일부나 여러 개를 섞어 마스터 출력으로 내보냅니다. 따라서

사운드카드의 입출력이 라인레벨로 설정되었는지 확인해 볼 필요가 있습니다. 
 

Smaart 6는 신호발생기 사용 시 장비의 손상, 과도한 입력신호 등을 방지하기 위해

기본적으로 작은 레벨로 맞추어져 있습니다. 신호발생기를 통해 만들어진 신호의

출력레벨은 윈도우의 믹서 설정과 사용하는 장치의 출력레벨의 영향도 받으므로

윈도우 믹서와 장치의 출력레벨을 먼저 확인 후 적당한 레벨로 조정하여 사용합니다.
 

 
< 그림 1-2 > 입력레벨: 너무 작음(좌), 적당함(중앙), 너무 큼(우) 

 

 

측정을 위한 입력레벨은 -12dB ~ -6dB 정도가 적당합니다. 즉, 입력레벨은 가능한

크게 받아야 하지만 사운드카드의 입력에서 오버로드(overload) 되거나 A/D 
컨버터에서 클리핑(clipping) 되지 않게 조정해야 합니다. Smaart 6 구동 시 입력레벨

미터는 사운드카드의 A/D 컨버터의 입력레벨을 표시합니다. 레벨이 너무 높으면

입력레벨미터 상단의 클리핑 표시로 알 수 있으며, 정확한 측정을 위해서 입력레벨을

적당히 줄여야 합니다. 

 
사용하는 컴퓨터가 마이크입력과 라인레벨입력이 모두 가능하다면, 라인레벨신호를

마이크입력으로 보내지 않도록 조심해야 합니다. 대부분 컴퓨터 사운드카드의

프리앰프 회로는 값싼 믹서보다 질이 떨어지므로, 컴퓨터 사운드 하드웨어의

마이크입력을 사용하는 것보다 외부 오디오장치나 작은 믹서를 사용하는 편이 좋은

결과를 얻을 수 있습니다. 
 

1.4 사용자 인터페이스 소개 

 

Smaart 6의 인터페이스는 프로그램 내의 주요 기능을 한번의 클릭으로 접근, 사용 할

수 있도록 제작 되었으며, 측정결과 디스플레이를 위한 옵션사항들은 드롭리스트에서

선택하도록 되어있기 때문에 쉽고 빠르게 관련 파라미터를 수정할 수 있습니다. 
신호발생기, SPL 표시부분, 또는 딜레이 정보표시(readout) 영역을 클릭하면 나타나는

대화창을 통해 관련 파라미터를 설정할 수 있으며, 측정값을 표시해주는 표시창(plot) 
위의 특정 부분을 드래그하면 그 부분을 확대하여 자세히 볼 수도 있습니다. 게다가

표시창(plot)을 통해 표시되는 여러 가지 형태의 측정결과를 표시창(plot) 좌측상단의

버튼을 클릭하여 쉽게 전환할 수 있습니다.  
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표시창(plot)의 오른쪽에는 주요 측정 형태인 스펙트럼과 주파수응답의 결과

디스플레이에 대한 설정을 할 수 있는 부분이 있습니다. 스펙트럼과 주파수응답

버튼을 클릭하여 관련 그래프 형태를 볼 수 있고, 이 버튼 오른쪽의 화살표를

클릭하여 표시 설정을 위한 대화창을 열 수 있습니다. 

 

 
메뉴와 셋팅에 관한 자세한 사항은 Chapter 5와 Chapter 6를 참고 바랍니다. 

 

< 그림 1-3 > Smaart 6 메인 창 

1.4.1 메뉴 

 

Smaart에서 가장 많이 사용되는 주요 기능들과 명령들은 키보드 단축키나

화면상에서 직접 접근이 가능합니다. 이러한 기능들은 메뉴 항목을 통해서도 선택이

가능하며, 일부 자주 사용되지 않는 기능들은 메뉴 항목을 통해서만 접근이

가능합니다. 

 

< 그림 1-4 > 메뉴 바 

 

 
메뉴 중 “…”와 같이 끝나는 항목 선택 시 대화창이 열리고, 화살표가 있는 항목을

선택하면 하위메뉴가 나타납니다. 
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1.4.2 표시창(Plot) 영역 

 
Smaart 6가 측정한 데이터를 표시하기 위한 부분입니다. 더 자세한 사항은 ‘Chapter 3: 
분석 모드와 디스플레이 형태’를 참고 바랍니다. 
 

1.4.3 커서 정보표시(Cursor readout) 

 

표시창(plot) 영역에 마우스를 가져가면 커서(그림 1-5의 흰색 십자 모양)를 볼 수 
있으며, 커서가 위치하는 곳의 세부적인 측정값을 표시창(plot) 상단의 커서

정보표시(cursor readout) 영역에 수치로 보여줍니다. 고정 커서를 활성화했을 경우

역시 그 좌표도 같은 곳에 보여지고, 마우스를 따라 움직이는 커서와의 차이도

수치로 보여줍니다. (3.10 고정 커서 참고) 
 

 
< 그림 1-5 > 커서 정보표시 영역 (노란색 글씨 부분) 

 

1.4.4 시작/정지 버튼 

 

모든 실시간 측정 모드에서 시작(Start)버튼을 클릭하면 Smaart 6가 측정을 시작하고

그 결과가 표시창(plot)에 나타납니다. Smaart 6가 동작하는 동안 시작(Start)버튼은

정지(Stop)버튼으로 바뀌고, 정지(Stop)버튼을 클릭하면 측정을 멈춥니다. 
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1.4.5 측정모드 버튼 

 측정모드 버튼을 클릭하면 아래 세가지 주요 측정 모드를 시작할 수 있습니다. 

 

 스펙트럼(Spectrum): 3.1 스펙트럼 측정 참고 
 주파수응답(Freq. Resp.): 3.2 주파수응답 측정 참고 
 임펄스응답(IR Analysis): 3.3 딜레이와 임펄스응답 측정 참고 

 

              
< 그림 1-6 > 디스플레이 모드 버튼(좌)과 측정 모드 버튼(우) 

 

1.4.6 디스플레이 컨트롤 

 

Smaart 6는 같은 입력 데이터를 여러 가지 형태로 분석하여 표시창(plot)에 
보여줍니다.  표시창 좌측상단의 ‘RTA’, ‘Spectrograph’, ‘Magnitude’, 그리고 ‘Phase’ 
버튼을 클릭하여 이를 선택할 수 있습니다. 이들 중 Spectrograph 버튼이 선택되어

있을 경우 표시창 우측상단의 ‘Capture’, ‘Load’, ‘Legend’ 버튼은 비활성화 됩니다. 
 

1.4.7 레퍼런스 트레이스(Reference Trace) 컨트롤 

 

< 그림 1-7 > 캡처(Capture)와 불러오기(Load) 버튼 

 

 캡처(Capture)와 불러오기(Load) 버튼을 클릭하여 RTA, 주파수응답, 위상에 대한

트레이스를 각각 저장하고 불러와 화면에 표시할 수 있습니다. (‘3.5 측정 데이터

캡처와 불러오기’ 참고) 
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1.4.8 신호발생기(Signal Generator) 

 
< 그림 1-8 > 신호발생기와 딜레이 조정 영역 

 

 Generator 버튼을 클릭하여 신호발생기를 활성화 할 수 있습니다. 다음과 같이

신호발생기를 설정할 수 있습니다. 
 

 

< 그림 1-9 > 신호발생기 설정창 
 

 1. 신호발생기 버튼 아래 신호종류와 그 레벨이 표시되는 영역을 클릭하면

설정을 위한 대화창이 열립니다. 
2. 신호의 종류를 선택하고 레벨을 결정합니다. 
3. Sine Wave 또는 Dual Sine을 선택할 경우에는 주파수 설정도 함께 합니다. 
4. Level 1 오른쪽의 화살표를 클릭하여 레벨을 조정하거나 직접 숫자를

입력하여 레벨을 설정할 수 있습니다. Level 2는 Dual Sine이 선택되었을 때만

활성화됩니다. 
5. Generator ON 옆의 체크박스로 신호발생기를 켜고 끌 수 있습니다. 
6. OK를 클릭하면 설정을 끝내고 창을 닫습니다. 
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1.4.9 내부 딜레이 조정 

 

딜레이 버튼(그림 1-8)을 클릭하여 Smaart 6의 내부 신호 딜레이에 대한 설정을 할 수

있습니다. 내부 딜레이는 0.01ms 단위로 750ms까지 조정 가능합니다. 딜레이 버튼

아래의 정보표시(readout) 영역에서 현재 적용된 딜레이타임를 볼 수 있는데 이

부분을 클릭하여 열리는 창에 직접 딜레이타임을 입력할 수도 있고, 그 오른쪽의

화살표를 클릭하여 딜레이타임을 증감할 수도 있습니다. 화살표 클릭 시 증감 단위는

딜레이 설정창의 ‘Delay Spinner Increment(ms)’에서 조정 가능합니다.  
 

 자동 딜레이 탐지기 버튼 

 

‘Auto Sm’과 ‘Auto Lg’ 버튼(그림 1-8)을 클릭하여 각각 짧은 시간과 긴 시간의

타임윈도우 설정을 사용하는 자동 딜레이 탐지 기능을 사용할 수 있습니다. (자세한

내용은 ‘3.3.3 자동 딜레이 탐지기’를 참고) 
 

1.4.10 신호레벨/SPL표시와 입력레벨미터 

 

< 그림 1-10 > SPL, 입력레벨 미터 

 

 신호 레벨/SPL 정보표시 영역은 SPL Source로 선택되어있는 채널(Options > Audio I/O 
탭에서 확인 가능)의 전체적인 신호 레벨을 숫자로 표시합니다. (정확한 SPL을

표시를 위하여 음압레벨 교정(calibration)이 필요합니다.) 
 

입력레벨미터는 Smaart 6로 입력되고 있는 두 신호의 레벨을 표시합니다.
입력레벨미터의 최대 입력은 사용 중인 장치의 A/D컨버터의 최대 입력을

나타냅니다. 입력레벨미터 상단에는 클립을 표시하는 부분이 있는데 A/D 컨버터로

들어오는 신호가 최대 입력을 넘게 되면 붉게 표시됩니다. 
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Chapter 2: 기초지식, 용어 및 관련서적 
 

 

Chapter 2 에서는 관련된 기초지식과 용어를 정리하였습니다. 하지만 그 내용은

Smaart 6를 사용하는데 꼭 필요한 부분만 다루었기 때문에 수학적인 내용까지

포괄적으로 다루지는 않았습니다. 관련된 주제들에 관하여 더 자세하게 공부하고자

하는 사용자는 Chapter 2 마지막의 ‘관련서적’을 참고바랍니다. 
 

2.1 기초지식 

2.1.1 데시벨 

 

데시벨(dB)은 power, voltage 등을 포함하여 서로 다른 크기를 갖는 두 힘의 양적

차이를 로가리듬의 비(logarithmic ratio)로 표현하는 단위입니다. 전압(voltage)나 음압을

기반으로 하는 대부분의 오디오 측정은 데시벨(dB)이라는 단위를 사용합니다. 
왜냐하면 음압과 주파수에 대한 인간의 청감은 매우 광범위하기 때문에 이를

표현하려면 매우 큰 단위의 수를 사용해야만 하는데, 로그스케일(logarithmic scales)을
사용한다면 이를 간단한 수로 표현할 수 있기 때문입니다. 표 2-1은 power와
voltage의 비(ratio)에 대한 값을 각각 데시벨(dB)로 나타낸 것인데 이를 보면 왜

로그스케일(logarithmic scales)이 필요한지 알 수 있습니다. 
 

< 표 2-1 >  데시벨 과 Power / voltage 비 

 

 

 

1,000,000:1로 표현되는 Power Ratio는 인간 청감 범위의 반 정도인 60dB로

표현됩니다. 데시벨(dB)의 표현 시 0dB의 의미는 자주 혼동됩니다. Smaart에서의

0dB는 다음을 의미합니다. 
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 주파수응답측정 모드에서, 데시벨(dB)값은 입력채널로 들어오는

레퍼런스(reference)신호와 측정(measurement)신호 사이의 차이에 대한

데시벨(dB)값입니다. 
 트랜스퍼 기능(transfer function)에서, 레퍼런스신호보다 측정신호의 에너지가

더 많은 주파수대역에서는 + dB값으로 표현합니다. 즉, 반대의 경우 – 
dB값으로 표현합니다. 

 외부 캘러브레이터(calibrator)로 음압레벨 교정(calibration)이 되지 않은

입력레벨미터는 기본 Full-Scale로 레벨을 표시합니다. 이 때의 0dB(0dBFS)는
사용하는 오디오장치의 A/D컨버터가 갖는 최고레벨을 의미합니다. 즉, 
입력되는 모든 신호는 최고입력 레벨인 0dBFS의 값보다 작기 때문에 그 차에

해당하는 비를 – dB값으로 표현합니다. 
 

2.1.2 고속 푸리에 변환 (FFT) 

 

고속 푸리에 변환(FFT; Fast Fourier Transform)은 시간영역의 신호를 주파수영역의

데이터로 변환하기 위해 사용 되는 수학기법인 이산 푸리에 변환(DFT; Discrete 
Fourier Transform)을 획기적으로 빠르게 수행하기 위해 만들어진 계산법입니다. 고속

푸리에 변환을 수행하기 위해서 2n개의 샘플로 구성된 시간영역 데이터가

필요합니다. Smaart 6에서 수행하는 모든 주파수변환 역시 2n개 길이로 된 샘플을

필요로 하는 고속 푸리에 변환을 이용합니다. 
 

< 표 2-2 > 2의 거듭제곱 표 

 
 

 

 

 
2n개가 아닌 샘플로 구성된 시간영역 데이터의 푸리에 변환 역시 가능하지만, 더 많은 계산이 

필요하기 때문에 변환을 위한 많은 시간이 필요하게 됩니다. 
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2.1.3 평균(Averaging) 

 

FFT 측정 시 음악이나 랜덤 노이즈(random noise)와 같은 비동기성의 테스트신호를

사용할 때, 여러 개의 FFT frame의 데이터를 평균하는 것이 유용합니다. 여러 개의

FFT frame을 평균한다는 것은 다음과 같습니다. 
 

 

 모든 주파수대역에서 충분한 에너지를 가질 가능성이 증가하여 보다 정확한

측정이 가능합니다. 
 동적인 신호의 전체 주파수 정보를 보기 쉽게 만들어줍니다. 
 한 단위의(single) FFT 측정 시 오류로 작용할 수도 있는 소스가 전체 측정에

주는 영향을 최소화 할 수 있습니다. 
 

 

Smaart의 평균(averaging)기능은 그 설정에 따라 여러 개의 FFT 프레임을 선형적(모든

FFT 프레임을 같은 비중으로 합하여), 또는 지수적(최근 FFT 프레임일수록 그

데이터에 더 큰 비중을 주어)으로 합하여 평균하는 것입니다. 이를 위해 Smaart에서

사용되는 거의 모든 평균 기능은 RMS 평균에 기반을 두고 있습니다. 선형평균(linear 
averaging)은 산술(artithmetic)평균이라고도 합니다. Smaart에는 1 frame부터 128 
frame까지의 선형평균 옵션이 있습니다. 분석이 진행되는 동안의 모든 데이터를

선형평균하는 무한(infinite)평균 옵션도 있습니다. 스펙트럼측정과 SPL 측정에서

사용되는 ‘Fast’와 ‘Slow’ 평균 옵션은 지수적(exponential) 평균입니다. 
 

2.1.4 샘플링레이트 

 

샘플링레이트는 아날로그 오디오신호를 디지털 오디오 신호로 변환하기 위해 매

초(second)마다 취해지는 샘플의 수를 말합니다. 기억해야 할 중요한 점은

샘플링레이트가 측정할 신호의 가장 높은 주파수를 결정한다는 것입니다. 즉, 
샘플링레이트의 절반에 해당하는 주파수가 그 샘플링레이트로 디지털화 된 신호가

가진 최고 주파수가 되고, 이를 처음 밝혀낸 Harry Nyquist의 이름을 따서 나이키스트

주파수(Nyquist frequency)라고 부릅니다. 
 
디지털로 변환되는 신호 중 나이키스트 주파수보다 높은 주파수는 앨리에이싱 또는

중첩되고 왜곡된 저음으로 더해지게 됩니다. 이러한 이유로 A/D 컨버터 이전의

단계에서 좋은 성능의 로우패스필터를 이용해 불필요한 고음역대의 주파수 성분을

제거하는 것이 일반적이며, 이를 안티앨리에이싱 필터(anti-aliasing filter)라고 합니다. 
안티앨리에이싱 필터는 주어진 나이키스트 주파수의 90% 이하의 주파수 대역만

통과하도록 걸어주는 것이 일반적입니다. 

 
Smaart 6는 사용중인 사운드카드가 지원하는 다양한 샘플링레이트(최고 96kHz)로
작업이 가능합니다. 
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2.1.5 주파수 해상도(Frequency Resolution) 

 

FFT의 주파수 해상도(Q)는 샘플링레이트를 FFT사이즈로 나눈 것과 같으며, 0 Hz부터

나이키스트 주파수까지 Q Hz의 간격마다 FFT 데이터 포인트를 갖게 되며, FFT
데이터 포인트마다 주파수 데이터를 가지게 됩니다. 예를 들어 샘플링레이트가 44.1 
kHz일 때 FFT사이즈가 4096(4k)이라면 주파수 해상도(Q)는 10.77 Hz입니다. 따라서 0 
- 22.05 kHz까지 매 10.77 Hz마다 FFT 데이터 포인트를 가지게 됩니다. 
 

 주파수응답 측정모드의 Fixed-Point Per Octave (FPPO) 옵션 

 

선형으로 나누어져 있는 FFT 데이터 포인트는 현실적으로 한가지 문제점이 있는데, 
그것은 인간이 선형이 아니라 로그스케일로 주파수를 인지한다는 것입니다. 즉, 
인간의 청감은 두 배씩 늘어가는 주파수 간격(octave)을 같은 간격이라고 느낍니다. 
즉, 앞의 예와 같이 10.77 Hz의 주파수 해상도일 때 31.5 – 63 Hz에서의 FFT 데이터

포인트는 겨우 3개로 해상도가 매우 낮은 반면, 8 – 16 kHz에서는 700개 이상의 FFT 
데이터 포인트를 갖게 됩니다. 이를 로그스케일의 그래프로 보면 고음역대의

데이터는 매우 밀집되어있어 복잡한 그래프로 표현되어 해석이 어려워집니다. 

 
이러한 문제를 해결하기 위해 Smaart 6는 FPPO 옵션을 제공하는데, 이는 (각각 다른

샘플링레이트와 FFT사이즈를 갖는) 다중 FFT를 이용하여 옥타브 별로 같은

해상도를 가질 수 있도록 하는 옵션입니다. 좀 더 자세히 말하자면, 2개의 최저

옥타브에는 24개의 FFT 데이터 포인트를 할당하고, 또 44 Hz 이상의

주파수대역에서는 매 옥타브 당 24개의 FFT 데이터 포인트 할당하는 것으로 저음

대역일수록 긴 타임윈도우를, 반대로 고음 대역일수록 짧은 타임윈도우를 적용하여

처리된 결과를 한번에 표시해주는 옵션입니다. 
 

 주파수 해상도와 주파수대역 표시 

 

주파수응답 측정 모드에는 다중 FFT 기술이 사용되는 옵션이 있는 반면, 모든 RTA 
표시는 단일 FFT에 의해서 계산된 결과를 표시합니다. 단일 FFT는 FFT 데이터

포인트를 선형적으로 할당하기 때문에 높은 주파수 대역에 비하여 낮은 주파수

대역은 매우 낮은 해상도를 가지게 됩니다. 관련 설정에 따라 낮은 주파수대역에는

데이터 포인트가 없거나 1개만 있을 수도 있습니다. 
 

Smaart는 이러한 문제점을 개선하기 위해 낮은 주파수 대역들에 에너지를 적당하게

분배하여 RTA를 표시하기 위한 진보된 알고리즘을 사용합니다. 하지만 낮은 주파수

대역의 FFT 데이터 포인트가 너무 적다면 그 효과가 떨어지게 됩니다. 그러므로

좋은 주파수 해상도를 얻기 위해서는 필요한 최저 주파수에 따라 적당한 FFT 
파라미터를 선택할 것을 권장합니다. 
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2.1.6 핑크노이즈와 화이트노이즈 

 
핑크노이즈와 화이트노이즈는 불규칙하게 임의로 생성된 광대역 에너지입니다. 이

노이즈들은 음향측정을 위한 소스신호로 많이 사용됩니다. 
 

 핑크노이즈 

 

핑크노이즈는 매 옥타브 대역이 가지는 에너지가 같은 노이즈입니다. 이 노이즈를

RTA 상의 옥타브 대역 표시로 본다면 평탄한 스펙트럼을 가집니다. 하지만 이를

로그스케일로 본다면 옥타브 당 3dB씩 감소하는 모양이 됩니다. (그림 2-1 참고). 
 

 

< 그림 2-1 > 옥타브스케일(좌)과 로그스케일(우)로 본 핑크노이즈 그래프 

 
 

 화이트노이즈 

 

화이트노이즈는 주파수 대역 별로 가지는 에너지가 같은 노이즈입니다. 이 노이즈를

로그스케일로 본다면 평탄한 스펙트럼을 가집니다. 하지만 옥타브 대역 표시로

본다면 3dB씩 증가하는 스펙트럼을 보입니다. (그림 2-2 참고) 
 

 
< 그림 2-2 > 옥타브스케일(좌)과 로그스케일(우)로 본 화이트노이즈 그래프 
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 노이즈 소스의 선택 

 

주파수응답 측정 시 핑크노이즈나 화이트노이즈 중 어떠한 것을 소스신호로

사용하여도 결과에는 영향이 없습니다. 왜냐하면 트랜스퍼 기능(transfer function)은
주어진 두 신호를 주파수 포인트 별로 비교한 결과이기 때문입니다. 하지만

RTA에서의 결과는 달라집니다. RTA에서 로그스케일로 이 두 노이즈를 측정하면

화이트노이즈는 평탄한 스펙트럼을 보이고, 핑크노이즈는 고음 대역으로 갈수록

에너지가 줄어드는 스펙트럼을 보입니다. 

 

 

 
화이트노이즈는 주로 전자 부품이나 장비를 테스트하기 위해 사용하지만 높은 주파수 대역의 

에너지가 많아서 높은 레벨로 재생된다면 스피커에 손상을 주기 쉽습니다. 그러므로 

사운드시스템의 측정을 위해 화이트노이즈를 사용하지 않는 것이 좋습니다. 

 

 

2.1.7 데이터 윈도우 기능 

 

데이터 윈도우 기능은 임의의 시간영역 신호를 FFT사이즈에 따라 한 단위로

끊어내어 FFT 과정을 수행할 때 발생하는 문제를 줄이기 위해 사용됩니다. FFT
과정은 변환 대상 신호가 연속해서 반복된다는 가정하에 이루어지기 때문에 한

단위로 끊어낸 데이터의 시작과 끝부분 사이의 불연속성은 FFT 과정에서 과도하게

높은 노이즈로 인식되고 모든 주파수들에서 인접한 주파수로 누설(leakage)이 생기는

결과를 초래합니다. 
 

데이터 윈도우 기능은 FFT 과정 이전에 신호의 시작과 끝부분을 감쇠함으로써 위의

문제를 완화시켜줍니다. 이 기능으로 불연속성이 만드는 문제는 상당히 줄일 수는

있지만, 그 감쇠곡선의 정밀한 모양을 어떻게 할 것인가 하는 등의 몇 가지 고려 해

볼 사항들이 있습니다. 여러 가지 장점들과 단점들이 있는 많은 데이터 윈도우

기능들이 수년간 발전해왔고, 대부분 오디오 관련 사용에서 Gaussian tapers로
처리하는 것이 우수하다고 하지만, Smaart에서는 특별한 이유로 다른 윈도우 기능을

사용해야 하는 경우가 아니라면 기본적으로 선택되어있는 Hanning window(Hann 
window라고도 함)를 사용할 것을 권장합니다. 
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2.1.8 임펄스응답 

 

임펄스응답은 순간적인 자극(임펄스)에 대한 테스트 대상 시스템(SUT; System Under 
Test)의 반응을 말합니다. SUT는 하나의 장비나 사운드시스템, 또는 건축음향적

환경일 수도 있습니다. Smaart 6에서의 임펄스응답은 그 시스템의 특성을

시간영역으로 표현한 것입니다. 즉, 임펄스응답은 테스트 신호가 SUT를 거치는 동안

생겨난 변화를 알려주는 신호입니다. 임펄스응답을 통하여 딜레이, 주파수응답 특성

등 SUT에 대한 많은 정보를 알 수 있으며, 또 반사음, 잔향 그리고 감쇠 특성 등

건축음향적 특성을 파악할 수 있습니다. 
 

 

 

 
어떠한 공간이나 시스템의 임펄스응답 특성을 이용하여 목소리나 음악과 같은 음원에 그 

특성을 갖도록 처리하면 그 음원이 같은 시스템과 공간에서 재생될 때 어떻게 들릴 것인지를 

알아볼 수 있습니다. 

 

 

2.1.9 트랜스퍼 기능(The Transfer Function) 

 

Smaart 6의 주파수응답(매그너튜드와 위상 측정)과 임펄스응답 데이터는 트랜스퍼

기능(transfer function)이라고 불리는 수학적 연산을 통하여 이루어집니다. 이는 EQ, 
사운드시스템 또는 특정 공간과 같은 테스트 대상 장비(이하 DUT; Device Under 
Test)나 시스템(SUT; System Under Test)을 거치기 이전의 신호(레퍼런스 신호)와 거친

후(측정 신호)의 신호를 비교하는 기능을 말합니다. Smaart 6는 주파수응답과

임펄스응답 측정에 이용되는 연산은 모두 이 기능을 기반으로 이루어집니다.
트랜스퍼 기능 연산은 FFT 데이터를 이용하여 주파수영역에서 이루어지며, 그

결과는 표시 모드에 따라 주파수 영역뿐만 아니라 시간 영역으로도 볼 수 있습니다. 
 

Smaart 6의 주파수응답 측정은 SUT의 매그너튜드(magnitude)와 위상 특성을 파악하기

위하여 트랜스퍼 기능(transfer function) 결과를 주파수 영역에서 보여줍니다. 
임펄스분석 모드에서, Smaart 6는 매우 긴 FFT 과정으로부터 나온 데이터를 이용하여

트랜스퍼 기능(transfer function)을 수행하고 난 후, SUT의 임펄스응답을 보기 위하여

그 결과를 다시 시간영역의 데이터로 변환합니다. 
 

정확한 주파수응답 측정을 수행하려면 레퍼런스신호와 측정신호는 시간상으로

반드시 정렬되어야 합니다. 임펄스응답 측정은 두 신호간의 지연시간을 파악하기

위해서도 유용하게 사용됩니다. 
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2.1.10 코히어런스(Coherence) 

 

Smaart 6의 코히어런스(coherence) 표시는 복잡한 수학적 기능을 통하여 두 신호간의

코히어런스(coherence)를 측정하고 나타냅니다. Smaart는 코히어런스(coherence)에 대한

값을 0에서 1까지의 숫자가 아닌 백분율(%)로 표현합니다. 같은 입력조건으로

측정된 한 단위의 FFT 프레임만 비교를 한다면 즉, 평균을 1(프레임)로 선택하였을

경우 같은 입력 조건으로 측정된 두 FFT 프레임의 코히어런스(coherence)는 항상

1입니다. 비선형적인 문제는 두 신호가 일정 시간 이상 평균되었을 때만 나타나므로

평균(average) 옵션이 1(프레임)로 선택되었을 때는 코히어런스(coherence) 표시는

사라집니다. 그리고 평균값이 클수록 전체적인 코히어런스(coherence)는 감소하는

경향을 보입니다. 
 

두 신호 사이의 시간 차, 특정 주파수가 충분하지 못한 레퍼런스신호, 반사음이나

잔향과 같은 건축음향적인 영향, 또 주변 환경 또는 전기적인 노이즈 등 여러 가지

요인을 포함한 트랜스퍼 기능(transfer function) 데이터는 코히어런스(coherence)에 좋지

못한 영향을 줄 수 있습니다. 측정신호의 경로 중에 사용된 컴프레서나 리미터와

같은 비선형 처리장치들은 코히어런스(coherence)에 안 좋은 영향을 줄 수 있습니다. 
그러므로 측정 시 주의 바랍니다. 
 

2.1.11 신호 정렬(Signal Alignment) 

 

주파수응답 측정을 수행할 때, 반드시 레퍼런스신호와 측정신호는 시간상으로 같은

위치에 정렬되어야 합니다. 다시 말해 두 신호의 차이를 정확하게 비교하기

위해서는 두 신호가 갖는 같은 시간 상의 데이터로 트랜스퍼 기능(transfer function)을
수행하여야 합니다. 대부분의 아날로그 오디오장치에서 신호 정렬은 문제가 되지

않고 일반적으로 보정도 필요하지 않습니다. 그러나 모든 디지털 신호 처리장치는

소리가 공기 중에서 퍼져나가 마이크에 도달하는 것과 같은 약간의

지연시간(Propagation Delay)을 가지고 있습니다. 
 

지연시간이 생길 수 있는 측정 대상 장비나 시스템의 주파수응답 측정을 정확하게

하기 위해서는 반드시 그 지연시간을 찾아 보정해 주어야 합니다. 즉, 측정신호가

가지고 있는 지연시간을 찾아, 레퍼런스신호를 그 시간만큼 늦춰줌으로써 두 신호가

같은 시간 상에 놓인 채 비교될 수 있도록 하여야 합니다. Smaart 6의 딜레이

탐지기(Delay Locater)와 내부 딜레이(Internal Delay) 기능을 이용하면 위의 과정을

쉽게 해결할 수 있습니다. (3.3.3 자동 딜레이 탐지기와 3.6 내부 딜레이 참고). 
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2.2 용어 

 

Analog to Digital (A/D) Conversion: 표본화, 양자화 과정을 통해 아날로그신호를

디지털신호로 바꾸는 과정 

 
Amplitude: 방향과 상관없이 양(+)의 실수로 그 크기만을 표현하는 단위입니다.
일반적으로 Amplitude를 나타내는 수는 복잡하지 않으며, 로그스케일에서 사용되지

않습니다. 로그스케일로 표현되는 수의 크기는 Magnitude라고 표현하는 것이 더

적당합니다. 

 
Attenuation: 신호 레벨의 감소를 말하며, 전체적인 레벨의 감소뿐만 아니라 특정

주파수 영역에서 레벨이 감소하는 현상도 Attenuation에 포함됩니다. 

 
Coherence: 두 신호 사이의 선형성(linearity)을 나타내며, 그 값은 보통 0에서 1 
사이의 값으로 표현됩니다. 측정 환경과 평균 옵션의 설정은 코히어런스(coherence)
결과에 영향을 줄 수 있습니다. 

 
Compressors: 오디오신호의 다이나믹 레인지를 다루기 위해 사용하는 장비로써 신호

레벨의 변화가 발생합니다(감쇠하는 쪽으로). 컴프레서는 비선형 처리장치이기

때문에 주파수응답 측정 시 사용을 금해야 합니다. 

 
Crosstalk: 인접한 신호(채널)로부터 불필요한 에너지가 새어 들어오는 현상 

 
Data Window: 임의의 시간영역 신호를 FFT사이즈에 따라 한 단위로 끊어내어 FFT 
과정을 수행할 때 그 시작과 끝 지점 사이의 불연속성 때문에 발생하는 문제를

줄이기 위해 사용되는 수학적 기능. 임의로 끊어낸 시간영역 데이터의 시작과

끝부분의 크기(amplitude)를 줄여줌으로써 문제를 해결합니다. 
 

Decay Rate: 신호의 크기가 감쇠하는 비율로서 초당 감소하는 dB(dB/sec)로
표현하거나, 신호의 크기가 60dB 감소하는데 걸리는 시간 등으로 표현합니다. (2.2 
용어 설명의 ‘Reverberation Time’ 참고) 

 
Decibel: 데시벨(dB)은 두 값 사이의 로가리듬적(logarithmic) 비를 나타냅니다. 음향

분야에서의 데시벨은 시스템의 입력레벨에 대한 출력레벨을 나타낼 때, 또 정해진

기준에 대해 주어진 레벨을 상대적으로 표현할 때 많이 사용됩니다. 

 
Dynamic Range: 어떤 장비나 시스템이 받아들일 수 있는, 또는 재생할 수 있는

신호의 가장 큰 값과 작은 값 사이의 차. 
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FFT: 고속푸리에변환(Fast Fourier Transform)은 “고속”이라는 말에서 알 수 있듯이

시간영역 데이터를 주파수영역 데이터로 변환하는 이산푸리에변환 (DFT; Discrete 
Fourier Transform)을 아주 빠르게 수행할 수 있도록 하는 수학적 함수입니다. 이는

컴퓨터의 연산과정에 있어서 16, 32, 64, 128, 256 등과 같이 2n개의 샘플로 구성된

시간영역 데이터가 훨씬 빠르게 처리될 수 있는 원리를 이용합니다. 

 
FFT Time Constant: 주어진 샘플링 레이트와 FFT사이즈에 따라 한 개의 FFT 
프레임에 해당하는 샘플들을 모으는데 걸리는 시간. FFT의 Time Constant는 Time 
Window와 같은 의미이며, FFT 사이즈를 샘플링 레이트로 나누어 나온 값과

같습니다. 예를 들어, 샘플링 레이트가 44.1kHz일 때 FFT 사이즈를 4k로

설정하였다면 Time Window(FFT Time Constant)는 0.09초가 됩니다. 

 
Graphic Equalizer: 특정 주파수의 신호를 키우거나 줄이기 위해 사용되는 여러 개의

필터를 가진 장치. 1옥타브 밴드 또는 1/3옥타브 밴드의 제품이 일반적입니다. 

 
Latency: 어떤 장비나 시스템으로 들어간 신호가 내부에서 처리되어 나올 때

발생하는 지연시간.  

 
Linear Scale(선형스케일): 아래 그림과 같이 각 수치들이 일정한 간격으로 배치되어

있는 스케일. 

 

 
< Linear Scale > 

 
 
Logarithmic Scale(로그스케일): 아래 그림과 같이 수치가 커질수록 차지하는 간격이

좁아지는 스케일. 각 수치를 10n 의 표현으로 바꾼다면 n이 같은 간격으로 늘어간다. 
예를 들어 100, 101, 102, 103과 같은 수치들이 같은 간격으로 늘어갑니다. 
 

 
< Logarithmic Scale > 

 
 
Magnitude: 다른 양과 비교될 수 있는 양을 나타내는 수치. 복소수에서의

양(quantity)에 대한 magnitude 값은 절대값으로 표현합니다. 
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Nyquist Frequency: 나이키스트 주파수는 샘플링레이트의 절반과 같습니다. 
나이키스트 주파수는 아날로그 신호가 주어진 샘플링레이트에서 샘플링 과정을 거쳐

디지털신호로 변환될 때 받아들여지는 가장 높은 주파수를 나타낸다. 

 
Octave-Band Resolution: 선형 또는 로그스케일에서의 그래프는 각각의 FFT 데이터

포인트의 값을 모두 표시하는 좁은 대역의 해상도를 갖습니다. 이와는 다르게

옥타브 대역 해상도는 전체 표시 대역을 옥타브 단위로 나누고, 옥타브 단위 내의

모든 FFT 데이터 포인트를 합하여 각 옥타브 단위가 갖는 총 에너지를 표시합니다. 

 
Overlap: Smaart 6에서, 오버랩은 각각의 연속하는 FFT 프레임이 이전의 FFT 
프레임과 나누는(프레임 간에 서로 겹치게 되는) 데이터의 양을 말합니다. FFT 
프레임이 오버랩된다는 것은 지붕의 기왓장과 유사합니다. 오버랩이 사용되지

않는다면, 실에 꿰어진 구슬처럼 각각의 새로운 FFT 프레임은 이전 프레임이 끝난

뒤부터 시작될 것입니다. 
 

Parametric Equalizer: 이퀄라이저는 신호의 주파수 성분에 작용하는 하나 이상의

필터를 가진 장치입니다. 파라메트릭 이퀄라이저의 각 필터의 파라미터(gain 또는

attenuation, 주파수 대역 및 그 대역 폭 등)를 사용자가 조정할 수 있습니다. 
 

Phase Shift: 어떤 신호에서 하나 또는 여러 개의 주파수에서 나타나는 타이밍(어떤

기준에 대해 상대적으로 갖게 되는) 차이를 말합니다. 일반적으로 도(degree) 단위를

써서 표시합니다. 

 
Pink Noise: 매 옥타브 대역이 가지는 에너지가 같은 신호. 
 

Propagation Delay: 소리가 한 장소에서 다른 장소로 전파되는데 걸리는 시간.
일반적으로 라우드스피커에서 마이크로폰으로 전달되는데 걸리는 시간. 

 
Reverberation Time: 특정 공간에 전해진 음향 에너지가 정해진 dB 만큼 감쇠하는데

걸리는 시간을 말하며, 일반적으로 RT60 값으로 나타낸다. 
 

RT60: 잔향시간을 말하며, 특정 공간에서 음향 에너지가 60dB 감쇠하는데 필요한

시간. 

 
Sampling Rate (SR): 아날로그신호를 디지털로 변환하는 과정에서 초(second)당
취해지는 데이터 포인트의 수를 말하며, Hz 단위를 사용합니다. 
 

Signal to Noise Ratio (S/N): 노이즈 레벨에 대한 신호 레벨의 비를 말하며, S/N비가

너무 작으면, 노이즈가 측정값을 압도하여 측정을 무의미하게 합니다. 
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Spectrograph: 주파수와 시간을 축으로 하는 2차원 표현에 각 주파수 대역의 크기를

색으로 표현하는 하는 기능을 더한 3차원 그래프. 
 

Spectrum: 스펙트럼은 주어진 신호의 주파수 별 정보를 보여줍니다. 
 

Speed of Sound: 소리의 속도는 매질과, 온도, 그리고 또 다른 많은 요인들과 관계가

있습니다. 일반적으로 341.376m/s(1120ft/s)를 공기 중의 소리의 속도로 합니다. 이

값은 Smaart 6가 시간차에 따른 거리를 계산할 때 사용됩니다. 
 

System Under Test (SUT): Smaart 6로 측정하려는 시스템을 말합니다. 이는 한 대의

장비가 될 수도 있고, 또는 건축음향을 포함한 (여러 개의 스피커와 파워앰프로

구성된) 시스템일 수도 있습니다. 
 

Time Window: 측정 또는 다른 과정의 time constant와 같은 의미입니다. 
 

Time Constant (TC): TC = FFT size/SR (SR=샘플링레이트) 

 
White Noise: 매 주파수 대역 별로 가지는 에너지가 같은 노이즈입니다 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



EAW Smaart 6.1 사용 설명서 
 

Copyright ⓒ SmaartCorea. All Rights Reserved. - 30 -

2.3 관련 서적 

 
다음은 Smaart 6, 사운드시스템 디자인, 음향학에 관련된 물리적, 이론적 개념과

수학적 처리에 대한 이해를 넓히고자 하는 분들께 권장하는 서적들입니다. 
 

 

Badmaieff, A. & Davis, D. How to Build Speaker Enclosures. Indianapolis: Howard W. Sams & 
Co., 1966. 
 
Ballou, G. ed. Handbook for Sound Engineers - The New Audio Cyclopedia. Indianapolis: 
Howard W. Sams & Co., 1987. 
 
Bensen, K. B. ed. Audio Engineering Handbook. New York: McGraw-Hill Book Co., 1988. 
 
Beranek, L. L. Acoustical Measurements. New York: John Wiley and Sons, Inc., 1949; reissued 
by the American Institute of Physics for the Acoustical Society of America, New York:1986. 
 
Beranek, L. L. Acoustics. New York: McGraw-Hill book Co., 1954; reissued by the American 
Institute of Physics for the Acoustical Society of America, New York, 1986. 
 
Brigham, E. The Fast Fourier Transform and its Applications. Englewood Cliffs: Prentice-Hall, 
Inc., 1988 
 
Davis, D. & Davis, C. Sound System Engineering, Second Edition. Indianapolis: Howard W. 
Sams & Co., 1987. 
 
Davis, G. & Jones, R. Yamaha Sound Reinforcement Handbook, Second Edition. Milwaukee: Hal 
Leonard, 1989. 
 
Digital Signal Processing Committee, ed. Selected Papers in Digital Signal Processing, II. IEEE 
Press Selected Reprint Series, New York: IEEE Press, 1975. 
 
Digital Signal Processing Committee, ed. Programs for Digital Signal Processing. IEEE Press 
Selected Reprint Series, New York: IEEE Press, 1979. 
 
Eargle J. Handbook of Sound System Design. Plainview: Elar, 1989 
 
______. The Microphone Handbook. Plainview: Elar, 1982 
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Everest, F. A. Successful Sound System operation. Blue Ridge Summit: TAB Books, 1985. 
 
______. The Master Handbook of Acoustics. Blue Ridge Summit: TAB Books, 1983. 
 
Giddings, P., Audio System Design and Installation. Indianapolis: Howard W. Sams & Co., 1990.
 
Harris, H. J. “On the Use of Windows for Harmonic Analysis with the discrete Fourier 
Transform,” Proceedings of the IEEE, Vol. 66, No. 1, pp. 51-83, January 1978. 
 
Huber, D.M., Microphone Manual: Design and Application. Indianapolis: Howard W. Sams & 
Co., 1988. 
 
Ifeachor, E. C. & Jervis, B. W. Digital Signal Processing: A Practical Approach, Second Edition, 
Essex, England: Prentice Hall, 2002 
 
Knudson, V. O. & Harris, C. M. Acoustical Designing in Architecture, New York: John Wiley 
and Sons, Inc., 1950; reissued by the American Institute of Physics for the Acoustical Society of 
America, New York, 1978. 
 
Lubman D. and Wetherill E., eds. Acoustics of Worship Spaces. New York: The American 
Institute of Physics, 1983 
 
McCarthy, B. Meyer Sound Design Reference For Sound Reinforcement. Berkely: Meyer Sound 
Laboratories, 1998 
 
Olson, H. F. Acoustical Engineering. Princeton: Van Nostrand, 1957; reissued by Professional 
Audio Journals, Philadelphia, 1991. 
 
Olson, H. F. Music, Physics and Engineering. New York: Dover Publications, 1967. 
 
Oppenheim, A. V., ed. Applications of Digital Signal Processing. Englewood Cliffs: Prentice-
Hall, Inc., 1978. 
 
Oppenheim A. V. & Schafer, R. Digital Signal Processing. Englewood Cliffs: Prentice-Hall, Inc., 
1975. 
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Prentice-Hall, Inc., 1983. 
 
Otnes, R. K. & Enochson, L. Applied Time Series Analysis. New York: John Wiley and Sons, 
Inc.,1978 
 
Rabiner, L. R. & Rader, C. M., ed. Digital Signal Processing. IEEE Press Selected Reprint Series, 
New York: IEEE Press, 1972. 
 
Rona, J. MIDI: The Ins, Outs, and Thrus. Milwaukee: Hal Leonard, 1987. 
 
Strutt, J. W. (Lord Rayleigh, 1877). Theory of Sound. New York: Dover Publications, 1945. 
 
Tremaine, H. Audio Cyclopedia, Second Edition. Indianapolis: Howard W. Sams & Co., 1969. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



EAW Smaart 6.1 사용 설명서 
 

Copyright ⓒ SmaartCorea. All Rights Reserved. - 33 -

Chapter 3: 분석 모드와 디스플레이 종류 
 

 

Smaart 6에는 실시간 모드와 임펄스응답(IR Analysis) 모드, 이렇게 두 가지의

분석모드가 있습니다. 이 두 가지 모드는 각각 별도의 창에서 독립적으로 실행

가능합니다. 
 

실시간 모드 과정들은 연속하여 들어오는 데이터를 처리하며, 이를 보여주는 네

가지(RTA, Spectrograph, Magnitude, 그리고 Phase) 종류의 디스플레이가 있습니다. 
 

RTA와 Spectrograph 디스플레이는 스펙트럼 측정을 고려하여 만들어졌으며, 각

데이터는 한 채널의 신호를 분석하여 직접 표시합니다. Magnitude와 Phase 
디스플레이는 두 채널의 트랜스퍼 기능(transfer function)을 기반으로 주파수응답

데이터를 보여줍니다.  
 

Spectrum 과 Freq. Resp. 버튼은 실시간모드 중 각각 측정형태와 관련된 두 가지

디스플레이를 표시하도록 설정할 경우 사용합니다. 
 

 

 Spectrum 버튼을 클릭하면, Spectrograph와 RTA가 위, 아래로 동시에 
표시됩니다. 

 Freq. Resp. 버튼을 클릭하면, Phase와 Magnitude가 위, 아래로 동시에 
표시됩니다. 

 

 
< 그림 3-1 > Spectrum 버튼을 클릭하였을 때의 디스플레이 
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Spectrum이나 Freq. Resp. 버튼을 클릭하면 위와 같이 두 가지 디스플레이를 동시에

보여주며, Spectrum이나 Freq. Resp. 버튼을 클릭하여 디스플레이를 선택한 후에도

각각의 디스플레이 창 좌측상단의 버튼을 클릭하여 다른 디스플레이로 전환이

가능합니다. 
 

 

IR Analysis 버튼을 클릭하여 임펄스응답 모드 창을 시작할 수 있습니다. 임펄스응답

모드는 일정량의 데이터를 모으고 저장한 후, 그 데이터를 시간 축 또는 주파수

축을 기반으로 하는 두 가지 디스플레이 형태로 표시할 수 있습니다.  
 

 
< 그림 3-2 > 임펄스응답 창 
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3.1 스펙트럼 측정 

 

실시간 스펙트럼 분석은 피드백 주파수를 찾고, 귀를 훈련하고, 또 주파수 성분을

모니터링 할 수 있는 뛰어난 도구입니다. RTA는 극장시스템 등에 이퀄라이저를

설정하기 위해 많이 사용되고 있으나, 더 큰 규모의 사운드시스템(공연장, 대규모

공연 등)을 튜닝하기 위해서 Smaart와 같은 듀얼 채널 FFT analyzer의 사용이 점차

늘고 있습니다. 듀얼 FFT analyzer는 주파수, 에너지, 그리고 시간에 관련된 모든

측정을 할 수 있는 반면, RTA는 타이밍과 위상에 관련된 값은 나타내지 못합니다. 
좋은 RTA는 여전히 매우 유용한 도구이며, Smaart 6의 RTA는 실시간 스펙트럼

분석을 위한 강력함과 유연함을 제공합니다. 
 

3.1.1 RTA (Real-Time Spectrum Analyzer) 

 

RTA는 가청 주파수 스펙트럼의 다양한 주파수 내에 존재하는 에너지의 양을

실시간으로 보여줍니다. Smaart 6의 RTA 디스플레이는 두 채널의 FFT 기반의 실시간

스펙트럼 분석기가 동시에 동작합니다. 레퍼런스 입력과 측정 입력으로 들어오는

신호의 스펙트럼을 보여주는데, 각각 X축에는 주파수 정보를, Y축에는 그 양을

나타냅니다. RTA 디스플레이에 보여지는 두 가지 데이터의 색상은 각각 입력 레벨

미터의 색상과 같습니다. 
 

실시간 모드에서 Start 버튼을 누르면 실시간 측정이 시작됩니다. RTA 디스플레이가

활성화되어 있을 때, 사운드 장치의 A/D 변환기로부터 전해진 시간 영역 오디오

데이터는 고속 푸리에변환 과정을 통해 계속해서 주파수영역 데이터로 변환되고, 이

데이터는 설정에 따라 선형, 또는 여러 주파수 대역으로 나누어져 RTA 
디스플레이에 실시간으로 보여집니다. 각 주파수 대역(또는 데이터 포인트)의
Magnitude 정보는 샘플링레이트, FFT사이즈, 컴퓨터 사양 등에 따라 매초 여러 번

업데이트 됩니다. 
 

RTA 표시창(plot)의 Y축, 즉 Magnitude의 범위는 Options의 Spectrum 탭의 RTA
부분에서 최대, 최소값을 지정할 수 있습니다. RTA 표시창(Plot) 위에 직접

드래그하면 사각의 영역을 만들 수 있는데, 그러면 사각영역을 확대하여 볼 수

있습니다. (표시창 범위는 키보드 단축키로도 조정할 수 있으며, 단축키는 Chapter 5의

‘5.5 키보드 단축키’를 참고 바랍니다.) RTA 디스플레이 X축(좌측) 또는 Y축(아래)의
좌표값 부분(숫자들이 나열된)을 클릭하면 옵션의 RTA dB 범위에 설정한 범위로

돌아옵니다.  
 

기본 값인 Full Scale Calibration으로 설정되어 있다면, 0dB를 최대 Magnitude 값으로

가지게 되는데, 이 때 0dB는 사용 중인 사운드장치의 A/D 변환기가 받아들일 수

있는 최대 크기와 같게 됩니다. 다시 말해 사용 중인 사운드장치의 최대 입력만큼의
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전압을 갖는 특정 주파수의 사인파가 들어오고 있다면, RTA 표시창(plot)에서 그

주파수의 Magnitude는 0dB로 나타나게 됩니다. Full Scale Calibration은 각 주파수

대역의 상대적인 양적 차이를 파악하기에는 충분하지만, SPL(Sound Pressure Level)과
같이 특정 기준으로 측정해야 할 경우에는 Smaart 6의 음압레벨 교정(calibration)
기능을 통해 외부 기준에 맞춰 음압레벨을 교정(calibration)할 수 있습니다. (레벨

기준을 위한 별도의 캘러브레이터가 필요) 
 

RTA의 주파수 스케일은 옥타브, 1/3옥타브, 1/6옥타브, 1/12옥타브, 1/24옥타브 등으로

설정하여 볼 수 하며, Spectrum 버튼 아래의 Scale에서 설정할 수 있습니다.  
 

RTA 표시창(plot)의 주파수 표시 범위는 키보드 단축키로도 조정 가능하며(Chapter 
5의 ‘5.5 키보드 단축키’를 참고), Options의 Zoom 탭에서 4가지의 범위를 미리 설정해

놓고 키보드의 1 - 4번 숫자 키를 이용하여 빠르게 변환할 수도 있습니다. Smaart의
그래프 표시창(plot)에서 자세하게 보고자 하는 부분이 있을 경우, 그 부분을

마우스로 드래그하여 확대해 볼 수 있습니다. 그래프 창의 좌측 또는 아래 측의

좌표값 부분(숫자들이 나열된)을 클릭하면 원래 표시되던 범위로 돌아옵니다. 
 

3.1.2 스펙트로그래프(Spectrograph) 

 

Smaart 6의 스펙트로그래프는 시간의 흐름에 따라 입력신호의 주파수 성분 변화를

보여줍니다. 다시 말해 현재의 FFT 측정치만 보여주는 RTA와는 조금 다르게, 시간

경과에 따른 각 주파수 성분의 양적 특성이 어떻게 변해가는 가를 보여줍니다. 
 

< 그림 3-3 > Spectrograph 디스플레이 

 

 
스펙트로그래프 디스플레이는 실시간 스펙트럼 분석기(RTA)의 다른 유형입니다. 
일반적인 RTA는 수직막대 등으로 각 주파수 성분의 양을 표현하며, 계속하여

새로운 FFT 결과로 바뀌어 표시합니다. 스펙트로그래프는 RTA 데이터를 수평선으로
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나타내며, 각 주파수 성분의 양은 그 수평선에 색상으로 표시됩니다. 이렇게 주파수

성분의 정보를 담은 수평선은 한번 나타났다가 사라지는 것이 아니고 계속하여

밀려나가며 다음 데이터가 뒤로 쌓여 가므로, 시간에 따라 주파수 성분이 어떻게

변화해 가는 가를 파악할 수 있습니다. 
 

 
스펙트로그래프는 아래의 세가지 데이터를 보여줍니다. 
 

 

 time: X축 
 frequency: Y축 
 magnitude: 색상으로 표시 

 

 

매그너튜드(Magnitude) 값에 따라 나타나는 색상은 Options의 Spectrum 탭의

Spectrograph 부분에서 최대, 최소값을 설정하는데 따라 결정됩니다. 현재 설정된

최대값보다 큰 값은 붉은색으로 나타나고, 최소값보다 작은 값은 검은색으로

나타납니다. 
 

 
< 그림 3-4 > Spectrograph의 dB 범위 

 

 

스펙트로그래프의 주파수 스케일은 표시창(Plot) 위에 직접 마우스를 드래그하여

조정이 가능하며, RTA 디스플레이와 마찬가지로 X축(시간), Y축(주파수)의 좌표값

부분을 클릭하여 원래의 스케일로 돌아올 수 있습니다. 
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3.1.3 스펙트럼 측정 파라미터 

  
 주파수 스케일 

 

RTA의 주파수 스케일은 옥타브, 1/3옥타브, 1/6옥타브, 1/12옥타브, 1/24옥타브 또는

선형, 로그스케일로 표시될 수 있습니다. Spectrum 버튼 아래의 Scale 컨트롤에서

조정 가능합니다. 
 

 
< 그림 3-5 > 주파수 스케일 리스트 

 

 

RTA의 주파수 표시 범위는 키보드 단축키로도 조정 가능하며(Chapter 5의 ‘5.5 
키보드 단축키’를 참고), Options의 Zoom 탭에서 4가지의 범위를 미리 설정해 놓고

키보드의 1 - 4번 숫자 키를 이용하여 빠르게 변환할 수도 있습니다. Smaart의
그래프 표시창(Plot)에서 자세하게 보고자 하는 부분이 있을 경우, 그 부분을

마우스로 드래그하여 확대해 볼 수 있습니다. 그래프 창의 좌측 또는 아래 측의

좌표값 부분(숫자들이 나열된)을 클릭하면 원래 표시되던 범위로 돌아옵니다. 
 

 평균(Averaging) 

 

Smaart 6의 평균(averaging)은 측정과정 수행 시 측정의 S/N비(Signal-to-Noise Ratio)를
높이고, 불필요한 주변소음의 영향을 감소시키기 위해 사용됩니다. 이는 표시되는

그래프를 안정시키고, 측정값의 전체적인 경향을 쉽게 파악할 수 있도록 도와줍니다. 
스펙트럼 측정은 RMS 평균을 사용하지만, Linear first in, first out(FIFO), Infinite, Fast, 
Slow, 그리고 지수적 통합과 같은 여러 가지의 통합 방식을 선택할 수 있습니다. 
 

FIFO 평균은 2n (n = 0, 1, 2…7)개의 최근 FFT 프레임을 가중치 없이 계산하는

단순평균입니다. 평균값이 1로 설정되었다는 것은 평균을 하지 않는다는 것과 같은

의미입니다. 즉, 가장 최근 1개의 FFT 프레임으로부터 넘어온 데이터를 계속해서

바로 표시한다는 의미입니다. 
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Infinite (Inf) 평균은 FFT 프레임에 가중치 없이 계산한다는 것은 FIFO 평균과

비슷합니다. 하지만 일정한 수의 최근 FFT 프레임을 평균하는 것이 아니라, 컴퓨터의

버퍼(메모리)에 저장된 모든 FFT 기록에 최근 FFT 결과를 더하고, 이를 계속적으로

평균합니다. 평균에 관련된 파라미터, FFT사이즈, 샘플링레이트 등을 변경하였을

경우나 키보드의 ‘V’ 키를 누르면, 평균 버퍼(메모리)가 저장하고 있는 이전의 FFT 
기록은 지워지고 새롭게 시작됩니다. (‘V’키는 평균을 재시작 할 경우 사용하는

키입니다. ‘5.3.8 평균 재시작’ 참고) 
 

            
< 그림 3-6 > 평균(average) 옵션(좌), 가중치(weight) 옵션(우) 

 
 

 가중치 곡선(Weighting Curves) 

 

스펙트럼 디스플레이 컨트롤 부분의 가중치 설정은 가중치곡선을 RTA, Spectrograph 
디스플레이에 적용합니다. A, C 가중치곡선(ANSI/IEC)과 극장 시스템을 위한 X 
가중치곡선과 같은 대표적인 가중치곡선이 프로그램에 내장되어 있으며(< 그림 3-6 
>의 오른쪽 그림 참고), 이외의 가중치곡선은 Smaart 6 설치 폴더 내의 ‘Weighting’
폴더에 관련 파일을 첨가하여 리스트에 추가하고 사용할 수 있습니다. 스펙트럼

모드와 주파수응답 모드에 각각의 가중치를 독립적으로 설정하는 것이 가능합니다. 
(‘3.8 가중치 곡선’ 참고) 
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 스펙트럼 모드의 FFT 파라미터 

 

스펙트럼, 주파수응답, 임펄스응답의 FFT 파라미터들은 Options에서 설정이

가능합니다. 
 

Sample Rate – Smaart 6를 처음 실행하였을 경우, 또 입력장치를 변경한 경우는

사용하려는 샘플링레이트를 확인해야 합니다. 이러한 옵션은 Options의 Audio I/O
탭의 Sampling Rate에서 확인할 수 있습니다. Options의 다른 탭에도 샘플링레이트를

확인 할 수 있지만, 설정은 Audio I/O 탭에서만 가능합니다. 
 

FFT Size – FFT사이즈의 설정은 Options에서 각 모드의 탭에서 가능하며, 
스펙트럼모드와 주파수응답모드에서 각각 독립적으로 설정할 수 있습니다. 
 

Time Constant – Time Constant, 또는 FFT의 Time Window는 FFT사이즈와

샘플링레이트에 관련되어 있습니다(TC = FFT사이즈/ 샘플링레이트). Smaart 6는 설정된

FFT사이즈와 샘플링레이트를 통해 자동적으로 TC를 계산하고, Options의 Impulse, 
Delay 탭의 Time Constant 부분에 표시합니다. (TC는 직접 조정하지 못합니다.) 
 

Frequency Resolution – 주파수 해상도는 샘플링레이트를 FFT사이즈로 나눈

값(FR=SR/FFT사이즈)이며, FFT 기반의 측정(특히, 낮은 주파수 대역)에 관련된

세부적인 사항을 결정하는 중요한 요소입니다. (‘2.1.5 주파수 해상도’ 참고) 프로그램

하단의 상태표시줄(Status Bar)에서 현재의 주파수 해상도(FR)를 확인할 수 있습니다. 
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3.2 주파수응답 측정 

 

Smaart의 실시간 주파수응답 측정 기능은 사운드시스템의 이퀄라이저들과

크로스오버를 최적화하기 위한 매우 유용한 도구입니다. 주파수응답 측정은

트랜스퍼 기능(transfer function)이라 불리는 수학적 계산을 통하여 테스트 중인

장치나 시스템의 입력신호와 출력신호를 비교하고, 이들의 차이점을 파악하도록

도와줍니다. 트랜스퍼 기능을 통해 테스트 중인 장비나 시스템의 주파수와 위상에

관련된 특성을 아주 정확하게 파악할 수 있습니다. 게다가 듀얼채널을 통한 측정은

입력신호와 출력신호를 비교하는 과정을 통해 측정과정이 진행되므로 테스트 신호의

종류에 크게 영향을 받지 않습니다. 즉, 핑크노이즈와 같이 일반적으로 사용되는

테스트신호는 물론 음악 등 여러 가지 다양한 소스를 테스트 신호로 하여

측정과정을 수행하는 것이 가능합니다. 
 

3.2.1 주파수응답 측정의 장비구성 

 
아래 그림은 간단한 사운드시스템을 측정하고 최적화하기 위한 주파수응답 측정의

기본적인 장비구성 예입니다. 
 

 
< 그림 3-7 > 주파수응답 측정 블록 다이어그램 예 

 

 

사운드시스템의 주파수응답 측정을 수행하기 위해서, 소스(테스트)신호를 나누고

SUT와 컴퓨터 입력장치의 레퍼런스신호 입력으로 지정한 입력으로 각각 연결합니다. 
시스템의 출력은 컴퓨터 입력장치의 측정신호 입력으로 지정한 입력으로

연결합니다. 이러한 구성은 트랜스퍼 기능 계산을 위한 것이지만, 딜레이와

임펄스응답 측정에도 적용됩니다. 주파수와 임펄스응답 측정을 위한 장비구성에 더

자세한 사항은 ‘Chapter 4. Smaart 6 응용’을 참고바랍니다. 
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3.2.2 주파수응답 개요 

 

Smaart 6에서 주파수응답 측정을 수행 할 때 레퍼런스신호와 측정신호 사이의 주파수

별 양적 차이와 위상 차이를 파악하기 위해, 그 두 신호를 실시간으로 비교합니다. 
두 신호를 비교하기 위해 트랜스퍼 기능(Transfer Function)이라고 불리는 수학적

기술이 사용됩니다. 
 

트랜스퍼 기능은 두 입력 신호를 비교하는 것이기 때문에, 정확한 측정을 수행하기

위해서 두 신호 사이의 지연시간은 반드시 보정되어야 합니다. Smaart 6의 딜레이

탐지기(Delay Locator)와 내부 딜레이(Internal Delay) 기능을 사용하면 쉽게 두 신호

사이의 지연시간을 보정할 수 있습니다. 임펄스응답 측정, 또는 주파수응답 측정을

수행할 경우 리미터, 컴프레서와 같은 비선형의 신호처리장치는 사용해서는

안됩니다. (‘3.2.7의 코히어런스와 코히어런스 블랭킹’ 참고) 
 

3.2.3 매그너튜드 디스플레이(The Magnitude Display) 

 

Magnitude 디스플레이는 Y축에 양적인 정보를 표시하는데, 중앙을 0dB로 하여

위로는 + 값을, 아래로는 – 값을 의미합니다. 표시창(plot)에서 주파수 정보를

표시하는 X축은 로그스케일로 표시됩니다. 표준 Magnitude 디스플레이 일 때, 특정

주파수에서 0dB값을 갖는다는 것은 그 주파수에서 레퍼런스신호와 측정신호의

에너지가 같다는 의미입니다. 즉, 두 신호의 차가 0(zero)라는 뜻입니다. 또 특정

주파수에서 + 또는 – 값을 갖는다는 것은 그 주파수에서 레퍼런스신호에 대한

측정신호의 양이 많거나 적다는 의미입니다. 
 

샘플링레이트가 44.1 또는 48kHz일 때, Magnitude의 그래프는 가장 낮은 주파수

대역에 할당된 두 개 옥타브 대역은 합쳐서 24개의 데이터 포인트가 할당되고, 그

위 옥타브 대역들은 모두 각 옥타브 당 24개의 데이터 포인트가 할당됩니다. 96kHz의
샘플링레이트 일 경우 역시 옥타브 당 24개의 데이터 포인트를 갖지만, 
저음대역부터 3개 옥타브 대역은 합쳐서 24개의 데이터 포인트가 할당되고, 
44.1/48kHz에 비해서 높은 주파수 대역에 1개의 옥타브 대역이 추가됩니다. 이렇게

옥타브당 같은 해상도를 갖는 것은 FFT 계산이 수행될 때 다중(서로 다른 해상도를

갖는) FFT 계산의 결과를 합쳐서 표현하기 때문에 가능한 것입니다. 이를

FPPO(Fixed-Point-Per-Octave)라 하며, Options의 Freq. Resp.탭의 FFT size 부분에서 설정

가능하며, Magnitude 디스플레이는 X축(주파수)을 로그스케일로 표현하기에 높은

주파수 대역일수록 데이터 포인트가 많아져 그래프가 복잡해지는데 FPPO로 설정할

경우 이러한 어려움을 해결해줍니다. 
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3.2.4 위상 디스플레이(The Phase Display) 

 

Phase 디스플레이 버튼을 클릭하면 레퍼런스신호에 대한 측정신호의 위상

변화(주파수 별 시간차)를 보여줍니다. 모든 위상값은 0°를 Y축의 중심으로 하여

+180° 에서 –180°까지 360° 범위 안에서 표현되며, 360°는 그 주파수에서 그것의

주기만큼을 의미합니다. 
 

특정 주파수에서 위상값이 0°라는 것은 그 주파수에서 레퍼런스신호와 측정신호의

주기가 똑같다는 것을 의미합니다. 신호의 주기로 볼 때 레퍼런스신호보다

측정신호가 빠르다면 Phase 디스플레이에서 음(–)의 값으로 표현되며, 반대의 경우

양(+)의 값으로 표현됩니다. 
 

기본적인 Phase 표시창(plot)의 0° 선의 위치를 45° 올리거나 내려서 표시되게 하려면, 
각각 키보드의 Alt + Page Up 또는 Alt + Page Down 키를 이용하면 됩니다. 그리고

디스플레이의 가장 아랫부분을 0°로 하여 가장 윗부분을 360°로 표시하려면 Alt + 
End, 원래대로 하려면 Alt + Home을 누르면 됩니다. 
 

3.2.5 타임 윈도우 기능(Time Windowing) 

 

Smaart 6의 타임윈도우 기능은 주파수응답 측정 시 불필요한 데이터를 배제하고, 
그래프를 부드럽게 안정시킬 수 있습니다. 이 기능은 일반적으로 불필요한 낮은

주파수 대역을 걸러내거나 측정위치에서 Comb filter 효과를 야기할 수 있는 강한

반사음들을 걸러내기 위한 용도로 많이 사용합니다. 
 

 
타임윈도우 기능은 시간영역과 주파수영역의 측정 기술이 모두 사용됩니다. 
 

 

 주파수영역 데이터는 역푸리에변환(IFT; Inverse Fourier Transform) 과정을 통해

시간영역의 임펄스응답 데이터로 변환됩니다. 이것은 Smaart 6의

임펄스모드에서 자동 딜레이 탐지 기능을 사용하여 임펄스응답 데이터를

얻는 과정과 같은 것입니다. 하지만 이러한 모든 과정은 프로그램 내부에서

이루어지는 과정이기 때문에 사용자에게 보여지지는 않습니다. 
 지정된 타임윈도우 사이즈의 두 배인 Time Constant를 가진 특별한 Flat Top 

데이터윈도우 기능을 첫 번째 최고점(peak)을 중심으로 하여 임펄스응답에

적용합니다(실제로는 임펄스응답의 경과시간의 시작부분을 중심으로 하여

적용하지만, 딜레이 타임이 적당히 설정되어 있다는 가정하에 이를

최고점(peak)의 도달시간이라고 생각합니다). 데이터윈도우 기능은 특정구간

밖의 불필요한 샘플을 0(zero)으로 만듭니다. 
 수정된 임펄스응답 데이터는 FFT과정을 통해 주파수영역 데이터로 다시

변환됩니다. 
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타임윈도우 기능이 적용된 주파수응답 그래프는 Magnitude와 Phase 디스플레이에

다른 색상(밝은 청록색이 기본)으로 기본 그래프와 함께 표시됩니다. 또 다른

그래프의 전, 후면상(Z축)에 배치 가능하며, 레퍼런스 트레이스(Reference Trace)로
저장될 수 있습니다. 
 

 

타임윈도우 과정에 사용되는 데이터윈도우 기능의 실제 시간범위는 지정된

윈도우시간의 두 배입니다. 즉, 최대 윈도우는 ‘Options의 Freq. Resp.’에서 선택한

Time Constant(FFT사이즈/샘플레이트)의 반과 같습니다. 
 

 

 

 
FFT 메뉴에서 FFT size를 FPPO로 선택하면, Time Window 기능은 사용할 수 없습니다. 

 

 

 
Time Window 관련 파라미터는 ‘5.3.2 주파수응답’을 참고하시기 바랍니다. 
 

 

타임윈도우 기능에서 알아두어야 할 것은 타임윈도우 기능이 적용된 트랜스퍼

기능(transfer function)의 TC(Time Constant)는 줄어든다는 것입니다. 따라서 타임윈도우

기능은 하이패스필터(HPF)와 같은 역할을 하게 되며, 타임윈도우 기능이 적용된

그래프에서 저음 성분이 약간 줄어든 것을 볼 수 있습니다. 
 

3.2.6 평균(Averaging)과 스무딩(Smoothing) 

 

Smaart의 평균(averaging)기능은 그 설정에 따라 여러 개의 FFT 프레임을 선형적(모든

FFT 프레임을 같은 비중으로 합하여), 또는 지수적(최근 FFT 프레임일수록 그

데이터에 더 큰 비중을 주어)으로 합하여 평균하는 것입니다. 이를 위해 Smaart에서

사용되는 거의 모든 평균 기능은 RMS 평균에 기반을 두고 있습니다. 선형평균(linear 
averaging)은 산술(arithmetic)평균이라고도 합니다. Smaart에는 1 frame부터 128 
프레임까지의 선형평균 옵션이 있습니다. 분석이 진행되는 동안의 모든 데이터를

선형 평균하는 무한(infinite)평균 옵션도 있습니다. 스펙트럼측정과 SPL 측정에서

사용되는 Fast와 Slow 평균 옵션은 지수적 평균입니다. 

 

 

 
효과적인 측정을 위해 너무 긴 시간이 걸리지 않는 적당한 길이의 평균 파라미터를 선택해야 

합니다. 평균 설정을 바꾸면 컴퓨터의 버퍼(메모리)에 저장된 기존의 데이터를 지우기 때문에 

그래프가 안정되는데 약간의 시간이 필요합니다. 
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 평균(Averaging)의 종류 

 

주파수응답 측정에서 사용하는 평균의 종류는 Options의 Freq. Resp. 탭에서

선택(RMS/Vector)할 수 있습니다. 평균 기능은 주파수응답 측정 시 그래프를

안정시켜, 쉽게 해석할 수 있도록 해줍니다.  
 

RMS 평균: 바람 또는 음원의 움직임은 순차적인 FFT 프레임들의 도달시간에 미세한

변동을 만들어냅니다. RMS는 그런 변동에 큰 영향 없이 작업을 수행할 수 있습니다. 
또한 잔향과 같이 뒤 늦게 도달하는 에너지도 주파수응답 측정에 잘 수용됨으로 그

측정 결과가 우리가 실제로 인지하는 전체적인 시스템 음색에 가깝습니다. RMS 
평균은 복잡한 Vector를 Magnitude와 위상 데이터로 변환한 뒤에 이루어집니다. 
 

Vector 평균: 트랜스퍼 기능(transfer function) 계산으로부터 온 복잡한 FFT 데이터를

가지고 직접 작업을 수행합니다. Vector는 관련 없는 잡음과 반사음 에너지를

배제하는데 효과적이며, 명료도(intelligibility) 또는 신호재생의 정확성과 관련된

작업에 많이 사용됩니다. Vector는 바람, 스피커/음원의 움직임 등과 또 다른

시간변화로 인한 문제에 더욱 민감합니다. 그래서 실내공간이나 아주 조용하고

컨트롤이 잘된 상태들에 더 적합합니다. Vector는 주파수응답 측정에서만 사용할 수

있습니다. 스펙트럼 측정은 모든 경우에 RMS 평균만을 사용합니다. 
 

 평균(Averaging) 

 

선형평균(FIFO; First In, First Out), 무한(Infinite)평균, 그리고 지수적(Fast, Slow) 평균은

주파수응답과 스펙트럼측정에서 기본적으로 사용되는 평균입니다. 
 

FIFO평균은 지정된 수만큼의 최근 FFT프레임들을 가중치 없이 간단하게 산술적으로

평균하는 것입니다. FIFO평균에서 선택 가능한 FFT프레임의 수는 모두 2의 제곱

수들입니다. 평균에 사용되는 프레임들의 수가 두 배씩 늘어갈수록 측정의 S/N비는

3dB씩 증가합니다. 평균에서 1을 선택하면, 가장 최근 1개의 FFT프레임만의 결과를

그래프로 보여줍니다. 즉, 평균을 사용하지 않는 것과 같습니다. 
 

무한(Infinite)평균 역시 FFT프레임들을 가중치 없이 산술적으로 평균하는 것입니다. 
하지만 일정 수만큼의 FFT프레임을 평균하는 FIFO평균과는 다르게 평균이 시작된

뒤로부터 버퍼(메모리)에 저장된 모든 FFT프레임들을 평균합니다. 평균

버퍼(메모리)는 평균, FFT 사이즈, 샘플링레이트 관련 파라미터가 변경되거나, 
키보드의 ‘V’ 키를 누르면 이전의 FFT 프레임들은 지워지고 새로운 프레임들을

저장합니다. 
 

FIFO와 무한(Infinite)평균과는 다르게, 지수적 평균은 평균에 사용되는 FFT 프레임들

중 최근 것일수록 더 많은 비중을 주고, 오래된 것일수록 그 비중을 점점

지수적으로 감소시켜 평균하는 것입니다. Fast와 Slow 옵션은 표준 사운드 레벨미터에
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사용되는 시간통합회로의 특성을 고려한 고정된 반감기를 가진 지수적 평균입니다.  
 

평균에 사용되는 FFT 프레임들의 수가 두 배씩 증가하면 측정의 S/N비는 3dB씩

증가합니다. (단, SUT-System Under Test-나 측정시스템의 절대적인 Noise Floor 
이전까지)  
 

일반적으로 어려운 측정 상황일수록 더 많은 평균과 스무딩(Smoothing) 옵션이

필요합니다. 보통 전기음향 측정(예, EQ나 시스템 프로세서의 입출력 비교)은 아주

짧은 평균이 적당합니다. 이 경우 필터가 조정된다면 그래프가 빠르게 반응하는

것을 볼 수 있습니다. 건축음향 측정(예, 마이크를 사용하는 측정)의 경우 16-32의

FIFO평균을 사용하는 것이 일반적입니다. 시끄럽거나, 잔향이 많거나, 실외 등의

장소에서 건축음향 측정을 할 경우 64, 128과 같은 FIFO평균을 사용하는 것이

좋습니다. 
 

 스무딩(Smoothing) 

 

주파수응답 측정 모드에서만 사용 가능한 평균 옵션인 스무딩(Smoothing)은
들쭉날쭉한 Magnitude 그래프를 평탄하게 만들어 그래프를 읽기 쉽게 해줍니다. Freq. 
Resp. 버튼 밑의 Smooth 값에 따라 이웃하는 몇 개의 데이터포인트를 평균합니다. 
가능한 Smooth 값은 none, 3, 5, 7, 9입니다. 
 

예를 들어, Smooth 값이 3이라면, 각 데이터포인트는 상하위 데이터포인트와 함께

평균된 값을 나타냅니다. 만일 Smooth 값이 5라면, 각 데이터포인트는 상위

데이터포인트 2개, 하위 데이터포인트 2개를 합쳐 평균한 값을 나타냅니다. 즉, 
RMS와 vector 평균과 같이 시간적으로 평균하는 것이 아니라 주파수 대역에 걸친

평균을 실행하는 것으로, 각 데이터포인트의 주파수밴드를 효과적으로 증가시킬 수

있습니다.  
 

3.2.7 코히어런스와 코히어런스 블랭킹(coherence blanking) 

  
 코히어런스(Coherence) 

 

코히어런스(coherence)는 주파수응답 측정에서 두 신호 사이의 선형성(linearity)을
보여줍니다. 코히어런스(coherence) 표시 기능은 기본적으로 “측정 중인 시스템으로

입력되는 신호와 그 출력신호 사이의 선형성이 얼마나 유지되는가?”라는 문제를

다룹니다. 이러한 물음의 결과는 0 ~ 1 사이의 값, 즉 확률로 표현되며, 0에 가까운

값일수록 두 신호 사이의 선형성이 없다는 의미이고, 1은 그 반대입니다. Smaart는 각

주파수 데이터포인트 별로 확률이 아닌 퍼센트(%)로 코히어런스(coherence)를
표시합니다. 즉, 선형성이 가장 높은 경우를 100%, 낮은 경우를 0%로 표현합니다. 
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일반적으로 코히어런스(coherence)가 100%에 가깝다는 것은 선형성이 높고, 더 좋은

데이터라는 의미이지만, 그렇다고 코히어런스(coherence)가 낮다는 것이 꼭 신뢰할 수

없는 데이터라는 의미는 아닙니다. 예를 들어, 소음이 많은 환경에서 건축음향에

대한 측정을 수행할 경우 큰 평균 옵션값의 사용이 요구되며, 이는 당연히

코히어런스(coherence)를 떨어뜨립니다. 
 

현실적인 측정 상황에서, 좋은 코히어런스(coherence)는 상대적일 수 있습니다. 그래서

특정한 코히어런스(coherence) 값보다는 코히어런스(coherence)의 전체적인 경향을

보는 것이 유용한 경우가 많습니다. 특정 주파수가 다른 주파수들에 비해 매우 낮은

코히어런스(coherence) 값을 가졌다면, 그 결과를 의심해봐야 하며, 전체적인 그래프의

동향을 고려해 그 주파수 대역의 코히어런스(coherence)를 판단해야 합니다. 
 

두 신호 사이의 지연시간, 특정 주파수 대역에서 충분하지 못한 레퍼런스신호, 
건축음향적인 영향(반사음, 잔향 등), 주변 소음, 전기적 소음 등을 포함한 많은

요인들이 주파수응답 데이터의 코히어런스(coherence)에 좋지 않은 영향을 줄 수

있습니다. 또 컴프레서와 리미터와 같은 비선형 처리장치가 측정신호 경로 중에

있다면 코히어런스(coherence)에 좋지 않은 영향을 줄 수 있으며, 측정 시 반드시

경로 상에서 제외 시켜야 합니다. 
 

 코히어런스(coherence) 그래프 

 

코히어런스(coherence) 그래프는 Magnitude 디스플레이 상단에 붉은 그래프로

표시됩니다. (Options의 Freq. Resp. 탭의 ‘Show Coherence Trace’에 체크한 경우에만

표시) 
 

코히어런스(coherence) 그래프는 보통 Magnitude 디스플레이의 중심선을 0% 값으로, 
최상부를 100% 값으로 하여 표시됩니다. 표시창(Plot) 영역 위에 마우스 커서를

올리면, 현재 마우스 커서가 위치하는 데이터포인트의 코히어런스(coherence) 값이

표시창(Plot)위의 커서 정보표시 영역에 붉은색 숫자로 표시됩니다. 
 

 코히어런스 블랭킹(Coherence Blanking) 

 

코히어런스 블랭킹(coherence blanking)은 코히어런스(coherence)가 너무 낮은 부분의

데이터(그래프)를 보지 않기 위한 기능입니다. 코히어런스 블랭킹(coherence 
blanking)은 다음에 설명할 매그너튜드 트레숄딩(magnitude thresholding)과 비슷하지만, 
신호의 세기가 아닌 코히어런스(coherence) 값에 따라 그래프의 표시 여부를

결정합니다. 코히어런스 블랭킹(coherence blanking) 관련 파라미터들은 Options의 Freq. 
Resp. 탭에서 설정 가능합니다.(그림 3-8 참고) 
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코히어런스 (coherence blanking) 관련 파라미터들은 다음과 같습니다. 
 

Solid Above: 현재의 코히어런스(coherence) 값이 여기에 설정된 값보다 높은 구간의

코히어런스(coherence) 그래프는 진한 붉은색 선으로 표시됩니다. 초기값은 80%이며, 
이상적인 상황에서 건축음향 측정 진행 시, 코히어런스(coherence) 값이 그

이상이라면 그 구간이 높은 신뢰도를 갖는 다는 의미입니다. 
 

Invisible Below: 현재의 코히어런스(coherence) 값이 여기에 설정된 값보다 낮은

구간의 코히어런스(coherence) 그래프는 표시되지 않습니다. 초기값은 10%입니다. 
 

Transparent in between with minimum opacity: 주파수응답 그래프는

코히어런스(coherence)에 따라 다양한 투명도로 표시됩니다. 코히어런스(coherence)
값이 높을수록 불투명하고, 낮을수록 투명하게 표시됩니다. 이 때 Invisible Below에서

설정한 코히어런스(coherence) 값보다 조금 높은 데이터는 거의 투명하게 표시되어

그래프가 잘 보이지 않을 수도 있습니다. 여기에 설정한 값은 최소

불투명도(opacity)를 지정하는 것입니다. 다시 말해 블랭킹(blanking)되지 않고

표시되는 그래프를 얼마나 선명하게 볼 것인가에 대한 파라미터이며, 초기값은

30%입니다. 너무 투명한 구간이 많아 그래프를 보는데 어려움이 있는 경우, 이 설정

값을 올린다면 그래프를 보다 선명하게 볼 수 있습니다. 이 설정값이 100%로

되어있다면, Invisible Below에서 설정한 값보다 높은 값을 갖는 구간은 투명도 없이

모두 진하고 선명한 그래프로 표시됩니다. 
 

 
< 그림 3-8 > 주파수응답 측정 옵션창의 관련 파라미터 

 

3.2.8 매그너튜드 트레숄딩(Magnitude Thresholding) 

 

주파수응답 측정 시 여기에 설정된 값에 따라 불필요한 데이터를 제한할 수

있습니다. 특정 주파수 대역에서의 레퍼런스신호 레벨이 여기에 설정된 값(레벨)보다

낮다면, 그 구간의 그래프는 표시되지 않습니다. 
 

 
Smaart6를 공연 등의 행사 중에 사용하거나 소음이 많은 환경에서 사용할 경우

매그너튜드 트레숄딩 기능을 적당히 활용하면 다음과 같은 장점이 있습니다. 
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 정상적으로 이뤄지지 않은 측정데이터를 표시하지 않습니다. 왜냐하면 특정

주파수 대역에서 측정 대상 시스템에 입력되는 신호가 없다면, 그 주파수

대역에서의 출력도 있을 수 없기 때문입니다. 
 

 측정된 유효한 데이터포인트는 새로운 데이터로 교체되기 전까지 화면에

표시되어야 합니다. 측정 수행 중 테스트신호가 멈추거나 끊어졌을 경우, 
매그너튜드 트레숄딩 기능이 그래프의 최종 상태를 계속 표시하도록

해줍니다. 이는 측정이 시작되었을 때 그래프가 안정되기 위해서는 약간의

시간이 필요하다는 의미도 됩니다. 만일 측정 시작 후 몇 초가 지나도

그래프가 나타나지 않는다면 설정값을 적당히 낮춰주어야 합니다. 
 

 

매그너튜드 트레숄딩 기능은 평균(averaging) 기능에도 많은 도움을 줍니다. 즉, 이

기능의 적당한 활용은 새로운 데이터 중 유효한 데이터만 평균 기능에 쓰일 수

있도록 해줍니다. 특정 주파수 데이터포인트에서 유효하지 못한 데이터가 나타난

경우, 평균 기능은 최종 유효 값을 반영하여 그래프를 계속 유지하기 때문에 그

주파수 대역에서 그래프가 갑자기 사라지지 않고 유지될 수 있습니다. 
 

3.3 딜레이와 임펄스응답 측정 

 

Smaart 6의 임펄스 모드는 SUT(System Under Test)의 임펄스 응답을 측정하고

보여줍니다. 임펄스 응답은 두 입력신호 사이의 시간 차를 찾기 위해 주로

사용됩니다. 분석 모드(RTA와 주파수응답)가 주파수에 따른 에너지를 보여주는

것과는 다르게 임펄스 모드의 표시창(plot)은 시간에 따른 에너지를 표시합니다. 
임펄스응답 측정의 결과는 Windows 표준 웨이브파일이나 Mac AIFF 파일로 저장할

수 있습니다. 
 

실시간 주파수응답 측정과 함께, 임펄스응답 계산은 사운드 장치의 두 입력에 다른

경로를 가진, 같은 신호가 들어가고 있다고 생각합니다 (그림 3-9 참고). 입력된

오디오 데이터는 녹음되고, 주파수영역의 데이터로 변환되고, 트랜스퍼 기능(transfer 
function)을 이용하여 처리됩니다. 그 결과는 역푸리에변환(Inverse FFT) 과정을 통해

다시 시간영역의 데이터로 변환됩니다. 
 

 
< 그림 3-9 > 임펄스응답 측정 / 딜레이 블록 다이어그램 예 
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이 기술은 SUT(System Under Test)의 총 감쇠시간(공간을 포함한 시스템이 가진 전체

지연시간)보다 긴 측정 Time Constant(Time window)가 필요합니다. TC(Time Constant) = 
FFT 사이즈/샘플링레이트이기 때문에, SR = 48kHz이고 FFT 사이즈 = 32768 이라면, 
TC = 683 ms가 됩니다. 이 정도의 TC는 중소 규모 공간에 적당한 Time Window가

됩니다. 큰 공간 또는 잔향이 매우 많고 감쇠시간이 긴 공간에서는 더 긴 Time 
window가 필요합니다. 
 

FFT 사이즈를 높이고, 샘플링레이트를 낮추면 TC(Time constant)는 증가시킬 수

있지만, 샘플링레이트를 낮추는 것은 임펄스응답 결과에서 높은 주파수 성분이

제한된다 것을 유의하여야 합니다. 만약 측정 대상 공간의 감쇠시간에 대한 확신이

없어 TC의 설정을 어떻게 해야 할지 모를 경우, 너무 작은 것보다는 큰 편이

좋습니다. 비록 데이터가 녹음되고 처리되는 데 많은 시간이 걸리고, 측정결과가

불필요하게 길어지지만, TC가 두 배 늘어날수록 S/N비는 3dB씩 증가한다는 장점도

있습니다. 
 

3.3.1 임펄스응답 측정 파라미터 

 

임펄스응답 측정의 FFT 파라미터들은 실시간 모드(스펙트럼과 주파수응답측정)의
파라미터들과 조금 구분됩니다. FFT와 TC(Time Constant) 파라미터는 서로 영향을

줍니다. (TC = FFT 사이즈 / 샘플링레이트) 
 

 
< 그림 3-10> 임펄스응답 창 
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임펄스응답 모드에서는 FFT 주파수 해상도(FR; Frequency Resolution)를 표시하지 않습니다. 

 

 
 Type 

 
다음 중에서 설정 가능합니다 

: Log, Lin, ETC. 
 

 FFT 

 
FFT 사이즈는 128에서 512k까지 선택 가능합니다. FFT 사이즈를 바꾸면 바로 아래의

TC(Time Constant) 설정에도 영향을 미칩니다. 
 TC(Time Constant) 

 
FFT 사이즈 설정에 따른 TC를 표시합니다. 이곳에서 TC의 설정도 가능하며, 역시

바로 위의 FFT 설정에도 영향을 미칩니다. 
 

 Averages (Avg) 

 

Avg(Averages)에서는 녹음될 FFT 프레임들의 수를 설정할 수 있습니다. 설정된 수가

1보다 큰 경우, 녹음된 FFT 프레임들을 지정된 수만큼 모아 평균되고, 측정의 결과로

표시됩니다. 이 평균옵션을 통하여 측정 중 유입되는 불필요한 잡음으로부터의

영향을 줄일 수 있습니다. 평균 설정이 두 배가 될 때마다 S/N비는 3dB씩

증가합니다. (단, SUT-System Under Test-나 측정시스템의 절대적인 Noise Floor 
이전까지) 
 

3.3.2 임펄스응답 모드 

 

IR Analysis 버튼(Freq. Resp. 버튼 아래)을 클릭하여 임펄스응답 모드를 실행할 수

있습니다. 임펄스응답 모드는 별도의 창으로 시작되며, Start 버튼을 클릭하면 측정을

시작합니다. 임펄스 녹음 절차는 측정을 수행하고, 임펄스응답 창과 옵션의 설정에

따라 그 결과를 표시창에 나타냅니다. 임펄스응답의 결과를 시간영역 또는

주파수영역에서 볼 수 있습니다. 
 

Time: time 버튼(표시창 좌측 상단)을 클릭하여 선택 가능합니다. 기본 x축의 범위는

측정 시 설정했던 TC(Time Constant)와 동일하며, 원하는 범위를 확대하여 볼 수

있습니다. 
 

Frequency: Frequency 버튼(표시창 좌측 상단)을 클릭하여 선택 가능합니다. 기본

X축의 범위는 샘플링레이트(SR)의 반이며, 원하는 범위를 확대하여 볼 수 있습니다. 
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 Type 파라미터 

 

Type에서 Y축의 표현을 다음의 세가지로 설정할 수 있습니다. 
 

Lin: Y축을 디지털 full-scale의 선형 백분율(%)로 표시합니다. 

 
Log과 ETC (Energy Time Curve): Y축을 로그스케일의 dB 단위로 표시합니다. 
 

Lin과 Log amplitude 스케일은 같은 시간영역의 임펄스응답 데이터를 보기 위한 다른

방법입니다. 일반적으로 Log로 보는 것이 유용하며, 임펄스응답의 결과를 보기 위한

기본 magnitude view입니다. 
 

 
ETC로 설정한 경우, Log로 설정한 경우와 매우 비슷해 보이지만 다음과 같은 중요한

차이가 있습니다. 
 

 

 완전한 파형(waveform) 한 개는, + 성분은 물론, – 성분도 가지고 있습니다. 
 2차원의 오실로그램(oscillogram)에서 보면 90°와 270°의 위상값을 갖는 부분의

에너지는 0(zero)로 나타납니다. 
 

 

그래서 임펄스응답이 로그스케일로 보여질 때, 여러 개의 최고점(peak)을 가진

것처럼 보여집니다. ETC는 임펄스응답의 엔벨로프(envelope)를 로그스케일로

보여줍니다. 위상에 대한 정보는 배제하고, 한 개의 음원이나 반사음으로부터

도달하는 에너지는 한 개의 최고점(peak)을 가진 것으로 보여집니다. 그래서, 특히

저음역을 재생하는 장치의 딜레이를 측정할 경우, ETC가 임펄스응답보다 더 정확한

경우가 많습니다. 
 

 

 

 
마우스로 드래그하면 그래프의 특정부분을 확대하여 볼 수 있습니다. 원래 상태로 되돌리려면 

X축, 또는 Y축의 좌표값 부분을 클릭하면 됩니다. 

 

 

 

임펄스응답 그래프 중 가장 큰 최고점(peak)은 보통 magnitude가 가장 높은 지점이며,
임펄스응답 측정에서 에너지의 최초도달시간에 해당합니다. 측정이 시작된

시점으로부터 이 최고점(peak)의 시간으로 측정공간을 포함한 SUT(System Under 
Test)의 총 전달(propagation) 지연시간을 알 수 있습니다. 
 

임펄스응답 측정이 완료되면 가장 큰 최고점(peak)에 자동으로 고정커서(Locked 
Cursor)가 위치하며, 그 위치 정보는 표시창(plot) 상단에(커서 위치정보 표시 부분) 
표시됩니다. 고정커서(Locked Cursor)가 위치해 있을 때 키보드의 Shift + Space Bar를
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누르면 현재 고정커서가 위치하고 있는 시간을 내부 신호 딜레이(Internal Signal 
Delay)에 현재 딜레이시간으로 적용됩니다. 고정커서를 표시하거나 움직이려면

키보드의 Ctrl 키(Mac은 Cmd)를 누른 채 왼쪽 마우스 버튼을 클릭하면 되고, 그래프

중 가장 큰 최고점(peak)에 위치시키려면 최고점(peak) 찾기 기능(Shift + P)을
이용하면 됩니다. 
표시창(plot)에 고정커서(Locked Cursor)와 마우스커서가 함께 위치하고 있을 때, 두

위치 간의 상대적인 시간적, 양적(amplitude) 차이에 대한 정보가 커서

위치정보(Cursor Readout) 표시부분에 표시됩니다. 이 기능을 통해 임펄스응답 그래프

중 특정 위치와 고정커서(Locked Cursor)의 위치 간의 차이에 대한 정보를 쉽게 얻을

수 있습니다. 
 

임펄스응답 측정은 Windows의 wave파일이나 Mac의 AIFF파일로 저장할 수 있습니다. 
 

3.3.3 자동 딜레이 탐지기(Automatic Delay Locator) 

 

Smaart 6의 자동 딜레이 탐지기는 측정 중인 시스템(SUT; System Under Test)의
임펄스응답 측정을 통해 두 입력 신호 사이의 시간 차를 추적하여 나타냅니다. 두

신호 사이의 시간 차이는 임펄스응답 측정에서도 확인 가능하고, 스펙트럼측정이나

주파수응답 측정의 자동 딜레이 탐지기를 통해서도 확인 가능합니다. 딜레이 측정은

레퍼런스 신호와 측정신호가 모두 입력되고 있어야 측정 가능합니다. 
 

자동 딜레이 탐지기는 Smaart 6 창의 우측 하단의 Delay 정보표시 부분 아래 ‘Auto 
Sm(Delay Auto-Locate Small)’나 ‘Auto Lg(Delay Auto-Locate Large)’ 버튼을 눌러 사용할

수 있습니다. Small과 Large 옵션은 측정 과정 중 사용된 Time Window(Time 
Constant)와 관련이 있습니다. Smaart 6의 딜레이 추적 기능은 측정 중인 시스템(SUT; 
System Under Test)의 감쇠시간에 매우 민감하기 때문에 이와 같은 두 가지 옵션이

제공됩니다. 최소 Time Window(Time Constant)는 측정하고자 하는 최대 딜레이

시간보다는 충분히 커야 합니다. 최상의 결과를 위해서, 특히 저음역을 재생하는

장치의 경우, Time Window(Time Constant)가 공간을 포함한 측정 대상 시스템(SUT)의
전체 잔향 감쇠시간보다 반드시 커야 합니다. 

 
< 그림 3-11 > 자동 딜레이 탐지기 

 

 
Auto Sm과 Auto Lg의 기본 Time window(Time constant) 설정은 각각 300ms, 3s 입니다. 
위 설정의 경우, Auto Sm은 개별 장비나 중소 규모의 공간에 대한 측정을 위해



EAW Smaart 6.1 사용 설명서 
 

Copyright ⓒ SmaartCorea. All Rights Reserved. - 54 -

적당하며, Auto Lg는 중대 규모의 공간에 대한 측정을 위해 적당합니다. 매우 큰

공간이나 잔향이 많은 공간에서는 더 큰 Time window(Time constant)가 적당할 수도

있습니다. Auto Sm과 Auto Lg의 Time Window는 Options의 Delay 탭의 ‘Auto Small’, 
‘Auto Large’ 부분에서 설정 가능합니다. (샘플링레이트는 Options의 Audio I/O탭에서

설정 가능합니다.) 
자동 딜레이 탐지기는 두 신호 사이의 시간차를 찾기 위한 여러 가지 용도로 사용이

가능하며, 주로 주파수응답 측정 시 레퍼런스 신호와 측정 신호 사이의 시간차를

찾고, 보상하기 위해 사용됩니다. ‘Auto Sm’ 또는 ‘Auto Lg’를 실행하고 나면, 추적한

딜레이를 레퍼런스 입력 채널에 적용할 지 여부를 묻는 창이 나타납니다.  
 

3.4 SPL 측정 

 

Smaart 6는 입력장치의 A/D 컨버터로부터 디지털신호를 받지만, A/D 컨버터의 전압

범위나 게인(gain) 구조에 대한 특성 등에 대한 정보를 가지고 있지 않습니다. 
Smaart를 통해 정확한 SPL 측정을 수행하기 위해서는, SPL 측정 전에

캘러브레이터(calibrator)와 같은 SPL 기준을 제공해 줄 수 있는 외부 장치를 통해

음압레벨을 교정(calibration)해야 합니다. (예, Cirrus Research의 CR514) 
 

3.4.1 신호 레벨/SPL 정보 표시 

 

Smaart 6로 입력되는 두 신호 중 한 개에 대한 양적 정보를 Smaart 6 창의 우측

상단(입력 레벨미터 위)에 수치로 표현합니다. 외부 장치를 통해 교정(calibration)된
실시간 모드의 SPL표시는 ANSI/IEC 표준 사운드레벨미터(SLM)에 준합니다. 
 

 

 

 
Smaart 6에서의 SPL 측정은 Smaart 6를 외부에서 기준을 제공해줄 수 있는 장치로 음압레벨을 

교정(calibration하였을 경우에만 유효합니다. 자세한 내용은 2.4.2 음압레벨 교정(Calibrating to 

SPL)을 참고 바랍니다.  

 

 

 

신호레벨/SPL 정보표시 부분은 Options의 Audio I/O탭의 SPL Source로 설정된 채널에

대한 레벨을 표시합니다. Smaart 6를 외부 기준으로 음압레벨을

교정(Calibration)하였을 때, 이 부분에 표시되는 레벨은 현재 한 개의 FFT프레임 또는

최근 몇 개의 FFT프레임을 평균한 값을 표시할 수 있으며, A-weighted, C-weighted
등의 가중치를 적용할 수 있습니다. 
 

신호레벨/SPL 수치 정보가 표시되는 부분 바로 위의 ‘SPL 옵션버튼’에는 현재

적용되어 있는 가중치, Calibration 형태, 시간통합에 대한 설정 등의 정보가
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표시됩니다. 또 ‘SPL 옵션버튼’을 클릭하면, SPL/Calibration에 대한 설정을 위한 옵션

대화창이 열립니다. 
신호레벨/SPL에 대한 Smaart 6의 설정이 기본 설정인 Full-Scale Calibration으로

되어있을 경우, ‘SPL 옵션버튼’ 부분에는 ‘Full Scale’이라고 표시되며, Smaart 6가 외부

기준으로 음압레벨을 교정(calibration)하였을 경우에는 ‘SPL’로 바뀝니다. 현재 적용된

가중치(A, B, C 또는 Flat)에 대한 정보가 가장 앞에 위치하며, SPL 시간통합에 대한

설정(Fast, Slow 또는 Impulse)이 마지막에 표시됩니다. 다음의 그림 3-12는 가중치를

‘A-weighted’로, 시간통합은 ‘Fast’로 설정하였을 경우의 예입니다. 
 

 
< 그림 3-12 > 신호레벨/SPL 정보 표시 

 

 

Fast, Slow 시간통합 옵션은 표준 하드웨어의 표준사운드 레벨미터의 시간통합 회로와

최대한 가깝게 만들어졌으며, 또 Smaart 6는 ANSI/IEC standard Impulsive(Imp) 
integration을 모델로 하는 시간 해상도를 가졌습니다. 
 

신호레벨/SPL 수치를 표시하는 부분 위의 ‘SPL 옵션버튼’을 클릭하면, 
SPL/Calibration에 대한 설정을 위한 대화창이 열리며, 그 창에서 신호레벨

정보표시에 관련된 파라미터를 조정하거나, Smaart 6의 음압레벨을 교정(calibration)할
수 있습니다. 하지만 ‘Full Scale Calibration’으로 설정되어 있을 경우, SPL 옵션 중

일부는 비활성화됩니다. 그리고 SPL이나 다른 외부 기준에 맞춰 음압레벨을

교정(calibration)하였을 경우, ‘Peak Hold’ 옵션은 사용할 수 없습니다. 
 

3.4.2 음압레벨 교정(Calibrating to SPL) 

 

Smaart 6가 처음 설치되면, 사운드장치의 A/D 컨버터의 최대값을 0dBFS로 하는 ‘Full 
Scale Calibration’ 옵션으로 설정되어있습니다. 그러므로 A/D 컨버터의 최대 입력

전압과 같은 크기를 가지는 사인파(sine wave)가 입력되면, Smaart의 RTA는 그

사인파가 갖는 주파수에서 0dB (최대값)로 표시합니다. 
 

‘Full Scale Calibration’으로 설정되어있는 경우, 입력되는 사운드의 크기를 0dB를 최대

입력레벨로 하고, 그 이하를 ‘–‘ dB 값으로 나타내며, ‘dB Full Scale’이라고 표시됩니다. 
Smaart 6의 음압레벨이 교정(calibration)되었을 경우,  ‘SPL’이라고 표시되며, ‘+’ dB 
값으로 표시합니다.  
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Smaart 6에서 정확한 SPL 값을 얻으려면, SPL 기준을 제공해 줄 수 있는 외부장치를

이용하여 음압레벨을 교정(calibration)해야 합니다. 신호 레벨로 표시되는 채널(기본은

‘Meas In’)은 Options의 Audio I/O탭에서 ‘SPL Source’로 설정된 채널이 사용되며, SPL 
측정을 위해 사용되는 마이크의 신호가 입력되는 채널을 선택하시면 됩니다. 
 

 음압레벨 교정(calibration) 방법 (권장) 

 

Smaart 6를 SPL에 맞춰 음압레벨을 교정(calibration)하는 가장 정확한 방법은

피스톤폰(pistonphone) 형태의 음압레벨 캘러브레이터(calibrator)를 사용하는 것입니다. 
캘러브레이터는 측정마이크의 캡슐을 외부로부터 밀폐시킬 수 있어야 합니다. 
 

 

 

 
사용 중인 측정마이크의 캡슐사이즈가 캘러브레이터(calibrator)와 잘 맞지 않는다면, 

측정마이크나 칼리브레이터 제조사를 통하여 적당한 사이즈의 어댑터를 구하여 사용해야 

합니다. 

 

 

 

1. 음압레벨 교정(calibration)을 다시 하려면 RTA 디스플레이를 선택하고, Start 
버튼을 클릭하십시오. 

2. RTA의 주파수 해상도를 ‘Oct’(Octave)로 선택하십시오. 
3. 마이크 프리앰프와 사운드카드의 입력레벨을 사용하기 적당한 정도로

조정하고, 측정마이크를 캘러브레이터(calibrator)에 삽입한 후 캘러브레이터를

작동시킵니다. 
4. RTA 디스플레이에서 캘러브레이터가 재생하는 주파수대역의 최고값(peak)이

안정되면, 신호레벨/SPL 수치를 표시하는 영역 위의 ‘SPL 옵션버튼’을
클릭하여 SPL/Calibration 설정을 위한 대화창을 열고, ‘Calibrate Using Peak’
버튼을 누릅니다. Smaart 6는 자동으로 RTA 상의 최고값(peak)의 크기를

찾아내어 ‘Amplitude Calibration’ 창에 그 값을 보여줍니다. 
 

  
< 그림 3-13 > SPL/Calibrations 옵션 창(좌) / Amplitude Calibration 설정 창(우) 
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5. ‘Set this value to’ 영역에 캘러브레이터(calibrator)의 출력레벨을 적어 넣습니다. 
캘러브레이터의 출력레벨은 보통 94, 104, 또는 114dB입니다. (사용 중인

캘러브레이터의 출력레벨은 사용매뉴얼을 참고하십시오.) 
6. ‘OK’ 버튼을 클릭하면 변경사항을 적용하고 설정을 종료합니다. 

 

 

설정 대화창이 닫히면, 스펙트럼 모드의 스케일 표시는 새로운 교정값에 맞춰

자동적으로 조정되고, 신호레벨/SPL 정보표시 부분은 SPL을 나타내게 됩니다. 위의

모든 설정을 마치면, Smaart 6의 스펙트럼/주파수응답 측정은 정확한 SPL을

제공합니다. 위의 설정 후에도 임펄스응답 모드는 ‘Full Scale calibration’을 사용합니다.
 

 

 

 
마이크 프리앰프의 입력레벨(gain)이나 믹서의 채널을 바꾸는 등 사용환경이 변한 경우, 

음압레벨 교정(calibration)을 다시 하여야 합니다.  

 

 
 캘러브레이터가 없을 경우의 음압레벨 교정(Calibration) 

 
캘러브레이터가 없지만 표준 음압레벨미터(SLM)을 가지고 있을 경우, 다음의 과정을

통해 음압레벨을 교정(calibration)할 수 있습니다. 
 

 

1. 신호레벨/SPL 수치를 표시하는 영역 위의 ‘SPL 옵션버튼’을 클릭하여

SPL/Calibration 설정을 위한 대화창을 열고, ‘Calibrate Using Peak’ 버튼을

클릭하여 ‘Amplitude Calibration’ 설정창을 엽니다. 
2. ‘Calibration Offset’ 값을 1로 설정하고, ‘OK’ 버튼을 클릭하여 ‘Amplitude 

Calibration’ 설정을 종료합니다. 
3. 다시 ‘SPL 옵션버튼’을 클릭하여 설정창을 열고, ‘Weight(가중치)’와 ‘Speed’에

대한 설정을 기준으로 사용할 표준 음압레벨미터(SLM)에 맞춥니다. 이 후

과정을 더 쉽게 진행 하기 위해서 ‘Speed’ 설정은 ‘Slow(Slow time 
integration)’로 할 것을 권장합니다. 

4. ‘OK’ 버튼을 클릭하여 설정창을 닫습니다. 
5. 사용 중인 측정마이크와 표준 음압레벨미터(SLM)를 최대한 가까이하여, 

스피커 앞에 위치시킨 후, 스피커로 일정한 음원(sine wave, 핑크노이즈 등)을
재생합니다.  

6. Smaart 6와 표준 음압레벨미터(SLM)을 구동하고, 각각 나타내는 SPL 값을

확인합니다. 
7. 표준 음압레벨미터가 나타내는 SPL 값에서 Smaart 6가 나타내는 SPL 값을 뺀

후, 그 값에 1을 더합니다. 이 값은 ‘Calibration offset’ 값으로 사용될

것입니다. 
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8. ‘Amplitude Calibration’ 설정창을 다시 열고, 앞의 7. 과정에서 구한 값을

‘Calibration offset’ 값으로 다시 입력합니다. 
9. Smaart 6와 표준 음압레벨미터(SLM)을 다시 구동하여 각각의 SPL 값을 다시

확인합니다. 이제 각각의 SPL 값이 거의 비슷할 것입니다. 
 

3.5 측정 데이터 캡처와 불러오기 

 

Smaart 6에서 측정 진행 중인 스펙트럼/주파수응답 모드의 모든 그래프를 캡처할 수

있으며, 이렇게 캡처한 그래프를 레퍼런스 트레이스(Reference Traces)라고 부릅니다. 
캡처한 그래프들은 각각 컴퓨터의 원하는 위치에 저장 가능하며, 프로젝트 별로

새로운 폴더를 만들어 따로 관리하는 것이 좋습니다. 
 

3.5.1 레퍼런스 트레이스(Reference Trace)의 캡처 

 

측정 진행 중에 그래프 표시창 우측상단의 ‘Capture’ 버튼을 클릭하거나, 키보드의

space bar를 누르면, 캡처된 그래프의 저장위치를 묻는 창이 열립니다. 원하는

파일명을 입력하고, 원하는 위치를 선택하고 저장합니다. ‘Description’ 부분에 입력된

문자는 캡처한 파일을 관리하는 ‘Legend’에서 각 파일 별로 보이므로, 간단한 설명을

입력하면 ‘Legend’에서 레퍼런스 트레이스를 관리하기 쉬워집니다. 
 

 

 

 
캡처창이 열릴 때 기본 파일명이 자동적으로 제공됩니다. 따라서 키보드의 ‘space bar’를 눌러 

캡처창을 열고, 바로 키보드의 ‘Enter’키를 눌러 저장하면, 캡처된 그래프들은 순차적인 

파일명을 가지고 저장되므로, 바쁜 경우 아주 유용합니다. 

 

 

 

‘Description’ 부분에 문자를 입력하면, 자동적으로 파일명으로 함께 입력됩니다. 만일

파일명을 따로 작성하고자 할 경우, ‘Description’ 부분 입력 후, 파일명 부분을 직접

클릭하여 입력하면 됩니다. 
 

3.5.2 레퍼런스 트레이스(Reference Trace) 불러오기 

 

그래프 표시창 우측상단의 ‘Load…’ 버튼을 클릭하면, 저장된 그래프들을 불러오기

위한 창이 열립니다. 불러오기를 원하는 그래프가 저장된 폴더를 지정하고, 원하는

파일을 선택한 후 ‘Open’ 버튼을 클릭하면 불러오기가 완료됩니다. 이 창에서 파일을

선택하면, 창의 하단 부분에 파일에 관련된 정보가 보이는데, 캡처한 그래프를

저장할 때 작성한 ‘Description’ 내용이 보입니다. 또 한 개 이상의 파일을 선택하여

불러오기도 가능합니다.(키보드의 ‘Shift’키, 또는 ‘Ctrl/Cmd’키를 누른 채 선택) 
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3.5.3 레전드(Legend) 창과 레퍼런스 트레이스(Reference Trace) 

 

그래프 표시창 우측상단의 ‘Legend’ 버튼을 클릭하면, 각 측정 모드에 해당하는

Legend 창(Magnitude, Phase, 또는 RTA Display Legend)이 열리며, 이 Legend 창에는

캡처되었거나, 불러온 레퍼런스 트레이스들의 목록이 Smaart의 기본 그래프(Live 
Measured, Live Reference)와 함께 나타납니다.  
 

 
< 그림 3-14 > 레전드(Legend) 창 

 

 

dB +/-: 선택한 파일의 dB offset을 설정할 수 있습니다. 
Move In List: 파일 선택 후 위/아래 방향의 화살표를 눌러 목록 내의 모든

파일(그래프) 중에서 선택한 파일(그래프)의 순서를 설정할 수 있습니다. 
목록에서의 순서는 그래프 표시창(Plot)에서 Z축 상의 순서를 나타냅니다. 
즉, 목록의 상단에 위치할수록 표시창(Plot)에서는 앞쪽으로, 목록의 하단에

위치할수록 표시창(Plot)에서는 뒤쪽에 위치하게 됩니다. (목록의 특정

파일을 더블클릭하면 최상위로 순서로 한번에 이동합니다.) 
Load…: Legend 창의 ‘Load…’ 버튼을 클릭하여 레퍼런스 트레이스 불러오기가

가능합니다. (목록의 특정 파일을 선택 후 키보드의 ‘Delete’키를 누르면

파일이 목록에서 제거됩니다. ‘Remove’ 명령과 동일) 
Show/Hide: 선택한 파일을 현재의 표시창(Plot)에 표시하거나(Show), 표시하지

않기(Hide) 위한 설정을 합니다. 

 

 

 
Legend 창의 목록의 각 그래프를 마우스 오른쪽 버튼으로 클릭하면, 각 그래프에 적용 가능한 

설정(Show, Hide, Info, Save ASCII, Remove등)메뉴가 나타납니다. 

 

 

 
Info: < 그림 3.15 >와 같이 선택한 파일의 세부정보를 볼 수 있으며, ‘Weighting’

부분에서 선택한 레퍼런스 트레이스에 다른 종류의 가중치 곡선(Weighting 
Curve)을 적용할 수 있습니다. 
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< 그림 3-15 > 데이터 정보 창 

 

 
More >>: 다음과 같이 선택한 파일에 적용 가능한 옵션이나, 필요한 명령 메뉴를

보여줍니다. 

  

Save ASCII…: 각 파일은 ASCII 포맷으로 저장할 수 있으며, 이를

스프레드시트(Spreadsheets), 또는 ASCII 포맷을 사용할 수 있는

다른 프로그램에서 불러들여 사용할 수 있습니다. 
Average: 자세한 사항은 ‘3.5.4 레퍼런스 트레이스 평균’의 내용을 참고

바랍니다. 
 

Invert…: 주파수응답(Magnitude, Phase) 모드에서만 설정이 가능하며, 중앙

0(zero) 축을 중심으로 선택한 레퍼런스 트레이스의 상하를 뒤집어

표시합니다. (‘3.9.2 외부장치 설정’의 Show Inverted 옵션과 같은

효과를 위해 사용합니다.) 
 

Remove: 선택한 파일을 목록에서 제거합니다. (‘Hide’ 명령은 선택한 파일이

목록에는 남아있지만 표시창(Plot)에 표시하지 않음) 
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3.5.4 레퍼런스 트레이스(Reference Trace)의 평균 

 

각각의 RTA, Magnitude, 그리고 Phase Legend 창에서 목록 내의 두 개 이상의

레퍼런스 트레이스(Reference Trace)를 평균하여 새로운 레퍼런스 트레이스를 만들어

저장하고, 표시창(plot)에 표시할 수 있습니다. 평균하고 싶은 레퍼런스 트레이스를 두 
개 이상 선택하고 하단의 ‘More >>’ 버튼을 클릭하면 나타나는 메뉴 중

‘Average…’를 클릭합니다. 새로 만들어진 레퍼런스 트레이스를 저장하기 위한

대화창이 열리면, Description, 파일명 등을 기입하고 저장하기 원하는 위치를 지정 후

저장합니다. 이렇게 다른 레퍼런스 트레이스들을 평균하여 생성, 저장된 레퍼런스

트레이스도 하나의 독립적인 레퍼런스 트레이스와 똑같이 취급됩니다. 
 

3.6 내부 딜레이(Internal Delay) 

 

Smaart 6는 한 개의 입력 신호에 대하여 내부적으로 750ms까지의 딜레이를 설정할

수 있습니다. 이는 정확한 주파수응답 측정을 위해 레퍼런스신호와 측정신호 사이의

시간차를 조정하기 위한 기능입니다. Options의 Delay탭을 선택하거나, ‘Delay’
버튼(Smaart 6 메인창의 우측, 레벨미터 하단)을 클릭하면 나타나는 설정창에서 내부

딜레이에 대한 설정을 할 수 있습니다. 보통 레퍼런스신호 채널에 딜레이가

적용됩니다. (딜레이 설정에 대한 자세한 사항은 ‘5.3.5 딜레이’를 참고 바랍니다.) 
 

 
< 그림 3-16-1 > 딜레이 옵션 창 
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Options의 Delay 탭에서 딜레이에 대한 설정을 할 수 있습니다. ‘Delay Time’에는 현재

적용 중인 딜레이 시간이 나타나며, 원하는 딜레이 시간을 직접 입력할 수도

있습니다. A – E 프리셋(preset) 설정버튼을 클릭하여 ‘Delay Time’에 적용된 딜레이

시간을 A - E까지의 딜레이 프리셋값으로 불러올 수 있습니다. 이렇게 저장된 딜레이

프리셋은 키보드의 A – E 버튼을 눌러 바로 현재의 내부 딜레이 시간에 적용시킬 수

있습니다. 딜레이 프리셋값은 ‘Preset’ 영역에서 직접 입력할 수도 있습니다. ‘Auto 
Small’과 ‘Auto Large’ 영역은 각각 자동 딜레이 탐지기에서 사용되는 Auto Sm, Auto Lg
관련 설정을 할 수 있으며, ‘Speed of Sound’ 영역에 설정된 온도를 기준으로 현재

적용된 딜레이 시간에 해당하는 거리가 Smaart 6 메인창의 내부 딜레이 정보 표시

부분에 표시됩니다. 
Smaart6의 내부 딜레이는 자동 딜레이 탐지기(Automatic Delay Locator), 또는

임펄스응답 모드에서도 설정할 수 있습니다. (‘3.3.2 임펄스응답 모드’, ‘3.3.3 자동

딜레이 탐지기’ 참고) 
 

 

< 그림 3-16-2 > 임펄스응답 창의 딜레이 프리셋 

 

 

임펄스측정모드 창의 하단부에 ‘Delay Presets’ 버튼을 클릭하면 딜레이 설정창을 열

수 있습니다. 딜레이 옵션에 설정된 딜레이 프리셋(delay preset)은 ‘Delay Presets’ 버튼

오른쪽의 A – E 버튼을 클릭하면 프리셋에 설정된 각각의 딜레이 시간에 해당하는

위치를 임펄스응답 표시창(Plot)에 수직 점선으로 표시합니다. 또 ‘Peak’ 버튼을

클릭하면 표시창에 임펄스응답 측정 결과의 최고점(Peak)이 위치하는 지점에

고정커서(Locked Cursor)를 위치시키며, ‘Peak >> Delay’ 버튼을 클릭하면 고정커서가

현재 위치한 시간을 Smaart 6의 현재의 내부 딜레이로 적용합니다. 
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3.7 신호발생기 

 

사용 중인 사운드장치가 full-duplex 모드를 지원한다면, Smaart의 신호발생기로

측정용 신호를 재생하여 측정과정을 수행할 수 있습니다. ‘Generator’ On/Off 버튼(< 
그림 3-17 > 오른쪽 그림 참고) 아래의 신호종류와 크기에 대한 정보를 표시하는

부분을 클릭하여 신호발생기에 대한 설정창을 열 수 있으며, 다음과 같은 여러

가지의 테스트용 신호를 사용할 수 있습니다. 
 

  

< 그림 3-17 > 신호발생기 설정 창 

 

 

 Pink Noise: 옥타브 당 에너지가 같은 랜덤노이즈. (2.1.6 핑크노이즈와

화이트노이즈 참고) 
 

 Sine Wave: 단일 사인파를 테스트 신호로 재생합니다. ‘Level1’ 영역에서   -
96dB – 0dB의 신호 크기를, ‘Freq1’ 영역에서 20Hz - 24kHz의 주파수 설정이

가능합니다. 
 

 Dual Sine: 두 개의 사인파를 동시에 테스트 신호로 사용합니다. ‘Level1’, ‘Level2’
영역에서 -96dB – 0dB의 신호 크기를, ‘Freq1’, ‘Freq2’의 영역에서 20Hz - 
24kHz의 주파수를 각각 설정할 수 있습니다. 

 

 Pink Sync: 옥타브 당 에너지가 같은 동기(Synchronous) 노이즈. 랜덤 노이즈가

현재 설정된 FFT 사이즈와 같은 간격으로 반복 재생됩니다. 
 

 Pink Sweep: 핑크노이즈와 같은 스펙트럼 특징을 갖는 사인파가

저음역으로부터 고음역까지 변화하며 재생되며, 현재 설정된 FFT 사이즈와

같은 간격으로 재생됩니다. 
 

 
Smaart 6의 신호발생기는 모노(mono) 신호를 재생하며, Options의 Audio I/O탭의 설정에

따라 그 것을 한 개, 또는 두 개의 출력채널을 통해 재생 가능합니다. 주파수응답과
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임펄스응답 측정 시 한 개의 사운드장치 출력에서 나오는 신호를 물리적으로

분배하여 레퍼런스신호와 측정신호를 위한 신호로 사용하길 권장합니다. 왜냐하면

사운드장치의 출력들은 작지만 측정에 영향을 줄 수 있을 정도의 시간차(time 
offset)가 존재할 수 있습니다. 만일 사용하는 장치의 두 개 출력 사이에 시간차가

존재한다면, 위상(phase)과 딜레이 측정 시 문제를 야기시킬 수 있습니다. 게다가

이러한 경우 컴퓨터 내부에서 나누어진 신호일 경우, 레퍼런스신호가 SUT(System 
Under Test)를 통해 마이크로 입력된 측정신호와 완전히 똑같다고 확신하기

어렵습니다. 
 

 동기(Synchronous) 테스트 신호 

 

Smaart 6의 ‘synchronous noise’ 옵션은 현재의 FFT 사이즈와 같은 간격으로 반복되는

랜덤노이즈이며, ‘pink sweep’ 옵션은 핑크노이즈와 같은 스펙트럼 특징을 가지고

현재의 FFT 사이즈와 같은 간격으로 반복되는 신호입니다.  
 

FFT 기반의 측정에서 랜덤 테스트 신호를 사용하여 측정과정을 수행할 경우

상대적으로 큰 평균(averaging)을 사용하거나, 적절한 Time window를 사용해야 합니다. 
하지만 동기(Synchronous) 테스트 신호를 사용하는 경우 MLS(Maximum Length 
Sequence)와 TDS(Time-Delay Spectrometry) 측정기술과 같이, 불필요한 잡음으로부터

독립적으로 측정과정을 수행할 수 있는 특징을 가진 결정론적인(deterministic), FFT 
기반의 주파수/임펄스응답 측정을 가능하게 해줍니다. 
 

핑크 스펙트럼(pink spectral)의 가중치(weighting) 옵션은 옥타브 당 같은 에너지를

가진(화이트노이즈와 비교해 옥타브당 에너지가 3dB씩 감소하는) 신호를 출력하며, 
RTA 디스플레이에서 옥타브 단위의 해상도로 볼 경우 평탄한(flat) 스펙트럼으로

보입니다. 
 

3.8 가중치 곡선(Weighting Curves) 

 

음향 측정과 시스템 셋업 과정을 수행하다 보면 AMSI/IEC A weighting, C weighting와

같은 주파수 가중치곡선(weighting curve)이 필요한 경우가 많습니다. 가중치 곡선은

용도 별로 다양한 형태에 맞춰 만들어졌습니다. 
 

Smaart 6의 신호레벨/SPL 정보표시 영역과 RTA에서의 그래프 표현에 표준 A, C, X, 
Inv X 가중치를 적용하여 사용할 수 있습니다. 주파수응답과 스펙트럼 측정의 가중치

옵션은 각각 독립적으로 설정할 수 있습니다. 
 

Smaart 6는 사용자가 직접 정의한 가중치곡선(Weighting curve)을 적용하여 측정과정을

수행할 수 있습니다. 주파수 가중치곡선은 주파수 별 상대적인 크기를 정의한

주파수응답 곡선과 비슷합니다. 주파수응답 측정 수행 중 ‘FPPO’의 FFT 사이즈로
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캡처한 모든 레퍼런스 트레이스(Reference Trace)는 Smaart 6의 가중치곡선으로 사용할

수 있습니다. 먼저 그래프를 캡처하고, 컴퓨터의 Smaart 6 설치폴더의 ‘Weighting’
폴더에 캡처한 레퍼런스 트레이스를 저장한 후, Smaart 6를 다시 시작하면

가중치(weighting) 옵션의 목록에 추가되어 나타나고, 이를 선택하면 측정 중인

주파수응답/스펙트럼 측정에 적용할 수 있습니다.  
 

 

 

 
사용자 정의 가중치곡선의 가중치(Weighting) 옵션 목록(drop-list) 상의 이름은 그 곡선이 

저장될 때 기입한 ‘Description’이 보여집니다. (캡처한 레퍼런스 트레이스의 저장에 관련된 

자세한 내용은 ‘3.5.1 레퍼런스 트레이스의 캡처’를 참고 바랍니다.) 

 

 
 

3.9 외부장치 제어 

 

 

 
Smaart 6를 Mac OS에서 사용할 경우 아직 외부장비를 제어할 수 없습니다. 

 

 

3.9.1 외부장비 제어 인터페이스 

 

원격조정이 지원되는 이퀄라이저, 시스템 프로세서 등의 외부장비는 Smaart 6의

외부장비 제어 인터페이스를 통해 직접 제어할 수 있습니다. 이 기능을 통해, 
원격조정 대상 장비의 여러 파라미터 조정을 위해 별도의 프로그램 창을 띄우거나, 
옮겨 갈 필요 없이 Smaart 6 내에서 실시간으로 측정과정의 결과를 확인하며, 대상

장비를 직접 조정할 수 있습니다.  
 

특정 장비에 대한 지원은 “plug-in” 파일을 통해 이루어지므로, 지원 가능한 장비들의

목록은 변경되는 수가 있습니다. 또 독점적인 OEM 제어 소프트웨어나 각 장비가

가진 모든 기능 전부를 지원하지 않을 수도 있습니다. 
 

Magnitude 디스플레이에서 키보드의 X키를 누르거나, ‘External Devices’ 메뉴의 ‘Show 
Current Device’를 선택하면, 현재 선택된 외부장비 제어를 위한 창이 나타납니다. 
여러 개의 외부장비를 사용 중일 경우, ‘External Devices’ 메뉴에서 조정을 원하는

장비를 선택하면 됩니다. 
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외부장비 제어 모드에 있을 경우, 현재 그 장비의 선택된 채널의 EQ와 관련된

주파수와 cut/boost 위치(적용 가능한 경우), high/low pass filter에 대한 마커(marker)가
Magnitude 표시창(plot)에 표시됩니다. High/low pass filter는 관련된 필터의 roll-off 
방향을 나타내주는 특별한 마커로 표시됩니다. 모든 다른 형태의 필터는 사각 박스

형태로 보여집니다. 
 

원격조정 중인 장비의 필터 셋팅은 Magnitude 디스플레이 위에 나타나는 마커를

마우스로 클릭하고 드래그하여 조정할 수 있습니다. 마우스로 클릭하여 필터의

마커를 선택하면, 그 필터의 파라미터들이 외부장치 제어 창의 윗부분에 표시됩니다. 
표시되는 정보는 선택된 필터의 형태에 따라 다르게 나타납니다. 예를 들어, graphic 
EQ의 경우 개별 필터의 중심주파수와 대역폭은 고정되어있지만, parametric EQ는

사용자가 조정 가능합니다. 
 

표시창(plot)에 나타난 모든 필터의 마커는 키보드의 Tab키를 이용해 순차적으로

선택(Shift+Tab키는 반대 순서로 선택)할 수 있습니다. 선택된 필터의 중심주파수(Hz), 
대역폭(Oct)과 cut/boost 값(dB)은 외부장비 제어창의 윗부분에 보여집니다. 
 

필터의 Cut/boost 값이 0(zero)로 설정되어 있다는 것은 사용하지 않고 있다는 말과

같습니다. 일부 디지털 장비에서, 사용하지 않는 필터는 나타나지 않습니다. (일부

장비의 경우 키보드의 Shift키를 누른 상태에서 표시창(plot)위를 클릭하면, 
자동적으로 사용하지 않고 있는 필터가 나타나고, 또 선택됩니다.) 
 

선택한 필터의 중심주파수(parametric EQ의 경우)와 cut/boost 값을 조정하려면, 
키보드의 방향키를 사용하거나, 마우스로 마커를 드래그하면 됩니다. Parametric EQ의

경우, 키보드의 Shift키를 누른 상태에서 좌우방향키를 사용하여 필터의 대역폭을

조정할 수 있습니다.  
 

Parametric 필터는 외부장비 제어창의 파라미터 조정 영역 우측의 화살표가 있는

버튼(spinner)을 클릭하여서도 조정이 가능합니다. 일부 파라미터 영역은 마우스로 그

영역을 클릭하고 값을 입력하는 방법으로 직접 조정이 가능합니다. 화살표

버튼(Spinner)으로 조정할 경우 대부분의 장비는 정해진 값만큼씩 한번에 증가하거나, 
줄어들기 때문에, 원하는 세밀한 값을 입력할 경우 직접 입력하여 조정해야 합니다. 
 

 

 

 
Smaart 6에서 제어 가능한 외부장비는 프로그램의 ‘External Devices’ 메뉴에서 확인 가능하며, 

EAW, 스마트코리아 웹사이트에서도 확인하실 수 있습니다. 
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3.9.2 외부장치 설정 

 

지원되는 외부장치를 Smaart 6 프로그램 내에서 제어하기 전에 그 장치에 대한

설정을 해주어야 합니다. ‘External Devices’ 메뉴의 ‘Add’를 선택하면 가능한 장비의

목록(Smaart 6 프로그램 메뉴의 장비의 목록은 Smaart 6 설치폴더 내의 ‘Devices’
폴더의 드라이버 파일들을 스캔하여 작성됨)을 볼 수 있습니다. 그 목록의 장비를

선택하면, 해당 장비의 설정창이 열립니다. 설정이 끝나면 OK 버튼을 클릭하여

설정을 마치면 됩니다. 
 

설정을 다 마쳤다면, ‘External Devices’ 메뉴의 외부장비 목록(‘Add’의 아랫부분에

나타남)에 추가되며, 각 장비의 하위메뉴에서 제어를 원하는 채널을 선택하여

클릭하면 설정창이 나타납니다. 하위메뉴에서 ‘Remove’ 명령을 선택하면, 그 장비는

외부장비 목록에서 제거됩니다. 
 

 
선택한 EQ 장비를 제어하는 방법은 다음과 같습니다. 
 

 

1. 선택한 장비의 필터를 조정하려면, Magnitude 디스플레이에 표시된 필터의

핸들(handles)을 마우스로 드래그하거나 외부장비 제어창의 ‘Filters’ 영역의

파라미터들을 조정합니다. 
2. 현재 선택한 필터, 또는 전체 필터를 평탄(flat)하게 만들려면, 각각 ‘Flat’, 

또는 ‘All Flat’ 버튼을 클릭합니다. 
3. ‘Show Inverted’ 옵션에 체크하면, 그 필터의 boost/cut의 상하(+/-) 표현이

바뀝니다. 이는 Magnitude 디스플레이 상의 측정결과에 맞춰 필터를

수정하려는 경우, 그 결과로 나타난 그래프(전체 또는 수정하려는 부분)와
필터의 모양을 세밀하게 일치시킬 수 있어, 정확하고 편리하게 작업을 진행할

수 있습니다. 
4. ‘Gain’ 영역에서 대상 장비의 전체 게인(gain)을 조정할 수 있습니다. 
5. ‘Program’영역의 ‘Recall’과 ‘Store’ 버튼을 클릭하여 필터의 셋팅을 제어중인

외부장비나 컴퓨터에서 불러오거나, 저장할 수 있습니다. 
6. ‘Sys Control’ 버튼(해당 장비가 지원하는 경우)을 클릭하면, 시스템 제어

옵션창이 열립니다. 이 창에서 설정할 수 있는 옵션은 장비에 따라 아주

다양합니다.  
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3.10 고정 커서(The Locked Cursor) 

 

Smaart 6의 고정커서(Locked Cursor)는 표시창(plot)위에 선택한 위치에 고정된

마커(marker)를 나타내는 기능이며, 특정 위치와 다른 위치 사이의 차이를 정확하게

확인하기 위해서 사용됩니다. 고정커서가 표시되어 있는 경우, 세 가지의 커서의

위치값을 표시창 위에서 확인할 수 있습니다. 좌측부터 고정커서의 위치, 현재

마우스커서의 위치, 두 위치 사이의 차이에 대한 정보가 표시됩니다. 
 

RTA와 Magnitude 디스플레이에서 고정커서가 위치한 주파수를 기준으로 한

배음(harmonic)들을 표시할 수 있습니다. (고정커서를 위치시킨 후 키보드의 H키를

눌러 표시) 또, 임펄스모드에서 측정이 끝나면 전파 지연시간(propagation delay)에
해당하는 위치인 최고치(peak)에 맞춰 자동적으로 고정커서가 표시됩니다. 
 

현재 마우스커서의 위치에 고정커서를 표시하려면, 표시창(plot) 위의 원하는 지점에

키보드의 Ctrl키를 누른 상태로 클릭하면 됩니다. (Spectrograph는 제외) 고정커서

표시를 해제하려면 키보드의 Ctrl + X키를 누르거나, Ctrl키를 누른 상태에서

표시창(plot)의 좌측이나 아래의 좌표값 부분을 클릭하면 됩니다. 
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3.11 Smaart 6 화면 캡처 

3.11.1 Windows 

 

Windows는 표시중인 전체화면을 비트맵(bitmap) 이미지로 캡처할 수 있는 기능이

있습니다. 이 기능으로 Smaart 6의 화면을 캡처하여 보고서나 다른 문서에 사용할 수

있습니다. 
 

키보드의 PrtScn(prt sc)키를 누르면 현재의 모니터에 나타나는 전체화면이 비트맵

이미지로 캡처 되고, Alt+PrtScn(prt sc)키를 누르면 현재 활성화 되어있는 창만 캡처

됩니다. 이렇게 캡처된 이미지는 이미지편집 프로그램이나 워드프로세서 등의 다른

프로그램에서 ‘붙여넣기(paste)’를 하여 사용할 수 있습니다. 
 

흑백프린터에서 출력 할 경우, ‘Options’의 ‘High Contrast View’로 설정하는 것이

좋습니다. 
 

3.11.2 Mac OSX 

 
다음과 같이 Grab을 이용하여 전체화면을 캡처할 수 있습니다. 
 

 

1. Grab(located in /Applications/Utilities)을 구동합니다. 
2. Capture > Window를 선택합니다. 
3. Window Grab 대화창이 열리면, ‘Choose Window’를 클릭합니다. 
4. 캡처하려는 창을 클릭합니다. 

 

 
캡처가 완료되면, 이미지를 보여주는 새 창이 열립니다. 
 
 

 
전체화면 캡처를 원하지 않는 경우, 다음과 같이 모니터에 표시되는 화면 중 특정

영역만 캡처할 수 있습니다. 
 

 

1. Grab(located in /Applications/Utilities)을 구동합니다. 
2. Capture > Selection를 선택합니다. 
3. 캡처하려는 영역을 마우스로 드래그하여줍니다. 

 
 캡처가 완료되면, 이미지를 보여주는 새 창이 열립니다. 
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Chapter 4: Smaart 6 응용 
 

 

 

‘Chapter 4: Smaart 6 응용’은 오디오시스템과 개별 장비를 측정하기 위한 Smaart 6의

네 가지의 전형적인 응용에 대한 내용을 다룹니다. 필요한 예제만 볼 수도 있겠지만, 
Smaart 6 사용에 대한 전반적인 이해를 위해 네 가지 예제를 모두 볼 것을

권장합니다. 
 

‘4.5 사운드시스템의 측정과 최적화’에서는 (스펙트럼의 균형과 사운드시스템의 
안정성에 초점을 맞춰) 사운드시스템을 평가하고 최적화하기 위한 Smaart 6 사용법에

대해 다룹니다. 
 

 

 

 

EAW社는 Smaart 6를 적당하게 사용하지 않아 발생되는 장비의 손상에 대한 책임을 지지 

않습니다. 측정을 시작하기 전에 반드시 모든 시스템 구성 장비에 대해 입/출력 레벨, 

임피던스, 그리고 장비 간 연결 등에 문제가 없는지 확인하시기 바랍니다. (아직 본 

사용설명서의 1~3장의 내용을 읽어보지 않았다면, Smaart 6의 바른 사용을 위해 1장을 읽어볼 

것을 권장합니다.) 
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4.1 실시간 스펙트럼 분석기(RTA) 

 

2채널 실시간 스펙트럼 분석은 Smaart 6의 가장 기본적인 기능입니다. 스펙트럼

측정은 하드웨어 형태의 RTA와 비슷합니다. 즉, 신호가 들어와 주파수 영역별로

나누어지고, 그 영역마다의 에너지 양(magnitude)이 표현됩니다. 각 채널의 기본적인

디스플레이는 1/12옥타브의 스케일로 각 주파수 별 에너지를 막대 그래프 형태로

나타내며, 설정에 따라 다른 형태로 나타낼 수도 있습니다. 
 

4.1.1 측정시스템 연결 

 

사운드장치의 입력 단에 1개 이상의 오디오 신호를 연결합니다. 2채널에 대한

측정결과를 동시에 볼 수도 있지만, 한 채널은 측정마이크를, 또 다른 채널에는

CD플레이어나 믹싱콘솔의 출력 신호를 연결합니다. 
 

연결이 완료되었다면, Smaart 6를 실행한 후, RTA 디스플레이 형태를 선택하고, 
‘Start’버튼을 클릭하여 측정을 시작합니다. 
 

 

< 그림 4-1 > RTA 측정 
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아래 < 그림 4-2 >는 측정마이크를 통해 들어오는 휘파람 소리에 대한 RTA 
디스플레이의 반응을 보여줍니다. 
 

 
< 그림 4-2 > 기본 RTA 스펙트럼 디스플레이 (1/12 옥타브 밴드) 

 

 

RTA 디스플레이의 옵션 중 시각적으로 변화가 가장 큰 것은 ‘Frequency Scale’ 즉,
주파수 대역 해상도입니다. 표시창(plot) 우측에 위치한 ‘Scale’의 목록(Log, Lin, Oct, 
1/3, 1/6, 1/12, 1/24)에서 원하는 옵션을 선택할 수 있습니다. ‘log’와 ‘Lin’는 FFT사이즈

설정에 따라 정해진 모든 데이터포인트를 각각 로그스케일과 선형스케일로

보여주고, 다른 옵션들은 주파수 대역을 옥타브 단위로, 또는 옥타브의 1/3, 1/6, 1/12, 
1/24 단위로 나누어 보여줍니다.  
 

 

 
< 그림 4-3 > 스펙트럼 파라미터들 

 

 

평균(averaging)은 RTA 디스플레이의 그래프들이 현재의 측정결과만을 즉시

표현하거나, 일정 시간의 측정결과를 모아 평균한 결과를 표현하도록 설정하기 위한

옵션입니다. ‘Avg’의 목록(1, 2, 4, 8, 16, 32, 64, 128, Inf, Slow, Fast)에서 원하는 옵션을

설정할 수 있으며, 키보드의 V키를 누르면 평균 버퍼를 비우고 새로 평균을

시작합니다. 
 

‘Weight(가중치)’ 설정은 주파수 가중치 곡선을 RTA 디스플레이에 적용하기 위한

옵션입니다. (3.8 가중치 곡선 참고) 
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디스플레이에 대한 더욱 세밀한 설정은 Options의 Spectrum 탭에서 할 수 있습니다. 
(‘5.3.1 스펙트럼’ 참고) 
 

스펙트럼 측정으로 피드백(Feedback) 주파수를 찾고, 공간의 소음을 분석하고, 음악의

주파수 별 에너지의 양을 파악할 수 있습니다. 외부 기준에 맞춰 음압레벨을

교정(calibration)하면, 실시간으로 주파수 대역 별, 또는 전 대역의 SPL을 확인할 수

있습니다. (‘3.4 SPL 측정’ 참고) 
 

 
< 그림 4-4 > 스펙트로그라프와 SPL 디스플레이 

 

 

RTA(Real-Time Analyzer)는 주파수응답을 측정하고 시스템에 EQ를 적용하기 위한

도구로 오랫동안 사용되어 왔습니다. 그러나 스펙트럼 측정은 본래부터 반사음과

직접음, 또는 자극(excitation) 신호와 측정에 불필요한 신호를 구별하지 못하기

때문에, 시스템응답 최적화를 위한 정확도는 매우 제한적입니다. 반면에, 주파수응답

측정은 시스템 특성에 대해 더 완전하고 정확한 정보를 제공하기 때문에

주파수응답(Frequency Response) 측정을 사용한 시스템응답 최적화를 권장합니다. 
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4.2 아날로그 이퀄라이저 측정 

 

본 예제는 Smaart의 실시간 주파수응답 측정 기능을 이용하여 아날로그

이퀄라이저의 주파수응답을 측정한 것입니다. 본 예제를 실행해 보시려면 아날로그

이퀄라이저(EQ), 크로스오버(crossover) 등이 필요합니다. 
 

디지털 장비의 입력에서 출력까지는 데이터 처리로 인한 약간의 딜레이가 있으며, 
이 딜레이는 주파수응답 측정을 수행하기 전에 보정이 필요하기 때문에, 본 예제의

실행은 아날로그 장비를 사용해야 합니다. 물론 Smaart는 전파(propagation) 
지연시간을 보정하여 측정할 수 있지만(‘4.3 라우드스피커 측정’의 예제 참고), 본

예제에서는 그 기능을 배제하고 단순하게 진행하겠습니다. 
 

 
본 예제를 수행하기 위해서 다음의 장비들이 필요합니다. 
 

 

 아날로그 이퀄라이저 – 독립 형태의 EQ가 없다면, 아날로그 믹서 채널의

EQ(또는 딜레이 추가 없이 주파수를 변경할 수 있는 다른 아날로그 장비)로
대신할 수 있습니다. 

 각 장비의 연결에 필요한 케이블과 변환커넥터 등 
 

4.2.1 측정 장비의 구성 

 

< 그림 4-5 >와 같이 각 장비를 연결을 합니다. 사운드 장치의 출력(라인레벨)은
이퀄라이저의 입력과 사운드 장치의 레퍼런스(reference) 입력으로 연결합니다. 
이퀄라이저의 출력은 사운드 장치의 측정(measurement) 입력으로 연결합니다. 즉, 
Smaart 6의 신호발생기에서 재생되어 사운드 장치의 출력으로 나온 신호는 두 가지

경로로 나누어지고, 다시 Smaart 6로 입력되어 비교합니다. 이렇게 입력된 레퍼런스

신호와 측정 신호를 비교하고, 두 신호 간의 차이를 트랜스퍼 기능(Transfer 
Function)으로 나타냅니다. 
 

 

< 그림 4-5 > 아날로그 EQ 측정 
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4.2.2 신호 레벨 조정 

 

1. Smaart 6의 신호발생기의 소스가 핑크노이즈로 선택되어있지 않다면, 
신호발생기의 정보표시 부분을 클릭하여 설정창을 엽니다. 

2. 신호 종류 중 핑크노이즈를 선택합니다. 
3. 신호발생기의 출력레벨을 -6dB 정도(시스템과 이퀄라이저의 다이나믹

레인지에 따라 적당한 레벨)로 설정합니다(Level 1부분, 초기값은 -36dB).  
4. ‘Generator On’에 체크한 후 ‘OK’를 클릭하여 설정창을 닫습니다. 신호발생기

버튼의 녹색 LED에 불이 들어오고, 핑크노이즈가 사운드 장치의 출력을 통해

재생됩니다. 
 

     
< 그림 4-6 > 신호발생기(좌)와 설정 창(우) 

 

 

5. ‘Start’ 버튼을 눌러 측정을 시작합니다. 
6. 레퍼런스 신호와 측정 신호의 양이 비슷하게, 또 각 신호의 입력레벨이 약 -

9dBFS ~ -12dBFS 정도가 되도록 사운드장치의 입력신호의 레벨을 조정합니다. 
(‘1.3 Smaart 6 신호 입출력’ 참고) 

7. EQ가 바이패스(bypass)되어 있거나 모든 필터의 셋팅이 0(Zero)이고, Smaart 
6의 셋팅이 바르게 되었다면, Magnitude 그래프는 0dB 라인 상에 거의

평탄(flat)하게 나타납니다. 만일 그래프가 0dB 라인보다 조금 위나 아래에

나타난다면, 두 입력신호 중 한가지의 레벨을 다음과 같이 조정하여 0dB 
라인에 맞출 수 있습니다. 

 

 

 측정신호 입력의 레벨을 조정합니다. 
 키보드의 Ctrl/Cmd 키를 누른 상태에서 위/아래 방향키를 눌러

조정하거나, Magnitude의 Legend 창을 열어 ‘dB +/-’ 영역의 상하방향키를

클릭하여 1dB씩 그래프의 위치를 올리거나 내릴 수 있습니다. 
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이퀄라이저의 필터를 조정함에 따라 Smaart 6의 Magnitude와 위상 디스플레이의

그래프가 변하는 것을 볼 수 있습니다. 이퀄라이저 필터의 값을 줄였을 경우

Magnitude의 그래프는 오히려 올라간다면, 레퍼런스 입력과 측정 입력 신호가 반대로

바뀌어 연결된 것입니다. 이럴 경우, 사운드 장치의 입력 신호를 바로 연결하거나, 
Options의 Audio I/O 탭에서 ‘Meas In’과 ‘Ref In’ 설정을 바꾸어야 합니다. 
 

주파수응답 측정의 주파수 해상도 초기값은 매 옥타브마다 24개의 FFT 데이터

포인트(최저 2개의 옥타브는 합해서 24개의 데이터 포인트)를 갖는 FPPO(Fixed Points 
per Octave)로 되어있습니다. FPPO 옵션은 Options의 Freq. Resp. 탭의 ‘FFT Size’
영역에서 설정할 수 있습니다. ‘Phase’ 버튼을 클릭하면 주파수에 따른 위상 특성을

확인할 수 있습니다. 아래 <그림 4-7>은 파라메트릭 EQ의 1kHz 대역을 조금

부스트(boost)시킨 위상과Magnitude 결과입니다. 
 
 

 

 

< 그림 4-7 > 아날로그 파라매트릭 EQ 필터의 측정 예제 
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4.3 라우드스피커 측정 

 
다음은 특정 공간에 위치한 라우드스피커를 측정하기 위해 임펄스응답모드와 실시간

주파수응답 측정을 사용한 예입니다. 
 

 
본 예제를 수행하기 위해서 다음의 장비들이 필요합니다. 
 

 

 파워앰프와 라우드스피커 
 평탄한 주파수응답 특성을 가진 측정마이크                           

(보통 콘덴서 타입이며, 팬텀파워가 지원되는 프리앰프가 필요합니다.) 
 각 장비의 연결에 필요한 케이블과 변환커넥터 등 

 
 

 
< 그림 4-8 >와 같이 각 장비를 연결을 합니다. 
 

 

 사운드장치로부터의 테스트 신호 출력을 레퍼런스입력(Ref In)과 파워앰프로

나누어 연결합니다. 
 측정마이크는 사운드장치의 측정입력(Meas In) 채널에 연결합니다. Smaart 6의

오디오 입출력은 Options의 Audio I/O 탭에서 설정 가능합니다.  
 

 
< 그림 4-8 > 라우드스피커/파워앰프 측정 
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4.3.1 신호 레벨 조정 

 

1. 라우드스피커의 1미터 앞에 측정마이크를 위치합니다. 측정마이크의 위치가

라우드스피커로부터 멀어질수록, 라우드스피커의 직접음보다는 반사음들이

상대적으로 많이 집음 되어 측정결과에 좋지 않은 영향을 미칠 수 있습니다. 
2. ‘Spectrum’ 버튼을 클릭하면 ‘RTA’와 ‘Spectrograph’ 디스플레이를 동시에 볼

수 있습니다. 
 

3. 측정을 시작하려면 ‘Start’ 버튼을 클릭합니다. 
4. Smaart 6의 신호 발생기를 켜고, 라우드스피커의 음압이 주변 소음보다

충분히 클 수 있도록 레벨을 조정합니다. 측정 대상 장비와 측정 진행자의

귀를 보호하기 위하여, 저음역을 담당하는 앰프로부터, 천천히 레벨을

증가시키는 것이 좋습니다. 
5. 사운드장치와 마이크 프리앰프의 입력 레벨을 적당히 조정합니다. (그림 < 1-2 

> 참고) 
6. 최상의 측정 결과를 얻기 위해, 레퍼런스신호와 측정신호 입력의 크기를

최대한 비슷하게 하는 것이 좋습니다. (‘4.2.2. 신호 레벨 조정’ 참고) 
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4.3.2 임펄스응답 측정 

 

 

1. ‘IR Analysis’ 버튼을 클릭하여, 임펄스응답 측정 창을 엽니다. 
2. ‘Start’ 버튼을 클릭하면, 측정을 수행하고 결과를 표시창에 나타냅니다. 

 

 
< 그림 4-9 > 작은 공간의 임펄스응답 측정 예 

 

 

< 그림 4-9 >는 특정 공간에 위치한 라우드스피커의 임펄스응답 측정에 대한 결과를

로그스케일로 보여주는 전형적인 예입니다. 임펄스응답은 시간에 따라 측정마이크에

도달하는 에너지를 나타냅니다. Smaart 6는 임펄스응답 측정에 대한 결과를

극성(polarity) 정보가 포함된 선형(linear) 단위, 또는 ETC(Energy-Time Curve)로도 볼

수 있습니다. 
 

< 그림 4-9 >의 측정 결과를 보면, 시작부분의 최고점(peak)은 라우드스피커로부터의

직접음을 나타냅니다. 이를 통해 파워앰프, 라우드스피커, 측정공간 등을 포함한

측정 대상 시스템의 전파(propagation)딜레이를 알 수 있습니다. 주파수응답 측정 시

이와 같은 전파딜레이는 반드시 보정되어야 합니다. Smaart 6는 임펄스응답 측정이

완료되면, 자동적으로 측정 결과의 최고점(peak)을 찾아내고, 고정커서(Locked 
cursor)를 표시합니다. 전파딜레이가 비정상적으로 길 경우, 측정신호와

레퍼런스신호의 입력이 바뀌었을 수도 있습니다. 이 경우 사운드장치의 입력 단을

확인하고, 바르게 연결한 뒤 다시 측정을 진행합니다. 
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직접음 이후에 도달하는 에너지는 측정 중인 공간이나, 주변 소음에 따라 여러 가지

다른 유형으로 나타납니다. 정확한 측정을 위해서는 주변 소음에 대해 직접음이

충분히 클 수 있도록, 즉 충분히 큰 S/N비를 확보하는 것이 중요합니다. 
 

임펄스응답 측정은 건축음향 측정 분야에서 널리 사용됩니다. 임펄스응답 측정

모드는 콤필터(comb filter) 현상 등 실시간 측정을 어렵게 만드는 문제가 되는

반사음들을 찾아낼 수 있도록 도와주며, 자동 딜레이 탐지 기능은 여러 가지로 아주

유용하게 사용될 수 있습니다. 임펄스응답 측정 모드를 잘 활용하기 위해 이러한

측정 과정이 어떻게 이루어지는지 이해하는 것이 중요합니다. 
 

4.3.3 라우드스피커의 주파수응답 측정 

 

1. 임펄스응답 측정 모드를 끄고, 위상과 Magnitude 디스플레이를 보기 위하여

‘Freq. Resp.’ 버튼을 클릭합니다. 
2. 라우드스피커와 측정마이크 사이의 전파(propagation) 지연시간을 보정하기

위하여 ‘Auto Sm’ 버튼을 클릭하고, 적용합니다. ‘Auto Sm’ 버튼을 누르면

Smaart 6의 내부에서 임펄스응답 측정을 수행하여 자동적으로 딜레이타임을

보여줍니다. 
3. ‘Insert Delay’ 버튼을 클릭하면 측정된 딜레이타임이 Smaart 6의 내부 딜레이에

적용됩니다. 
4. 딜레이 프리셋(Delay Presets)에 여러 개의 딜레이타임을 저장하였다가 빠르게

적용이 가능합니다. 이 기능은 여러 개의 마이크를 다른 곳에 위치해 두고

측정할 경우 등에 유용하게 사용됩니다. 현재의 딜레이타임 값을

프리셋(Preset)에 저장하려면, Options의 Delay 탭의 ‘Delay’ 부분의 A-E 중

원하는 프리셋 위치에 해당하는 버튼을 클릭하면 됩니다. 이렇게 프리셋에

저장된 딜레이타임을 불러 현재의 내부 딜레이에 적용하려면 키보드의 A-E 
키를 누르면 됩니다. 

5. ‘Start’ 버튼을 클릭하여 실시간 측정을 시작합니다. 만일 그래프가 너무

안정되지 않고 심하게 요동할 경우, 좀 더 큰 평균(Avg)값을 사용하여

그래프가 안정적으로 나타나게 합니다. 
 

 

 

 
딜레이 탐지기를 통해 바른 딜레이 타임을 얻으려면 측정 대상 장비나 SUT(System Under 

Test)의 Decay Time보다 큰 FFT Time Constant(Time Window)로 설정되어 있어야 합니다. 전자 

장비나 중소 규모의 공간을 위해서는 0.3-1.0초 정도의 Time Window가 적당합니다. 
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4.4 라우드스피커의 측정과 이퀄라이저 설정 

 

본 예제는 아날로그 이퀄라이저와 라우드스피커를 측정하기 위한 방법을

설명합니다. 먼저 라우드스피커를 측정하고, 그 동작을 최적화하기 위한

이퀄라이저의 설정을 할 것입니다. 
 
 

 
다음 <그림 4-10>과 같이 각 장비를 연결합니다. 
 

 

 외부음원(CD Player 등) 또는 사용 중인 컴퓨터의 출력 
 파워앰프와 라우드스피커 
 측정마이크 
 이퀄라이저 (주파수응답 튜닝을 위해 각 필터의 대역을 적당히 설정하여

조정할 수 있는 파라메트릭 이퀄라이저를 사용할 것을 권장합니다.) 
 각 장비 연결을 위한 케이블 
 오디오 믹싱콘솔 

 
 

 

< 그림 4-10 > 라우드스피커의 측정과 이퀄라이저 설정 
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라우드스피커 측정과 이퀄라이저 측정 사이의 전환은 사용 중인 오디오

인터페이스에서 케이블 연결을 직접 바꾸어도 가능하지만 < 그림 4-10 >과 같이

오디오 믹싱콘솔을 사용하여도 됩니다. 또는 멀티채널의 오디오 인터페이스를

사용할 수도 있습니다. < 그림 4-10 >과 같이 오디오 믹싱 콘솔을 사용한다면, 
레퍼런스 신호(음원)와 측정신호(EQ의 출력신호, 측정마이크 신호)가 서로 섞이지

않도록 각 채널의 Pan을 설정합니다. (예를 들어, A 채널의 Pan은 Left로, B/C 채널의

Pan은 Right로 하고, Left와 Right를 각각 오디오 인터페이스의 레퍼런스입력, 
측정신호 입력과 연결합니다.) 
 

 
다음의 진행은 이전 예제를 수행하였고, 이해하였다는 가정하에 설명합니다. 
 

 

1. A 신호(그림 4-10)가 Smaart 6의 레퍼런스신호 입력채널로, C 신호(그림 4-
10)가 Smaart 6의 측정신호 입력채널로 연결되도록 오디오 믹싱콘솔을

설정합니다. B 신호(그림 4-10)는 지금은 사용하지 않습니다.  

 
이퀄라이저의 출력(< 그림 4-10 >의 B신호)신호가 사운드카드로 입력되지 않도록 주의 

하십시오. (오디오 믹싱콘솔에서 Mute하여 줍니다.) 

 
2. 자동 딜레이 탐지기를 사용하여 레퍼런스 신호와 측정마이크를 통해

들어오는 측정신호 사이의 딜레이타임을 찾고, 내부 딜레이에 적용하여 두

신호를 정렬합니다. 
3. 측정된 딜레이타임을 딜레이 프리셋(delay preset) 키(A-E)에 저장합니다. 
4. 라우드스피커의 주파수응답 측정 과정을 시작합니다. (4.3.3 라우드스피커의

주파수응답 측정 참고) 
5. Smaart 6의 ‘Start’ 버튼을 클릭하고 Magnitude 디스플레이의 그래프(Trace)가

0dB 선 상에 위치하는지 확인합니다. 0dB 선 상에서 멀리 떨어졌다면 입력

레벨이나, Y+/– 설정을 통하여 0dB 선상에 위치하도록 합니다. 
6. 주파수응답 측정의 레퍼런스 트레이스를 캡처합니다. 
7. A 신호가 Smaart 6의 레퍼런스 입력채널로, B 신호가 Smaart 6의 측정신호

입력채널로 연결되도록 오디오 믹싱콘솔을 설정합니다. (C신호는 사용하지

않습니다.) 
8. 내부 딜레이를 리셋(Reset)합니다. 
 

 

 아날로그 EQ를 사용 중이라면, F5 키를 눌러 내부 딜레이를 0ms로
리셋합니다. (아날로그 EQ는 신호처리를 위한 지연시간이 거의 없습니다. 
따라서 딜레이에 대한 보정은 필요 없습니다.) 

 디지털 EQ를 사용 중이라면, 자동 딜레이 탐지기로 딜레이타임을 찾아

내부딜레이에 적용하여 보정하여 줍니다. 
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9. EQ의 모든 필터의 값을 0dB로 설정합니다. Smaart 6를 실행하여 Magnitude 
디스플레이의 그래프(Trace)가 0dB 선 상에 위치하도록 레벨 또는, Y+/–
설정을 조정합니다. 

10. Magnitude 디스플레이의 ‘Legend’창에서 ‘More>>’의 ‘Invert’를 클릭하여 6.에서

저장(캡처)한 시스템응답에 대한 레퍼런스 트레이스의 상하를 뒤집어 줍니다.
기본적으로 시스템의 주파수응답 그래프에서 큰 부분은 줄이고, 작은 부분은

키우려고 할 경우, EQ 설정은 상하가 뒤집힌 주파수 응답 그래프와 같은

모양을 가지게 되므로, 뒤집힌(Invert) 시스템응답 그래프에 맞춰 EQ의 각

필터를 설정한다면, 시스템응답에서 크거나 작은 부분을 쉽게 줄이거나 키울

수 있습니다. 
11. 만일 노이즈를 측정 신호로 사용하고 있었다면, 이번 단계에서는 음악으로

바꾸어 주는 것이 좋을 수도 있습니다. 저장된 시스템응답 그래프(Trace) – 
Invert 되어있는 상태 – 에서 0dB 아래로 움푹한 모양으로 들어간 부분들과

EQ의 필터 모양을 일치시킵니다. (시스템의 특성 상 입력된 소스보다 커진

부분의 신호를 EQ에서 줄여줍니다.) 하지만 위로 솟아오른 부분과 일치

시치는 것(시스템의 특성 상 입력된 소스보다 작아진 부분의 신호를 EQ에서

키우는 것)은 EQ의 필터에서 신호를 부스트하는 것이므로 적절한 판단을

하여 이루어져야 합니다. 이러한 단계에 따라 여러 번의 시스템응답 측정을

수행해보면서 EQ 설정에 따른 변화를 귀로 들어 직접 확인해 보는 것이

좋습니다. 
 

 

 

 
사운드 시스템의 주파수응답에 따라 EQ를 설정할 경우, EQ의 필터를 부스트하는 것은 최대한 

피하는 것이 좋습니다. 필터를 과도하게 부스트하면 위상 특성이 나빠지고 

디스토션(distortion)이 발생하여 시스템의 성능을 저하시킬 수 있습니다. 대신 시스템의 응답 

특성 중 많이 작아진 (소스보다 작아진)부분이 커질 수 있도록 파워앰프와(또는) 크로스오버의 

셋팅을 바꾸고 난 후, 전체 시스템 응답 중 솟아오른 (소스보다 커진)부분을 EQ의 필터로 

줄여 주는 것이 좋을 수 있습니다. 
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4.5 사운드시스템의 측정과 최적화 

 

사운드시스템을 측정하기 전에 무엇을 왜 측정하려고 하는지 생각하는 것은

중요합니다. 사운드시스템의 성능에는 양적인 것과 질적인 것이 있습니다. 다음은

시스템 성능을 평가하는 기본적인 질문들입니다. 
 

 

 Frequency response: 그 시스템이 의도하는 주파수 범위 내의 사운드를

전달(재생) 할 수 있는가? 
 Power handling: 그 시스템이 디스토션(왜곡), 또는 시스템 구성 요소의 고장

등 문제가 없이 원하는 만큼의 파워를 감당할 수 있는가? 
 Coverage: 원하는 공간의 모든 구역에 모든 주파수 대역의 사운드가

전달되는가? 
 주관적 음질(Subjective Quality): 그 시스템의 지각된 음질은 관객, 소유자, 

연주자, 오퍼레이터의 기대에 부합되는가? 이는 궁극적으로 아주 중요한

조건입니다. 
 안정성(Stability): 공연(행사)이 가능한 레벨에 게인(gain)을 유지하면 마이크가

피드백(Feedback)을 일으키는가? 
 Noise: 그 시스템이 원치 않는 잡음을 포함하고 있는가? 
 Configuration: 그 시스템의 환경(설정)을 이해하고 있는가? 어떤 사운드

시스템은 여러 개의 스피커로 이루어진 그룹들이 하나의 음원에 의해

구동되기도 하고, 또 다른 시스템은 여러 지역으로 나뉘어져 각각의 회로에

의해 제어되기도 합니다. 
 모든 시스템 구성 요소들은 문제없이 동작하고 있는가? 그 시스템을 직접

설계한 것이 아니라면, 그 시스템 설계자의 의도를 이해하도록 하십시오. 
시스템의 측정은 그 시스템이 적당하게 운용되는 상황에서 이루어져 합니다. 
게인(gain)이 변했거나, 간헐적인 잡음을 가지는 등 문제점을 가지고 있는

시스템은 최적화되기 어렵습니다. 시스템에 문제가 있는 경우 먼저 문제점을

해결하고 최적화하여야 합니다. 
 주파수응답에서 명백하게 큰 결점이 있습니까? 넓은 면적을 가진 평면에서

생긴 반사음들은 콤필터(comb filter)가 생길 수 있습니다. 콤필터가 생길 경우

빗(comb) 모양과 같이 일정한 주파수 간격으로 감쇠된 모양을 보이며, RTA와

주파수응답 특성 그래프에서 쉽게 확인할 수 있습니다. 
 

 

튜닝하려는 시스템이 어떤 것인지도 중요한 점입니다. 튜닝하려는 시스템은 이미

설치되어 있는 시스템이거나, 또는 새로 설치된 시스템일 수도 있고, 아니면 새로운

장소에 설치된 이동식 시스템(touring system)일 수도 있습니다. 이는 시스템에 대한

기대, 야기될 수 있는 문제의 형태, 현실적으로 튜닝이 가능한 정도에 영향을

줍니다. 
 



EAW Smaart 6.1 사용 설명서 
 

Copyright ⓒ SmaartCorea. All Rights Reserved. - 85 -

앞에서 말한 모든 질문에 정확한 답을 제시해 주는 하드웨어나 소프트웨어는

없습니다. 사운드 시스템을 튜닝하는 것은 하드웨어, 귀를 통한 통찰(식별)력, 문제

파악을 위한 적절하고 정확한 측정, 그리고 문제점을 찾고 해결하기 위한 많은

경험과 조직적인 방법 등에 대한 이해가 필요합니다. 이러한 문제에 접근하는데

있어서 정답은 없습니다. 시스템 튜닝 분야의 경험 많고 숙달된 많은 사람들도

튜닝을 위한 자신만의 방법을 만들어가고 있습니다. 
 

그러나 사운드 시스템을 측정하고 최적화하는데 있어서 성공적인 훈련(연습) 방법은

있다고 생각합니다. 하지만 이를 달성하기 위한 순서는 당면한 문제나 개인적인

선호도에 따라 달라질 수도 있을 것입니다. 다음은 이미 설치되어 있는 사운드

시스템을 최적화하는 기본적인 방법에 대해 설명한 것입니다. 
 

 Step 1: 사운드 시스템 확인 

 

사운드 시스템을 측정하기 전에 꼭 귀로 들어볼 것을 권장합니다. 앞(전 페이지)에서

이야기한 모든 질문에 대한 답을 찾아보십시오. 각 하위 시스템을 개별적으로

활성화하고, 여러 위치를 돌아다니며, 각각의 서브시스템이 의도한 구역에 적당한

역할을 하고 있는지를 확인해 보십시오. 커버리지(Coverage)의 경계선을 검사하여

사각이 있는지 확인합니다. 
 

 Step 2: 잠재적 문제점 확인 

 

앞(전 페이지)에서 이야기한 질문에 대한 답들로 시스템이 가진 문제점들을

찾았습니까? 예를 들어, 그라운드 루프(ground loop)와 안정적이지 못한 전기로 인한

험(hum)과 버즈(buzz) 노이즈는 시스템 성능을 떨어뜨리고 정확한 측정을 방해할 수

있으며, Smaart 6를 사용한 테스트 이전에 해결되어야 합니다. 커넥터들의 접점이나

케이블 상태와 같이 각 장비 간의 연결에도 문제가 없는지 확인해야 합니다. 과도한

시스템 히스(hiss) 노이즈는 게인 구조(gain structure)에 문제가 있다는 것을 나타내며

반드시 해결되어야 합니다. 
 

 Step 3: 측정 지점과 마이크 위치의 결정 

 
측정 장비의 위치를 선정함에 있어서 유용한 정보를 얻기 위한 측정 위치를

선택하는 것은 중요합니다. 
 

 

 전기음향 측정(electrical measurement)의 경우 장비의 입력과(또는) 출력을

연결합니다. 이러한 측정에서 연결된 여러 개의 장비를 함께 측정할 경우, 
입력은 신호 흐름 상 첫 번째 장비의 입력이고, 출력은 마지막 장비의 출력이

됩니다. 
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 건축음향(acoustical measurement) 측정은 측정마이크를 사용하여 이루어집니다. 
측정마이크를 사용하여 주파수응답 측정을 할 경우, 핑크노이즈와 같은

레퍼런스 신호가 필요합니다. 레퍼런스 신호는 스피커 시스템을 구동하기

위한 파워앰프의 입력으로 연결되어야 하는데, 만일 스피커 시스템을 위한

프로세서나 이퀄라이저를 사용하고 있는 경우 그 장비의 입력에 연결하면

됩니다. 
 

 

건축음향 측정 시 측정마이크의 선택과 위치는 매우 중요합니다. 측정마이크는

인지도 있는 제품을 선택하는 것이 좋습니다. 가능하다면 평탄한 주파수 특성을

가진 무지향성의 고품질 콘덴서 마이크를 선택할 것을 권장합니다. 
 

 
다음은 측정마이크의 위치를 선정하기 위해 고려해볼 사항입니다. 
 

 

 왜 그곳이 측정을 하기에 좋은 위치인가? 
 그 위치에서 측정마이크로 유입되어 측정에 좋지 못한 영향을 줄 수 있는

다른 요인이 있지는 않는가? 
 

 

측정마이크의 옆이나 뒤의 벽면에서 생기는 반사음은 측정의 정확도를 현저히

떨어뜨릴 수 있습니다. 측정마이크로 유입되는 반사음을 만들 수 있는 딱딱한

재질의 벽면이나 마루 등의 반사면을 유의하여야 하며, 측정마이크가 반사면에

가까이 위치할 경우 콤필터(comb filter) 효과가 생길 수 있습니다. 
 

 

 

 
측정에 좋지 못한 영향을 주는 반사면을 가진 마루 등에서 측정할 경우 이를 피하기 

어렵습니다. 이럴 경우 콤필터 현상이 무시될 수 있을 정도의 짧은 반사음을 만들도록 

측정마이크를 바닥에 내려놓는 것이 더 좋습니다. 

 

 

 Step 4: 측정 위치 비교 

 

한 장소에서만 이루어진 측정은 반사음과 같은 그 장소가 갖는 특성에 영향을 받아

정확한 측정이 이루어지지 못 할 수 있습니다. 따라서 여러 다른 위치에서 측정을

수행하는 것은 매우 중요합니다. 마이크의 위치를 옮겨가며 위치에 따른 주파수응답

상의 영향을 주의 깊게 관찰하십시오. 넓은 지역을 담당하고 있는 시스템을 측정할

경우, 여러 위치로부터의 측정 결과를 평균하여 시스템의 EQ를 설정하기 위한

가이드로 사용하는 것이 유용할 수 있습니다. 
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 Step 5: 이퀄라이저와 딜레이 설정 

 

이퀄라이저와 딜레이의 설정은 시간이 많이 소비되기 때문에 처음 시작할 때에는

어렵다고 느낄 수 있지만, 이를 해결해 나아가는 방법과 그 만큼 개선될 사운드에

대해 자신감을 갖고 진행해 나간다면, 좋은 결과를 만들어 갈 수 있을 것입니다. 
그리고 EQ 설정 시 아주 작은 양의 조정이 좋은 시스템인지, 최고의 시스템인지를

결정할 수도 있습니다. 따라서 이런 작은 변화도 인지하기 위해 노력하는 것이

좋습니다. 
 

작은 시간차와 이퀄라이저의 설정 차이가 딜레이 시스템의 특성을 완전히 다르게 할

수 있습니다. 따라서 항상 딜레이 설정을 끝낸 후 EQ의 세부조정을 해야 합니다. 
이퀄라이저와 딜레이를 조정할 경우, 그에 따른 변화를 계속하여 귀로 듣고

확인하는 것이 중요합니다. 프로그램 상의 측정결과에 대한 개선뿐만 아니라, 여러

위치를 돌아다니며 직접 귀로 들어보며, 실제 사운드가 개선되는지를 확인해야

합니다. 
 

 Step 6: 청각에 의한 평가 

 

이제 관객의 입장에서 시스템을 직접 들어보고 평가해봅니다. CD 등의 음원을

재생한 후 커버리지 내의 이곳 저곳을 돌며 직접 들어봅니다. 작은 레벨과 큰

레벨로도 확인해보며, 시스템의 성능을 확인합니다. 모든 음원 재생을 멈춘 상태에서

기본적으로 가지는 잡음(noise floor)이 시스템의 다이나믹 레인지(dynamic range)에
영향을 주지 않을 정도로 낮은지 확인합니다. 
 

익숙한 음원을 사용하는 것은 물론 좋아하지 않는 음악 등 다른 음원도 함께 사용해

보는 것도 좋습니다. 좀 지겹더라도 익숙한 음원이 시스템을 평가하기 가장 좋은

음원이 될 수 있을 것입니다. 그 음원을 계속하여 다른 시스템을 평가하는데

사용한다면, 시스템의 응답 특성을 알아차리는데 더욱 유용하게 사용할 수 있을

것입니다. 
 

 Step 7: 안정성(Stability) 테스트 

 

사운드 시스템을 실제로 사용하기 전에 하나 또는 여러 개의 마이크를 포함하는

시스템의 안정성(stability)을 확인하는 것은 아주 중요합니다. 즉, 행사가 진행되는

중에 엔지니어는 피드백(feedback) 주파수를 찾아 해결하는 것과 같은 시스템의

불안정성(instability)을 확인하기에 불편한 위치에 있을 수 있습니다. 이러한 상황은

엔지니어에게 있어서 최악의 경우이지만, 종종 발생하며 쉽게 피할 수 없습니다.  
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불안정한 사운드 시스템은 신호 경로 상에서 하나 또는 그 이상의 주파수 대역에서

원래의 신호보다 큰 게인(gain)을 가진 시그널 루프(signal loop)를 가지고 있으며, 
이는 피드백(feedback)의 원인이 됩니다. 안정된 시스템은 의도하는 - 필요한

명료도와 주파수응답을 가진 - 운용 레벨 에서 피드백이 발생하지 않고 충분한

게인(gain)이 확보됩니다.  
 

피드백은 오디오 장비를 손상시킬 수 있기 때문에 주의를 기울여야 합니다. 특히

갑자기 발생하여 급격하게 커지는(overload 또는 clipping을 만드는) 피드백은

시스템에 매우 위험합니다. 안정성 테스트 중 시스템의 장비들을 보호하기 위해

컴프레서나 리미터를 사용하는 것도 좋은 방법입니다. 하지만 주파수응답 특성 측정

시 컴프레서, 리미터와 같은 비선형(nonlinear) 장비가 신호의 경로 중에 있으면 안

되는 것을 잊지 말아야 합니다. 
 

 불안정성(Instability)의 원인 

 

피드백은 종종 잘못 지향된 스피커와 흡음하려는 음원을 지향하고 있지 않은

마이크를 사용하는 중에도 발생합니다. 이 두 가지 경우 게인(gain)을 확보하기가

어려우며, 좁은 대역의 피드백이 발생하여 시스템에 좋지 않은 영향을 줄 수

있습니다.  
 

피드백 주파수는 마이크의 위치에 따라 변화할 수 있기 때문에, 실제 행사 중

마이크가 사용될 모든 위치에서의 안정성을 테스트해야 합니다. 또 하나의

마이크로는 발생하지 않을 수 있는 문제도 여러 개의 마이크를 사용하게 되면

발생할 수 있으므로, 이 역시 테스트 해보아야 합니다. 
 

잔향이 너무 많은 공간이나 사운드 시스템에서 만들어 내는 과도한 잔향 역시

시스템의 안정성에 문제를 일으킬 수 있습니다. 
 

 불안정성(Instability)의 확인 

 

사운드 시스템의 안정성(stability)은 피드백(feedback)이 일어나기 시작할 때까지

천천히 그리고 조심스럽게 게인(gain)을 높여가는 것으로 쉽게 확인 할 수도

있습니다. 의도하는 운용 레벨 이상의 게인(gain)에서도 피드백이 일어나지 않거나, 
보통 레벨(normal level)에서 피드백이 일어날 수 있는 게인(gain)보다 조금 낮은

레벨에서 나타나는 울림(ringing)현상이 나타나지 않는다면, 시스템이 안정된

것입니다. 만일 그렇지 못하다면, 시스템의 안정성을 더 높여야 하며, 최선의

해결방법은 아래 ‘안정된 사운드 시스템 만들기’의 내용을 통해 찾을 수 있습니다. 
 

 안정된 사운드 시스템 만들기 

 
불안정한 시스템을 안정화한다는 것은 피드백(feedback)이 발생하는 주파수의 게인을

줄여줌으로써 GBF(Gain Before Feedback) - 피드백이 발생하지 않는 최대 게인(gain) -
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를 높이는 것입니다. 이퀄라이저는 만병통치약이 아닐 뿐만 아니라, 좋은 디자인의

시스템을 뛰어넘을 수는 없지만 사운드시스템을 안정시킬 수 있는 가장 강력한

도구입니다. 
 

Smaart 6는 피드백 주파수를 찾고 정확하게 EQ에 적용할 수 있도록 도와줍니다. 
이퀄라이저를 조정하기 전에, 이는 시스템의 전체적인 주파수응답에 영향을 주는

것임을 잊지 말아야 합니다. 사운드 시스템의 성능을 개선시키는데 있어서, 
이퀄라이저의 사용이 아닌 다른 방법들도 그와 같은, 또는 그 이상의 효과를 가져올

수 있습니다. 
 

 기계적, 음향적 해결 방법(Mechanical and Acoustical Solutions) 

 

라우드스피커와 모니터스피커에 대한 마이크의 상대적인 위치에 따라 피드백이

발생하는 조건에 상당한 영향을 줄 수 있습니다. 때로는 문제가 되는 주파수 대역의

게인(gain)을 줄여 주는 것이 마이크를 교체하거나 위치를 변경한 것과 같은 효과를

가져올 수 있습니다. 
 

라우드스피커의 위치를 조정하거나 지향하는 방향을 바꾸는 것도 좋은 방법이 될 수

있습니다. 라우드스피커가 마이크와 가까이 위치하고 있을 경우 피드백이 발생하기

쉽습니다. 그런 경우 마이크가 위치한 곳에 흡음재나 흡음판 등을 설치하여, 
스피커로부터 마이크로 전달되는 음압을 줄여주거나, 스피커의 운용 레벨을 줄여

주어야 합니다. 시스템 디자인의 의도를 헤치지 않고 적용될 수 있을 경우, 이런

해결 방법들이 가장 효과적일 수 있습니다. 
 

 교육에 의한 해결 방법(Educational Solutions) 

 

안정된 시스템도 여러 개의 마이크가 동시에 사용될 경우 불안정하게 될 수

있습니다. 오퍼레이터가 사용하고 있지 않은 마이크를 항상 뮤트(mute)하도록

연습하는 것이 최선의 방법이 될 수 있습니다. 
 

마이크를 사용하는 사람에게 마이크 사용 기술을 교육하는 것도 매우 좋은

방법입니다. 많은 가수들이 하고 있는 것과 같이 단일 지향성의 마이크를 감싸 쥐는

것은 특정 주파수 대역의 게인(gain)을 증가 시킬 수 있기 때문에 마이크 헤드에서

멀리 잡도록 해야 합니다. 사용 중 마이크를 모니터스피커 쪽으로 향하는 경우도

종종 있는데, 이 또한 피드백을 발생 시킬 수 있으므로 주의 하여야 합니다. 
 

 전자적 해결 방법(Electronic Solutions) 

 

일부 리버브(reverb) 장치와 특정 이펙트 연결은 안정된 시스템을 불안정하게 할 수

있습니다. 이런 경우, 다른 셋팅 방법을 찾아보거나 전체적으로 잔향 레벨을 줄여

주어야 합니다. 
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간단한 시스템의 경우, 극성(polarity)이나 위상(phase)을 변화시키는 것으로 피드백

문제를 해결할 수도 있습니다. 극성을 거꾸로 바뀌었을 때, 즉 역상이 되었을 때,
양(+)의 피드백 대신 음(-)의 피드백이 발생해야만 합니다. 그러나 많은 경로로

다양한 파장의 신호가 다시 입력되는 구조의 복잡하고 커다란 시스템의 경우, 
위상이나 극성의 변화는 안정성을 증가시키지 못하고 단지 피드백 주파수를 바꿀

뿐입니다. 
 

 이퀄라이저를 통한 시스템 안정화 

 

피드백은 보통 이퀄라이저를 사용하여 문제가 되는 주파수 대역의 에너지를

감소시킴으로써 해결할 수 있습니다. 시스템의 게인(gain)을 조심스럽게 증가시켜

피드백이 발생시켜 문제가 되는 주파수 대역을 확인하고 이퀄라이저를 사용하여 그

주파수 대역의 게인(gain)을 줄여줍니다. 시스템 안정화를 위해서는 파라메트릭

이퀄라이저를 사용할 것을 권장합니다. 
 

 

1. <그림 4-10>과 같이 시스템을 연결합니다. 이러한 셋팅은 컴퓨터의 입력

신호를 바꾸지 않고 이퀄라이저를 사용할 수 있도록 해줍니다. 
2. Spectrograph와 RTA를 동시에 볼 수 있도록 Smaart 6 프로그램의 ‘Spectrum’

버튼을 클릭합니다. 
3. Spectrum의 평균(Avg)을 8, 또는 그 이하로 설정하고, ‘Start’ 버튼을

클릭합니다. 그리고 작은 레벨의 핑크노이즈로 사운드 시스템을 구동합니다. 
4. 피드백이 일어나기 직전까지 천천히 그리고 조심스럽게 마이크의

게인(gain)을 올려줍니다. 
5. 천천히 그리고 아주 조심스럽게 피드백이 살짝 발생할 때까지 마이크

입력채널의 게인(gain)을 높입니다. RTA 디스플레이에서 다른 평균적인

부분보다 높은 볼록한 피크(peak)와 함께, Spectrograph 디스플레이에서

수직적으로 쌓여가는 측정 결과를 확인합니다. 
6. 현재의 측정결과를 그대로 유지하기 위하여 ‘Stop’ 버튼을 클릭하고, 사운드

시스템의 게인(gain)을 피드백이 발생하지 않는 레벨까지 줄여줍니다. RTA 
디스플레이의 ‘Capture’ 버튼을 클릭하여 그래프(trace)를 저장합니다. 

7. RTA 디스플레이의 결과 중 가장 높게 볼록한 부분을 클릭하고 그 주파수를

확인합니다. (주파수는 디스플레이 상단의 커서 정보표시 부분에서 확인 할

수 있습니다.) 
8. 이퀄라이저 응답을 보기 위해 ‘Frequency Response’ 버튼을 클릭합니다. 이는

피드백의 중심주파수에 파라메트릭 이퀄라이저의 필터를 설정하고 피드백을

발생시키는 공진을 줄여주려고 하는 것 입니다. 
9. 6-10dB의 좁은 대역폭을 가진 필터의 중심주파수를 앞에서 확인한 피드백

주파수에 설정합니다. 
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10. 필터의 대역폭을 1/3옥타브까지 증가시키고, 게인(gain)을 3dB를 줄여줍니다. 
넓고 얕은 형태의 필터를 사용하는 것이 위상 왜곡을 최소화할 수 있으며,
시스템 구동 중에 피드백 주파수를 자연스럽게 처리할 수 있습니다. 

11. RTA 디스플레이에서, 필터의 효과를 결정하기 위해 같은 마이크의 신호를

열어둔 채 피드백이 발생할 때까지 시스템 게인(gain)을 천천히 올려 피드백

주파수를 확인합니다. 만일 피드백이 발생하는 주파수가 같거나 거의

가깝다면, 그 주파수에 설정한 필터의 게인(gain)을 조금 더 낮춰줍니다. 만일

피드백이 새로운 주파수에서 발생한다면, 앞에서 행한 방법대로 그 대역에

다른 필터를 설정합니다.  
 

 

위와 같은 과정은 귀로 직접 들어 하는 것보다 아주 간단하며, 조직적이고, 훨씬

정확합니다. 문제가 되는 주파수 대역을 정확하게 알고 있다는 것은 필요한 필터의

조정을 더욱 쉽게 만들어 줍니다. 
 

 이퀄라이저는 얼마나 사용하는 것이 충분한가? 

 

시스템 안정성을 증가시키기 위해 컷(cut) 필터를 사용하는 것은, 그것이 특정

주파수 대역 하나에만 사용했을지라도, 게인(gain)을 줄이는 일이라는 것을 명심해야

합니다. 어쨌든 대부분 피드백 주파수는 너무 큰 게인(gain)을 가지고 있기 때문에

보통 안정성이 증가하면, 동시에 운용 레벨에서 시스템의 주파수응답도 증가할

것입니다. 그러나 너무 과도한 이퀄라이저를 사용하게 될 수도 있습니다. 
 

일반적으로 피드백이 발생하는 주파수들이 상대적으로 서로 가까이 위치 하고 있는

경우, 이퀄라이저는 시스템 안정성을 증가 시키는데 가장 효과적입니다. 넓은 면적의

주파수 대역에 여러 개의 컷(cut) 필터를 적용하는 것은 안정성이나 GBF(Gain Before 
Feedback)의 의미 있는 개선 없이 단지 그 시스템의 게인(gain)을 줄이게 되는

것입니다. 극단적인 경우, 문제를 해결하기 위해서는 시스템 디자인에 대한 변경이

필요 할 수도 있습니다. 
 

 Step 8: 최종 평가 

 

타이밍과 주파수 스펙트럼 균형이 당신이나 관계된 사람들에게 받아들여질 수 있고

시스템이 안정되었다면, 최적화 과정이 완료된 것입니다. 아마 최상의 성능을 얻기

위해서는 Step 2 - 7의 과정들을 여러 번 반복해야 할 것입니다. 일반적으로 사운드

시스템을 최적화하는 것은 여러 단계의 과정을 점진적으로 해결해 나아가는

과정이며, 투자한 만큼의 시간과 노력이 결과로 이어지는 과정입니다. (예상했던

시간보다 훨씬 많은 시간이 걸리는 경우도 자주 있습니다.) Smaart 6가 이러한 과정을

훨씬 쉽게 할 수 있도록 도와줄 것입니다. 
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Chapter 5: Smaart 6 메뉴 항목 

 

5.1 파일 메뉴(File Menu) 

5.1.1 임펄스 저장(Save Impulse) 

 
File >Save Impulse는 임펄스응답 데이터를 파일(wave파일, AIFF파일)로 저장하기 위한

명령입니다. 
 

5.1.2 종료(Exit) 

 
File > Exit는 Smaart 6를 종료하기 위한 명령입니다. 
 

5.2 외부장치 메뉴(External Devices Menu) 

 

 

 
외부 장치에 대한 컨트롤은 현재 Windows 환경의 Smaart 6만 적용됩니다.  

 

 

5.2.1 새 장치 추가(Add New Device) 

 

         
< 그림 5-1 > 새 장치 메뉴(좌) / 장치 설정 창(우) 
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1. ‘External Devices > Add’는 외부장치를 추가하기 위한 명령입니다.(<그림 5-
1>의 왼쪽 그림 참고) 여기서 추가하고자 하는 장치를 선택하면 해당 장치의

설정창이 열립니다.(<그림 5-1>의 오른쪽 그림 참고) 
장치 리스트에서 추가하려는 장치가 보이지 않는다면 EAW의 웹사이트(또는

스마트코리아 웹사이트)에서 최근 추가된 장치 컨트롤 드라이버를

확인하시고, 만일 그래도 원하는 장치의 드라이버를 찾지 못하는 경우 그

장치의 제조사에 문의해야 합니다. 
2. 장치 이름(Device Name) 부분에 원하는 이름을 써넣고, 설정창을 닫으면

‘External Device’ 메뉴에 그 장치의 목록이 나타납니다.(<그림 5-2>의 왼쪽

그림 참고) 
3. 또 설정창에서 각 입출력단에 원하는 이름을 써넣고 설정창을 닫으면, 

‘External Device’ 메뉴에 나타난 장치 목록의 하위 메뉴에서 각 입출력단의

이름을 설정하신 대로 확인 할 수 있고, 그것을 선택하여 직접 컨트롤할 수

있습니다.(<그림 5-2>의 오른쪽 그림 참고) 

 

           
< 그림 5-2 > 추가된 장치의 선택(좌)과 그 설정 창 

 

 
4. 사용하는 특정 장치에 필요한 communications parameters, unit IDs 등 또한 설정

가능합니다. 자세한 사항은 해당 장치의 컨트롤을 위한 소프트웨어 매뉴얼

등을 참고하십시오. 

 

 

 
현재 Smaart 6에서 MIDI 통신은 지원되지 않습니다. 
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5. ‘External Devices’ 메뉴에서 컨트롤하고자 하는 입력단이나 출력단을

선택(<그림 5-2>의 왼쪽 그림을 참고)하면, <그림 5-2>의 오른쪽 그림과 같이

선택한 채널을 설정을 위한 컨트롤창이 열리고, 선택한 채널에서 사용 가능한

모든 필터의 위치가 Magnitude 디스플레이 창에 표시되어야 합니다. 
만일 Magnitude 디스플레이 창에 아무것도 나타나지 않는다면, 다음

사항들을 확인해야 합니다. 장치 간의 통신에 문제가 있거나 컨트롤되는

장치의 필터들이 잘못 할당되었거나 해당 채널에 아직 할당된 필터가 없을

수 있습니다. 마지막의 경우에는, ‘Shift’키를 누른 채 Magnitude 표시창 위를

클릭하거나, 컨트롤창의 ‘New’ 버튼을 클릭하여 새 필터를 만들어 주어야

합니다. 만일 장치 간의 통신이 문제라 생각되면, 컨트롤창의 ‘Config’ 버튼을

클릭하고 장치에 대한 설정을 확인해야 합니다. 그리고 장치의 연결과 장치

자체의 설정이 적절한지도 확인해야 합니다. 
 

5.2.2 장치 제거(Remove Device) 

 

‘External Devices > Device Name > Remove’는 ‘5.2.1 새 장치 추가’에서 추가한 장치를

제거하기 위한 명령입니다. 이 명령을 클릭하면 선택한 장치가 ‘External Devices’
메뉴에서 제거됩니다. 
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5.3 옵션 메뉴(Options Menu) 

5.3.1 스펙트럼(Spectrum) 

 

 
< 그림 5-3 > 옵션 창의 스펙트럼 탭 

 
‘Options > Spectrum’, 또는 ‘Spectrum’ 버튼 오른쪽의 화살표를 클릭하면

옵션창(<그림 5-3> 참고)이 열립니다. (단축키: Alt + S) 

 
 FFT Parameters 

 

Sampling Rate: Audio I/O 옵션에서 설정한 현재의 샘플링레이트가 표시됩니다. 
 

Window: Hanning, Hamming, Blackman, Blackman-Harris, Max Flat Top, Parzen, Welch 중

선택 가능하지만, 특별한 사유가 없다면 ‘Hanning’으로 설정하기를 권장합니다. 
 

스펙트럼 디스플레이의 스케일이 ‘Lin’ 또는 ‘Log’로 설정되어 있다면 위의 모든

옵션 중에서 선택 가능하지만, ‘Oct, 1/3, 1/6, 1/12, 1/24’로 설정되어 있을 경우의

‘Window’ 설정은 ‘Hanning’으로 고정됩니다. 
 

FFT Size: 32k, 16k, 8k, 4k, 2k, 1k, 512, 256, 128 
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 RTA 

 

Max: RTA 디스플레이의 최대 dB 표시범위를 설정합니다. ‘Max’의 설정값은 ‘Min’의 
설정값보다 커야 합니다. 
Min: RTA 디스플레이의 최소 dB 표시범위를 설정합니다. 
 

여기에 설정한 최대, 최소값은 RTA 디스플레이가 시작될 때의 기본 표시범위로

합니다. 
 

 Spectrograph 

 

Max: Spectrograph 디스플레이에서 표현하는 값(dB)의 최대 한계를 설정합니다. 
‘Max’의 설정값은 ‘Min’의 설정값 보다 커야 합니다. 
Min: Spectrograph 디스플레이에서 표현하는 값(dB)의 최소 한계를 설정합니다. 
 

 Measurement/Reference Inputs 

 

각 입력단의 컨트롤 항목들은 같지만 해당 입력단에만 독립적으로 적용됩니다. 
 

Average: 1, 2, 4, 8, 16, 32, 64, 128, Inf, Fast, Slow 
 

Y+/-: 설정값만큼 RTA 디스플레이의 그래프(trace)를 위로 올리거나 아래로 내릴 수

있습니다. 실제 입력신호는 변화가 없고 보여지는 그래프(trace)에 옵셋(offset)을
적용합니다. 
 

RTA Peak Hold On: 이 박스에 체크를 해놓으면 ‘Hold Peak’에서 설정한 시간 동안

각 주파수의 최대값이 표시됩니다. 
 

Infinite Peak Hold: 이 박스에 체크를 해놓으면 측정 중 가장 높았던 최대값을

고정하여 표시하며, ‘Hold Peak’는 비활성화됩니다. 
 

Hold Peak: 각 주파수의 최대값이 고정되어 표시되는 시간을 설정할 수 있으며, 
‘Infinite Peak Hold’로 설정하였을 경우에는 비활성화됩니다. 
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5.3.2 주파수응답(Frequency Response) 

 

 

< 그림 5-4 > 옵션 창의 주파수응답 탭 

 

 

‘Options > Frequency Response’를 선택하거나 ‘Freq. Resp.’ 버튼을 클릭하면 <그림 5-
4>와 같은 설정창이 열립니다. (단축키: Alt + F) 
  

Sampling Rate: Audio I/O 옵션에서 설정한 현재의 샘플링레이트가 표시됩니다. 
 

Window: Hanning, Hamming, Blackman, Blackman-Harris, Max Flat Top, Parzen, Welch 중

선택 가능하지만, 특별한 사유가 없다면 ‘Hanning’으로 설정하기를 권장합니다. 
 

FFT: FPPO, 32k, 16k, 8k, 4k, 2k, 1k, 512, 256, 128 
 

Line Thickness: 그래프 선의 굵기를 설정할 수 있으며, ‘1-5’ 중에서 선택이

가능합니다. 이 설정은 주파수응답 그래프(trace)뿐만 아니라 RTA 디스플레이의

그래프(trace)에도 적용됩니다. 
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Mag Threshold: Magnitude 디스플레이에서 표시되는 측정결과로 사용될 입력신호의

최소값을 설정할 수 있으며, 레퍼런스 신호의 레벨에 따라 최소값을 설정하여, 
주파수응답측정 중 원하지 않는 데이터를 제한하는 방법으로 사용될 수도 있습니다. 
 

Show Coherence Trace: Magnitude 디스플레이에서 코히어런스(Coherence) 그래프의

표시 여부를 설정합니다. 
 

Unwrap Phase: 위상 디스플레이에서 기본적으로 보여지는 위상 그래프는 0°를
중심으로 하여 +/-180° 범위까지를 표시합니다(wrapped Phase). 만일 그래프의 값이

+180°(-180°)를 넘게 되면 같은 주파수 포인트의 -180°(+180°) 지점에서부터

이어져서 표시됩니다. ‘Unwrap Phase’ 부분에 체크가 되어있을 경우, 위상 그래프는

선형(Linear)으로 표시됩니다. 즉, 각 주파수 대역의 위상 변화가 있는 그대로

표시합니다. 하지만 transfer function 계산으로부터 나오는 실제 위상 데이터는 항상

+/-180° 범위 안의 값이고, ‘wrapped Phase’ 디스플레이에서 보여지는 값은 항상

정확하지는 않을 수도 있습니다. 실제 활용적인 면에서 보면, Smaart 6로 입력되는

측정 데이터가 아주 안정적이지 않다면 ‘unwrap Phase’ 디스플레이는 제대로

동작하지 않을 수도 있습니다. 
 

Show Phase as Group Delay: 이 부분에 체크를 해놓았을 경우, 위상 디스플레이의

그래프는 각 주파수 대역의 위상변화를 도(°) 단위의 값으로 표시하는 대신, 각

주파수 대역의 지연시간(ms)로 표시합니다. 이 옵션은 Smaart 6로 입력되는

측정데이터가 아주 안정적일 때 최상의 결과를 보여줄 수 있으므로, 건축음향

측정보다는 전기음향 측정에 더욱 적당합니다. 
 

Bold Front Trace: 라인(Line) 형태로 표시되는 그래프(trace) 중 가장 앞쪽에 위치하는

것을 다른 그래프보다 더 진하게 표시하도록 하는 옵션입니다.  
 

 Inputs 

 

Average: 1, 2, 4, 8, 16, 32, 64, 128, Inf, Fast, Slow, Exp 
 

Average Type: RMS or Vector 
 

Y+/-: 설정값만큼 Magnitude 디스플레이의 그래프(trace)를 위로 올리거나 아래로

내릴 수 있습니다. 실제 입력신호는 변화가 없고 보여지는 그래프(trace)에
옵셋(offset)을 적용합니다. 
 

Show Time Windowed Data: 이 박스에 체크가 되어있을 경우에만 ‘Time Window Y+/-

’의 설정이 활성화됩니다. 하지만 ‘FFT Size’의 설정이 ‘FPPO’로 되어있을 경우에는

‘Time Window’에 관련된 설정은 비활성화됩니다. 설정을 할 경우 Time-window가
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적용된 주파수응답 측정(Magnitude/위상) 그래프(trace)가 표시됩니다. 
 

Time Window Y+/-: 설정값만큼 Time-window가 적용된 그래프(trace)를 위로

올리거나 아래로 내릴 수 있습니다. 실제 입력신호는 변화가 없고 보여지는

그래프(trace)에 옵셋(offset)을 적용합니다. 
 

Time Window (ms): Time window의 폭(크기)를 설정합니다. 
 

 Coherence Blanking 

 

Solid Above: 현재 코히어런스(Coherence) 값이 여기에 설정한 값 이상인 주파수

대역의 Magnitude/위상 그래프(trace)를 진한 선으로 표시합니다. 기본 설정값은

80%이며, 이는 높은 신뢰도를 보여주는 상태라고 생각할 수 있는 값입니다. 
 

Invisible Below: 현재 코히어런스(Coherence) 값이 여기에 설정한 값 이하인 주파수

대역의 Magnitude/위상 그래프(trace)를 표시하지 않습니다. 기본 설정값은 10%이며, 
이는 매우 낮은 신뢰도를 보여주는 상태라고 생각할 수 있는 값입니다. 
 

Transparent in between with minimum opacity: ‘Solid Above’와 ‘Invisible Below’의
설정값 사이의 코히어런스(Coherence) 값을 가지는 주파수 대역의

주파수응답(Magnitude/위상) 그래프(trace)는 그 값에 따라 투명하게 표시됩니다. ‘Solid 
Above’의 값과 가까울수록 덜 투명하고, 반대로 ‘Invisible Below’의 값과 가까울수록

더 투명한 그래프(trace)로 표시됩니다. 이곳의 설정은 그 투명도의 최소값을

설정합니다. 기본 설정값은 30%이며, 코히어런스(Coherence) 값이 낮은 주파수

대역의 그래프(trace)가 너무 투명하여 불편하면 이 설정값을 올려 좀 더 진한

그래프로 확인할 수 있습니다. 이 설정을 100%로 하는 것은 그래프가 투명하게

표시되지 않으므로 ‘Coherence Blanking’을 비활성화 하는 것과 같습니다. 
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5.3.3 임펄스응답 분석(IR Analysis) 

  

 

 
< 그림 5-5 > 옵션 창의 임펄스응답 분석 탭 

 

 

‘Options > IR Analysis’를 선택하거나 임펄스응답 창의 ‘IR Options’ 버튼을 클릭하면

<그림 5-5>와 같은 설정창이 열립니다. (단축키; Alt + I) 
 

Sampling Rate: Audio I/O 옵션에서 설정한 현재의 샘플링레이트가 표시됩니다. 
 

 임펄스응답 측정 파라미터 

 

Type: 임펄스응답의 ‘time’ 디스플레이의 측정결과를 LogIR, LinIR, 또는 ETC 중

선택하여 확인할 수 있습니다. 
 

Averages: 평균(average) 계산을 위해 사용될 FFT 프레임의 수를 설정합니다. 여기에

설정될 값은 1보다 커야 하며, 임펄스 레코더가 여기에 설정된 수만큼의 프레임을

모으고, 이를 평균하여 결과를 만듭니다. 이러한 과정을 거치는 이점은 잡음을

제거할 수 있다는 것입니다. 평균의 수가 두 배가 될 때마다 S/N비는 3dB씩

증가합니다. (단, 이렇게 최대로 증가된 S/N비는 측정시스템이나 측정 대상 시스템의

S/N비보다 클 수 없습니다.) 
 

FFT: 원하는 FFT 사이즈(32k, 16k, 8k, 4k, 2k, 1k, 512, 256, 128)를 설정합니다. 이는 FFT 
계산에 사용될 샘플의 수를 설정하는 것입니다. FFT 사이즈의 설정을 변경하면 바로

아래 표시되는 ‘Time Constant’도 이에 따라 다시 계산되어 표시됩니다. Time 
Constant는 공간을 포함한 측정 대상 시스템의 잔향 감쇠시간보다 충분히 길어야

합니다. 만일 그 시간을 예상하기 어려운 경우, 최대한 긴 시간으로 설정하는 편이

좋습니다. Time Constant가 길다는 것은 측정시간이 길어진다는 것을 제외하면 다른
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불리한 점은 없습니다. 이론적으로 FFT 사이즈가 두 배 될 때마다 S/N비는 3dB씩

증가합니다. 
 

Overlap: 원하는 오버랩(Overlap) 비율을 설정합니다. 이 설정을 0%보다 크게 한다는

것은 오버랩을 사용한다는 것입니다. 예를 들어, 오버랩을 25%로 설정한다는 것은

사운드카드로부터 계속하여 입력되는 데이터 중 FFT 사이즈만큼의 샘플을 모으는데

있어서 어떤 FFT 프레임의 후반 25%의 샘플과 그 다음 FFT 프레임의 초반 25%의

샘플은 같은 데이터로부터 모은 데이터를 사용한다는 것입니다. 이는 잡음성분의

증가 없이도 측정에 필요한 데이터의 양과 이를 모으는데 걸리는 시간을 현저히

줄일 수 있기 때문에, 큰 FFT 사이즈와 긴 평균(Average)를 사용하는 측정에 특히

유용합니다. 
 

5.3.4 오디오 입출력(Audio I/O) 

 

 
< 그림 5-6 > 옵션 창의 오디오 입출력 탭 

 

 

‘Options > Audio I/O’를 선택하면 설정창이 열립니다. (단축키 Alt + A) 
 

Sampling Rate (Hz): 샘플링레이트는 사용하는 입력장치(사운드카드)에 따라 
다양합니다. 
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Channel Names and Pairs: 멀티채널 오디오 인터페이스를 사용할 경우, 그 장치가

가진 여러 개의 입력채널 중 두 가지 신호를 편리하게 선택하기 위한 옵션입니다. 
즉, 여러 개의 입력 채널 중 필요한 두 개의 신호를 선택하기 위해 매번 옵션창을

열어 설정할 필요 없이, ‘Channel Names and Pairs’에 설정에 따라 Smaart 6 메인

프로그램 창에 보여지는 서 한 쌍(pair)으로 묶인 입력신호를 선택할 수 있습니다. 
그리고 ‘Channel Names and Pairs’ 옵션 선택 시, 입력 레벨미터 아래의 입력신호 선택

부분에 보여지는 한 쌍의 입력채널들로 된 그룹들의 목록은 Smaart 6 프로그램

폴더에 “channels.plist”파일에 저장되어 있습니다. 새로운 그룹을 추가하거나 기존

그룹의 내용(Smaart 6에서 표시되는 이름) 등을 수정하고자 할 경우, 이 XML 
파일(channels.plist)을 Text/XML 편집프로그램(예, Windows의 메모장 등)을 사용하여

수정 할 수 있습니다. 
 

 Input Device 

 

Device: 컴퓨터에 추가되고 연결된 외부장치가 이 곳의 리스트에 나타납니다. 여기서

사용하고자 하는 입력장치를 선택합니다. 
 

Meas In: 측정신호의 입력으로 사용하고자 하는 채널을 선택합니다. 
 

Ref In: 레퍼런스신호의 입력으로 사용하고자 하는 채널을 선택합니다. 
 

SPL Source: SPL 측정의 소스로 사용하고자 하는 입력을 선택합니다. 
 

Bits per Sample: 입력장치가 지원하는 해상도(bit)를 설정합니다. 
 

Show ASIO Control Panel: ASIO API는 컨트롤창을 여는 기본 호출명령을 가지고

있습니다. 컨트롤창의 존재여부는 제품에 따라 다를 수 있습니다. 만일 호출 가능한

컨트롤창이 존재한다면, 이는 그 장치를 위한 드라이버의 한 부분이고, 호출된

컨트롤창과 드라이버의 컨트롤창과 같습니다. 만일 호출 가능한 창이 존재하지

않는다면, 이 버튼을 클릭하여도 컨트롤창이 열리지 않습니다. 또한 사용중인 장치에

따라, 그 컨트롤창을 호출하였을 때, Smaart 6의 인지(detect)와 재시작 없이

반응하는지에 대한 여부는 달라질 수 있습니다.  
 

 Output Device 

 

Device: 컴퓨터에 추가되고 연결된 외부장치가 이 곳의 리스트에 나타납니다. 여기서

사용하고자 하는 출력장치를 선택합니다. 
 

Main Out: 메인 출력으로 사용하고자 하는 채널을 선택합니다. 
 

Aux Out: 보조 출력으로 사용하고자 하는 채널을 선택합니다. 
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Bits per Sample: 출력장치가 지원하는 해상도(bit)를 설정합니다. 
 

Show ASIO Control Panel: ‘Input Device’의 내용과 같습니다. 
 

5.3.5 딜레이 

  

 

 
< 그림 5-7 > 옵션 창의 딜레이 탭 

 

 

‘Options > Delay’를 선택하거나, Smaart 6 메인창의 ‘Delay’ 버튼 오른쪽의 화살표, 
또는 임펄스응답창의 ‘Delay Presets’ 버튼을 클릭하면 설정창이 열립니다. (단축키: Alt 
+ D)  
 

 Delay 

 

Delay Time (ms): 현재 적용중인 딜레이타임을 보여주고, 설정할 수 있습니다. (최대 
750ms) 
 

Assign To: A-E 버튼을 클릭하면, 현재의 딜레이타임이 아래 ‘Presets’ 부분의 각

단축키(A-E)의 딜레이타임으로 설정됩니다.  
 

Channel: Ref->Meas (레퍼런스 채널에 딜레이타임 적용), Meas->Ref (측정 채널에

딜레이타임 적용) 중 선택합니다. 
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Delay Spinner Increment (ms): Smaart 6 메인창의 딜레이타임 컨트롤 부분에 있는

위/아래 방향의 화살표를 클릭하였을 경우, 한번 클릭 시의 딜레이타임 증감 정도를

설정합니다. 최소 0.02ms부터 100ms까지 설정 가능합니다. 
 

 Presets 

 
키보드의 단축키(A-E)를 눌렀을 때 적용될 딜레이타임을 직접 설정합니다. 
 

 Auto Large and Auto Small 

 

Averages: 보통 자동 딜레이 탐지기(Auto Delay Locator)는 여러 번의 임펄스응답

측정을 통하여 딜레이타임을 찾는데, 이때 사용될 임펄스응답 측정의 횟수를

설정하며, 그 횟수만큼의 측정을 평균하여 딜레이타임을 찾습니다. 
 

FFT: 128 – 512k 샘플까지의 원하는 FFT 사이즈를 선택합니다. 이는 딜레이 탐지 중

행해지는 각 FFT 계산을 위해 사운드카드로부터 모아지는 샘플의 수를 설정하는

것입니다. FFT 사이즈의 설정을 변경하면 바로 아래 표시되는 ‘Time Constant’도 이에

따라 다시 계산되어 표시됩니다. Time Constant는 공간을 포함한 측정 대상 시스템의

잔향 감쇠시간보다 충분히 길어야 합니다. 만일 그 시간을 예상하기 어려운 경우, 
최대한 긴 시간으로 설정하는 편이 좋습니다. Time Constant가 길다는 것은

측정시간이 길어진다는 것을 제외하면 다른 불리한 점은 없습니다. 이론적으로 FFT 
사이즈가 두 배 될 때마다 S/N비는 3dB씩 증가합니다. 
 

 Speed of Sound 

 

온도는 소리가 전파되는 속도에 가장 영향을 많이 주는 요인입니다. 현재의 온도를

이곳에 설정하면, 그에 따라 Smaart 6에서 딜레이타임에 상응하는 거리를 계산하는

기준으로 사용됩니다. 
 

온도, 또는 소리의 속도 중 한쪽만 변경하여 입력하면 나머지는 자동으로

변경됩니다. 그러나 이 기능의 일반적인 사용은 현재의 온도를 입력하여 소리의

속도를 계산하기 위함입니다.  
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5.3.6 줌(Zoom) 

 

 
< 그림 5-8 > 옵션 창의 줌 탭 

 

 

‘Options > Zoom’를 선택하면 설정창이 열립니다. (단축키 Alt + Z) 
 

Use Nyquist: 박스에 체크하면 최고주파수 영역이 사용 중인 샘픔링레이트에서

받아들일 수 있는 가장 높은 주파수(Nyquist Frequency = 샘플링레이트/2)로 자동

설정됩니다. <그림 5-8>의 Zoom 4와 같이 박스에 체크를 하면, 최고주파수 영역은

24kHz(SR=48kHz)로 설정되고, 최고주파수 영역은 비활성화됩니다. 
 

Min: 각각의 줌을 위한 최저주파수를 설정합니다. 
 

Max: 각각의 줌을 위한 최고주파수를 설정합니다. 
 

‘Apply’, 또는 ‘OK’를 클릭하면 변경한 설정이 적용되며, 키보드의 1-4키를 누르면

각각의 설정된 줌(Zoom)으로 보기가 가능합니다. 
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5.3.7 순간치(Instantaneous) 

 

‘Options > Instantaneous’를 클릭하거나 키보드의 Ctrl+I키를 누르면 Instantaneous의
설정을 스펙트럼/주파수응답 측정의 평균(Avg)에 적용화(적용되어 있을 경우는

적용을 취소)할 수 있으며, 평균(Avg) 부분이 비활성화됩니다. 
실시간 모드에서, 평균(Avg)은 측정 중인 데이터의 동향을 보기 쉽도록

그래프(trace)를 안정시켜주고, 데이터의 변화에 대한 그래프(trace)의 반응을 느리게

하지만 일시적으로 나타나는 불필요한 잡음을 배제할 수 있습니다. Instantaneous가
설정되었을 경우 그래프(trace)는 평균 기능을 사용하지 않고 그때그때의 측정결과를

표시합니다. 하지만 평균이 적용되고 있는 그래프(trace)와의 직접적인 비교를 위해

프로그램 내부에서 평균 기능은 계속하여 수행되고 있습니다. 따라서

Instantaneous의 적용이 취소되면 새로운 데이터가 평균이 되어 그래프(trace)로
나타나기를 기다릴 필요가 없습니다. 
 

5.3.8 평균 재시작(Reseed Averages) 

 

‘Options > Reseed' Averages’를 클릭하거나 키보드의 V키를 누르면 평균에 사용될

데이터가 저장되는 버퍼(buffer)를 비우고 새롭게 평균을 시작합니다. 또 평균 기능에

관련된 설정, FFT 사이즈, 샘플링레이트 등을 바꾸었을 경우에도 자동적으로 이 같은

작업이 이루어집니다.  
 

5.3.9 High Contrast View 

 

‘Options > High Contrast View’를 클릭하거나 키보드의 H키를 눌러 설정합니다. 야외

등 밝은 빛 때문에 프로그램 화면이 잘 보이지 않을 경우 매우 유용합니다. 
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5.4 도움말 메뉴(Help Menu) 
  

5.4.1 About 

 
‘Help > About’을 클릭하면 아래의 그림과 같이 현재 설치된 Smaart 6와 관련된

정보를 확인할 수 있습니다. Mac OSX 사용자는 시스템의 shared menu bar의 Smaart 
Menu를 통해 아래와 같은 정보를 확인할 수 있습니다. 

 

 
< 그림 5-9 > 제품정보 창 

 

 

5.4.2 Smaart 6 도움말(Smaart Help) 

  
 ‘Help->Smaart Help’를 클릭하면 사용자 매뉴얼을 보실 수 있습니다. 
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5.5 키보드 단축키 

General Controls 
Frequency Response Mode = F 

IR Analysis = I 

Spectrum Mode = S 

Real-Time On/Off = O 

Reseed Average Buffers = V 

Cycle Z-order on Selected Graph = Z 

Instantaneous = Cmd/Ctrl + I 

High Contrast Colors = Alt/Opt + H 

Help 
Windows = F1 

Mac = Cmd + Shift + ? 

Generator Shortcuts 
Generate Signal = G 

Increase Signal Level = ] 

Decrease Signal Level = [ 

Spectrum Display Frequency Scale 
Narrowband = 5 

1/24-Octave = 6 

1/12-Octave = 7 

1/6-Octave = 8 

1/3-Octave = 9 

Octave = 0 

Delay Time 
Auto-Locate Delay (Large) = L 

Clear Delay (Reset to 0 ms) = F5 

Recall Stored Delay Time Preset = A, B, C D, E 

Increase Delay Time = . (Period key) 

Decrease Delay Time = , (Comma key) 

IR Analysis Window Only 
Start/Stop Impulse Recorder = R 

Assign Cursor Position to Current Delay Time = Shift + 

Space Bar 

Assign Locked Cursor to Delay Preset = Cmd/Ctrl + A, 

B, C, D, E 

Save Impulse Response = Cmd/Ctrl + S 

Range, Scale, and Zoom Shortcuts 
Amplitude/Magnitude (y-axis) Range 
Zoom Selected Graph In (vertically) = +/= 

Zoom Selected Graph Out = – 

Move Selected Graph Up = PageUp 

Move Selected Graph Down = PageDown 

Frequency/Time (x-axis) Range 
Zoom Selected Graph In = Up Arrow (▲) 

Zoom Selected Graph Out = Down Arrow (▼) 

Move Selected Graph Left = Left Arrow (◄) 

Move Selected Graph Right = Right Arrow (►) 

Phase Display 
Set Phase Range to: 

• 180° to –180° = Alt/Opt + Home 

• 0° to 360° = Alt/Opt + End 

Frequency Zooms (Preset Frequency Ranges) 
Recall Zoom 1 = 1 

Recall Zoom 2 = 2 

Recall Zoom 3 = 3 

Recall Zoom 4 = 4 

Configure Frequency Zooms = Alt/Opt + Z 

Mouse Zooming 
•  Left-Click and drag on plot to select zoom range 

•  Release mouse button to set range 

•  Click in margin of graph to reset range 
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Trace Shortcuts 
Shift Front Trace Up (on selected graph) = Cmd/Ctrl + 

Up Arrow (▲) 

Shift Front Trace Down (on selected graph) = Cmd/Ctrl 

+ Down Arrow (▼) 

Capture Reference Trace = Space Bar Show Legend = 

Alt/Opt + L 

Cycle Z Order = Z (forward) or Shift + Z (reverse) 

•  Move Selected Up in List = Alt + Up Arrow (▲) 

•  Move Selected Down in List = Alt + Down Arrow 

(▼) 

•  Select all reference traces = Shift + A 

•  Select all live measurement Traces = Cmd/Ctrl + A 

•  Select all traces= Cmd/Ctrl + Shift + A 

•  Remove Selected Reference Trace = Del 

Locked Cursor Shortcuts 
Set at mouse cursor position = Cmd/Ctrl + Left-Click on plot 

Show Harmonics (on/even/odd/all/off) = H 

Set at lowest point on the front trace = Shift + L 

Set at highest peak on the front trace = Shift + P 

Track Peak (on real-time displays) = Cmd/Ctrl + Shift + P 

Remove Locked Cursor = Cmd/Ctrl + X 

 

External Device Control 
External Device Mode = X 

Flatten Selected filter = Del 

Increase Boost = Up Arrow (▲) 

Decrease Boost = Down Arrow (▼) 

Increase Frequency = Right Arrow (►) 

Decrease Frequency = Left Arrow (◄) 

Increase Bandwidth = Shift + Right Arrow (►) 

Decrease Bandwidth = Shift + Left Arrow (◄) 

Select Next Filter = Tab 

Select Previous Filter = Shift + Tab 

Mouse 
Create New Filter or 

Grab Nearest (device dependent) = Shift + Left-Click 

plot 

Select Filter Marker = Left-Click on marker 

Change frequency and/or 

boost/cut = Left-Click and drag filter marker 

 

Options Menu Shortcuts 
Audio I/O Options = Alt/Opt + A 

Delay Options = Alt/Opt + D 

Frequency Response Options = Alt/Opt + F 

Graph Options = Alt/Opt + G 

High Contrast Colors = Alt/Opt + H 

IR Analysis Options = Alt/Opt + I 

Open Legend Dialog = Alt/Opt + L 

Options (last used tab) = Alt/Opt + O 

Spectrum Options = Alt/Opt + S 

Volume (Recording) Control (Windows Only) = Alt/Opt 

+ P 

External Device Information = Alt/Opt + X 

Frequency Zoom Setup = Alt/Opt + Z 
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Chapter 6: 문제 해결 

 

6.1 설치 관련 문제 

6.1.1 설치 중 발생 문제 

 

Smaart 6를 설치하려고 할 때 발생하는 가장 일반적인 문제는 자동 바이러스 체크, 
시스템 감시, 그리고 프로그램 설치 감시 등과 같은 기능과 충돌하는 것입니다. 
Smaart 6가 아닌 다른 프로그램들 역시 이와 같은 문제를 일으킬 수 있습니다. 
그러므로 다른 모든 프로그램(특히, 백신/Anti-Virus 프로그램)을 종료한 후에 Smaart 
6의 설치를 시작해야 합니다. 
 

손상된 설치프로그램, 디스크의 공간부족, 또는 Smaart 6가 설치될 드리이브나

디렉토리에 접근이 불가능한 경우 등의 이유로 Smaart 6 설치 중 문제가 발생 할 수

있습니다. 설치될 컴퓨터의 보안 설정에 따른 문제라면 관리자(Administrator)
계정으로 접속해 Smaart 6를 설치해야 할 수 있습니다. 또 Smaart 6가 설치된 폴더가

모든 사용자 계정이 접근할 수 있도록 설정되어있지 않다면 설치 후에 사용자 승인

문제가 발생할 수 있습니다. 
 

Smaart 6는 아주 작은 디스크 공간만 있으면 설치할 수 있지만, 설치 중의

임시파일을 위한 여분의 디스크 공간이 필요합니다. 일반적으로 컴퓨터의

OS(Operating System)는 원활한 동작을 위한 여분의 디스크 공간이 필요하므로, 
하드디스크의 15-20% 정도를 여유공간으로 유지하는 것이 좋습니다. 여유공간이

너무 작을 경우, Smaart 6와 직접 관계되지 않더라도 여러 가지 다른 문제들이 발생할

수 있습니다. 
 

손상된 설치프로그램으로 인한 문제는 다음과 같은 증상을 나타냅니다. 아무런 경고

메시지 없이 설치프로그램의 구동이 멈추거나, OS가 관련된 오류메시지를 표시할

수도 있습니다. 만일 Smaart 6 설치 중 이와 같은 증상이 나타나는 등

설치프로그램의 손상으로 인한 문제가 발생하였다면, 새로운 설치프로그램을

다운로드 받아 다시 설치해야 합니다. 
 

6.1.2 설치 후 발생 문제 

 

Smaart 6을 설치 하는 중에 발생하는 문제는 대부분 Smaart 6 설치프로그램과

바이러스 체크 프로그램, 설치 감시, 시스템 감시 등의 소프트웨어와의 충돌

때문입니다. Smaart 6가 설치 될 때 Windows의 레지스트리(Registry) 정보를 변경하고, 
Windows 시스템 폴더 안에 여러 개의 파일들을 생성하거나 변경하며, Smaart 6와
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이에 관련된 구성 요소들을 OS(Operating System)에 등록합니다. 바이러스 체크

프로그램과 시스템/설치 관리 프로그램은 시스템파일들과 폴더들을 보호하고, 설치

과정을 중지시킬 수 있습니다. 가끔 다른 소프트웨어와의 충돌과 관련된 설치

문제들은 설치 완료 후에 나타나기도 합니다. Smaart 6 프로그램이 DLL, 또는 OCX 
파일을 찾을 수 없다는 메시지를 표시하는 경우, 다른 모든 프로그램을 종료한 후

Smaart 6를 재설치 해야 합니다. 
 

Smaart 6가 성공적으로 설치되고 정상적으로 동작하지만 오디오 신호 관련 문제가

있다면, 이는 단지 설정에 관련된 문제입니다. ‘6.2 오디오 입출력 컨트롤 설정’, ‘6.3 
사운드장치 문제’를 참고하십시오. 
 

6.2 오디오 입출력 컨트롤 설정 

 

만일 사운드장치의 입력채널을 통해 Smaart 6로 입력되는 신호나, 내부에서 발생시킨

신호를 출력채널을 통해 출력하는데 문제가 있다면, 먼저 ‘Option > Audio I/O’에서

입출력 장치가 바르게 선택되어 있는지 확인해봐야 합니다. 만일 사용중인 컴퓨터의

오디오장치가 1개뿐일 경우에도, OS가 그 장치를 보이스모뎀(Voice Modem)으로

인식하고 있거나, 가끔은 그 장치의 드라이버가 재대로 설치되어 있지 않은 경우도

있습니다.  
 

6.2.1 Windows용 웨이브(Wave-in/Wave-out) 장치 

 

웨이브 입출력 장치가 바르게 선택되어 있는데도 오디오 신호를 출력하는데 문제가

있다면, 선택한 장치의 출력단이 뮤트(mute)되어 있거나 그 장치의

믹서(프로그램)에서 너무 작게 설정되어 있을 수 있습니다. 만일 오디오 신호를

받는데 문제가 있다면, 그 장치의 입력 믹서(프로그램)의 설정을 확인하십시오.  
 

Windows의 볼륨컨트롤(믹서)은 대부분의 윈도우 호환 사운드 장치의 오디오

입출력을 제어할 수 있는 표준화된 인터페이스를 제공합니다. Smaart를 처음 써보는

사용자들 중에 Windows Taskbar에서 열수 있는 볼륨컨트롤창이 입출력 모두를

제어할 수 있다고 생각하는 경우가 있는데, 이는 출력에 대한 제어만 가능하고

입력에 대한 제어는 ‘녹음컨트롤’ 창에서 할 수 있습니다. 
 
만일 컴퓨터 입력채널에서 Smaart 6로 들어오는 신호를 받는데 문제가 있거나, 
컴퓨터의 내장 마이크 신호가 측정신호와 함께 들어온다고 의심된다면, ‘녹음컨트롤’
창의 설정을 확인해봐야 합니다. Smaart 6에서 선택된 입력장치의 입력믹서를 보려면, 
다음의 과정대로 하시면 됩니다. 
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1. Windows Taskbar의 스피커 모양 아이콘을 더블클릭하거나, ‘시작> 프로그램>
보조프로그램> 엔터테인먼트(멀티미디어)> 볼륨조절’을 선택하여 Windows 
볼륨컨트롤창을 엽니다. 

2. Options->Properties. ‘볼륨컨트롤’창에서 ‘옵션> 속성’을 선택합니다. 
3. ‘녹음’을 클릭하고, 마이크와 라인입력 박스에 체크한 후, ‘확인’을 클릭하여

설정창을 닫습니다. 
 

 

위의 과정을 마치면 ‘볼륨컨트롤’ 창이 ‘녹음컨트롤’ 창으로 바뀝니다. 라인입력

박스에 체크 했는지는 확인하고, 좌우 밸런스가 중앙에 있는지, 페이더가 적당한

레벨에 위치해 있는지 확인합니다. 만일 사용중인 컴퓨터에 내장 마이크가 있고

‘녹음컨트롤’의 ‘마이크’ 밑의 박스에 체크가 되어있다면, 클릭하여 체크가 안된

상태로 만들어 줍니다. 
 

6.3 사운드 하드웨어 문제 
  
 일반적인 문제해결 과정 

 

사용중인 컴퓨터에 Smaart 6와 함께 잘 구동될 수 있는 호환성이 좋은 사운드

하드웨어를 설치하고, 적당히 설정해야 합니다. Smaart 6는 직접 사운드 하드웨어와

데이터를 주고 받지 않고, OS(Operating System) 또는 제3의 오디오장치를 통해

오디오 데이터를 받습니다. Windows 시스템에서 구동되는 Smaart 6는 Windows 
Wave와 ‘Steinberg’가 개발했고 사실상 멀티채널 녹음 인터페이스의 표준인 ASIO 
API와 호환됩니다.  
 

만일 Smaart 6가 사용하는 사운드 하드웨어를 인식하지 못한다면, 다른 오디오 관련

프로그램은 그 장치를 통해 녹음, 재생이 되는지 확인해 보십시오. Windows와 함께

제공되는 녹음기와 미디어 플레이어가 테스트 목적으로 유용할 것입니다. 
 

특히 Windows에서 오디오 장치에 접근하기 위한 방법은 여러 가지입니다. 그래서 두

장치가 함께 동작하고 있을 경우, Smaart 6와는 원활하게 동작하지 않을 수 있습니다. 
만일 어떤 장치가 다른 프로그램과도 원활히 동작하지 않는다면, 소프트웨어 문제가

아닌 하드웨어나 설치에 관련된 문제일 수 있습니다. 또한 어떤 장치가 Windows용
ASIO 드라이버와 Wave(WDM, MDE) 드라이버를 모두 가지고 있다면, 둘 중 한가지

인터페이스와 더 잘 구동될 수도 있습니다. 
 

만일 하드웨어나 드라이버 문제로 생각된다면, 먼저 드라이버를 다시 설치해보는

것이 좋습니다. 컴퓨터 시스템이나 하드웨어 장치에 따라, 하드웨어 드라이버는

사운드카드나 컴퓨터와 함께 제공된 디스크, 또는 OS 설치 디스크에 있습니다.  
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만일 문제가 있는 장치의 제조사를 알고 있다면, 그 웹사이트에서 최신 드라이버가

있는지 확인해 보십시오. 드라이버에 문제가 있을 경우, 제조사가 그 문제를 해결한

새로운 드라이버를 제공하는 경우가 많습니다. 만일 하드웨어와 드라이버가 적당히

설정된 것이 확실한데도 문제가 계속하여 발생한다면, 그 장치의 매뉴얼을

참고하거나 제조사에 문의하여 도움을 받아야 합니다. 
 

6.4 프로그램 구동 문제 
  

 

만일 Smaart 6의 동작이 너무 느리다면, CPU의 성능, 또는 RAM의 크기가 충분하지

못한 것이 원인일 수 있습니다. 다음과 같이 Smaart 6를 위한 시스템 자원(System 
Resources)을 더 많이 확보해 주고, RAM/CPU에 부담을 덜 주는 방향으로 Smaart 6를

사용하는 편이 좋습니다. 먼저 꼭 필요하지 않은 다른 프로그램들을 종료하여 Smaart 
6가 사용하기 위한 RAM의 공간을 더 많이 확보해 줍니다. Smaart 6의 구동속도에

가장 큰 영향을 주는 것은 실시간 스펙트럼 분석과 주파수응답 분석에서 설정한

FFT 사이즈입니다. 스펙트럼, 주파수응답 디스플레이 양쪽에서 모두 선형(Linear), 
FIFO 평균을 사용하고 있을 경우에도, 선택한 FFT 사이즈는 메모리 사용량에 큰

영향을 줍니다. 또 캡처한 그래프(레퍼런스 트레이스)들을 화면에 띄워놓는 것도

최소화하는 것이 좋습니다. 
 

만일 컴퓨터의 실제적인 RAM 용량이 Smaart 6가 구동되기에 충분하지 못하다면, 
하드디스크 공간이 가상의 메모리로 사용됩니다. 이는 하드디스크의 과도한 구동의

원인이 되며, Smaart 6의 구동에 큰 영향을 주게 되므로 심한 경우 프로그램 구동이

거의 멈출 수 있습니다. 
 

주파수응답 디스플레이의 FPPO 옵션은 메모리와 CPU를 효율적으로 사용하므로, 
최상의 구동을 위해서 FPPO 옵션을 선택하고 너무 큰 FFT 사이즈를 선택하지 않는

것이 좋습니다. 메모리 공간과 CPU의 성능이 충분하지 않은 경우, ‘64’ 또는 ‘128’의
평균과, 큰 FFT 사이즈로 설정한다면 Smaart 6의 구동은 아주 느려질 수 있습니다. 
평균 설정이 ‘Infinite’인 경우 FIFO 평균에 비해 거의 RAM을 사용하지 않으며, 
‘Fast’, ‘Slow’와 같은 지수적 평균 역시 작은 공간의 메모리만 사용합니다. 
 

6.5 기본 설정 복구 

 

Smaart 6의 디스플레이와 스케일 옵션은 사용자에 의해 변경/저장되며, Smaart 6 
프로그램이 시작될 때 이를 참조하여 관련된 모든 설정이 업데이트 되므로, 
사용자의 설정이 유지됩니다. 만일 프로그램 첫 구동시의 기본 설정(Factory Default 
Settings)으로 되돌리려면, 다음의 파일을 지우면 되며, Smaart 6가 시작될 때

기본설정으로 된 새로운 파일을 자동 생성합니다. 
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둘 이상의 컴퓨터 사용자가 Smaart 6를 사용하는 경우, 각 사용자를 위한 별도의

파일이 생성되므로, 지우고자 하는 사용자의 파일만 선택하여 지워야 합니다. 모든

파일의 이름은 ‘sm6user.plist’로 같지만, 각 사용자의 계정 폴더에 위치하므로, 
사용자명에 따라 다음과 같이 파일을 찾을 수 있습니다. 
 
Windows: 

C:\Documents and Settings\[사용자명]\Application Data\Smaart 
 
Mac OSX: 

../users/[사용자명]/library/preferences/sm6user.plist 
 

[사용자명]은 컴퓨터에 로그온 할 때 사용하는 계정의 이름입니다. Windows의 경우

위의 위치에서 sm6user.plist 파일이 보이지 않을 수 있는데, 이럴 경우 폴더 옵션의

‘보기’ 설정을 변경하여야 합니다.  
 
 
 

6.6 기술지원 

 

 

제품 관련 정보는 스마트코리아 웹사이트를 방문하여 주시고, 관련된 문의사항은

웹사이트의 관련 게시판을 이용해 주시기 바랍니다. 
 

스마트코리아 웹사이트: www.smaartcorea.co.kr 
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